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Chapter 1 — Getting Started

System Requirements

Verify that your computer meets the following system requirements before installing QuicKeys 4.
*  QuicKeys 4 requires Mac OS X version 10.5 or later.
* There are no minimum processor or RAM requirements for QuicKeys 4, but its
performance will directly relate to the speed and memory available. If you meet Apple’s

RAM requirements for Mac OS X, that is sufficient.

* 60 MB of free hard drive space is recommended. You will need more as you build a library of
QuicKeys shortcuts and clips.

* Certain features, such as automatic checking for QuicKeys updates, require an internet
connection.

Turning on Accessibility

QuicKeys 4 requires that your system’s

ACCCSSibility pI'CfCI‘CHCC be turned on. Access for assistive devices (required for
hot keys, abbreviations, and other
features) is not enabled in Universal
If it is not turned on, then any time you launch sl S
. . . . . preferences now?

QulCKeyS7 QulCKeyS Wlll prOVIde you Wlth the Check “Enable access for assistive devices" in the

. . . i fe 3
Opportunlty to go dlrectly to the Unlversal Universal Access preferences to enable

Access preference pane.

"1 Do not show this message again

" No \( Yes 3

To turn Accessibility on manually, follow these o
steps:

1. Select System Preferences from the Apple menu.

2. Select the Universal Access pane from the System category.

3. Check the Enable access for assistive devices check box.

4. Ifyou are prompted to do so, enter your administrator password.

5. Quit System Preferences.
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Installing QuicKeys

After downloading QuicKeys 4, your browser may unarchive it for you. If it does not, |
simply double-click the file named QuicKeys 4.zip. Then drag & drop the icon named
“QuicKeys” from your Downloads folder into your Applications folder. QuicKeys

To install QuicKeys 4 from the CD, simply open the CD and drag & drop the icon named
“QuicKeys” from there into your Applications folder on your hard drive.

If you are upgrading from a previous version, QuicKeys 4 will update your data the first time you

run it. But first, it will make a back up of your previous data and place it in a folder on the Desktop
called “QuicKeys Backup.” You may wish to move this folder to a safe place. If for some reason you
need to revert to an older version, refer to the instructions found in the “QuicKeys Backup” folder.

Opening QuicKeys

Launching QuicKeys 4 for the first time is as simple as double-clicking the QuicKeys application
icon that you copied to your Applications folder. When you launch QuicKeys 4 for the first time,
you must read and agree to the License & Limited Warranty Agreement.

When QuicKeys is running, its presence will be indicated by a black “Q” (known as the QuicKeys
Menu) up by your system clock in the menu bar. It will also show up in your Dock just like

any other running application. However, these behaviors can be changed through QuicKeys’
preferences.

Opening the QuicKeys Editor window can be accomplished in two ways. You can select QuicKeys
from the QuicKeys Menu up by your system clock, or you can click on the QuicKeys icon in the
Dock.

Note: If you quit the QuicKeys application, you will not be able to play the shortcuts or use the
toolbars or abbreviations that you have created. The QuicKeys Editor window, however, does not
need to be open.

Activating QuicKeys

The first time you run QuicKeys you will be asked to enter an activation key or to run in trial
mode. If you are upgrading from an older version, you may be asked to verify your upgrade
eligibility by entering the activation key for the version you are upgrading from. If you do not know
the activation key for your old version you can request your old key on our website in the Support
section.

You can also choose to run in trial mode. QuicKeys will run normally for 30 days in trial mode.
After 30 days, QuicKeys will remain fully functional, but you will be reminded occasionally that you
are still in trial mode before a shortcut will run or an abbreviation will complete.
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When you enter your activation key, QuicKeys will check back to our activation server to make
sure you are entering a valid key. Once your key is validated, QuicKeys will never contact the
activation server again. However, if QuicKeys is unable to contact our activation server and validate
the key, it will continue to occasionally try contacting the server in the background until it validates
your activation key:.

When activating you have two options: activate just for the currently logged in user, or for all users
on the computer. If you choose to activate QuicKeys for all users, you may be asked to enter an
admin user name and password.

Setting Up QuicKeys

QuicKeys Setup will walk you through setting up some key features so that you can get started
right away. QuicKeys Setup can also be opened by selecting QuicKeys Setup from the QuicKeys
application menu.

Open QuicKeys at Login - Select this preference if you want QuicKeys to launch when you log in to
your computer. If this preference is not selected, your shortcuts will not work until you've launched
QuicKeys manually.

Accessibility - The Mac OS X Accessibility system is how QuicKeys sees and controls the user
interface of other applications. If Accessibility is not enabled, many QuicKeys features will not
be able to work correctly. QuicKeys Setup checks to see if Accessibility is enabled. If it is not, the
Open Universal Access button will help you to enable it.

F1, F2, etc. & the fn key - This screen will only appear if your keyboard has an fn key and your
System Preferences are not set to use all F1, F2, etc. keys as standard function keys. This screen
warns you that you will need to either hold down the fn key when setting and using functions keys
as triggers, or you will need to change your System Preferences to not require the fn key. If you
choose to change your preferences, the Open Keyboard & Mouse button will take you there.

Advanced Features - If you do not need QuicKeys advanced features (controls for subscopes, step
results, and excluded applications), QuicKeys can be easier to use with these features hidden out of
the way. You can always choose to show these features later if you find you want them. Select this
option if you want to show them now:.

Add-Ons - Add-Ons allow QuicKeys to get additional information from some applications. The
Web Actions and Web Launcher actions need to get descriptions of elements of web pages or need
to know when web pages have finished loading. QuicKeys uses an Input Manager to load Add-Ons.
If you wish to install the Input Manager, click Install Input Manager. You can install or uninstall the
Input Manager in the Add-Ons pane of QuicKeys Preferences.
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Checking for QuicKeys Updates

QuicKeys can automatically check startly.com for updates to the product. When you select Check
tor Update from the QuicKeys application menu, the QuicKeys Update window appears. You can
set QuicKeys to check for updates automatically in the General pane of QuicKeys Preferences, or
you can return to this window from time to time to check for updates manually. If you choose to
check for updates automatically, you must specify how often QuicKeys checks.

About this Manual

This section discusses how this manual is organized and contains information on the conventions
used in this manual. Knowing how the manual is set up will help you use it more effectively.

Assumptions

This documentation assumes you have a working knowledge of the Mac OS X operating system and
accompanying hardware. For example, you should know how to use your mouse and how to open,
save, and close files. You should also be familiar with Mac OS X interface elements, such as buttons,
menus, icons, and the Dock. If you need assistance with Mac OS X use or terms, consult the Mac
OS help system or visit apple.com.

Organization

* Chapters 1-3 of this manual introduce you to QuicKeys and provide basic instructions for
installing and operating the software.

* Chapters 4-6 explore three major features of QuicKeys: Shortcuts, Abbreviations, and
Toolbars.

* Chapter 7 covers some major concepts of QuicKeys: Clips, Scope, Variables, and Functions.

* Chapters 8-14 describe each action type used in creating shortcuts and give point-by-point
explanations of each feature and control.

* Appendices cover QuicKeys Online and additional topics.

Conventions

* A right arrow symbol (>) indicates the hierarchy of menu and submenu options. For
example: Create > Files > Open Items.

* A forward slash ()) indicates the hierarchy of a file or folder path on your hard drive. For
example: <hard drive>/Applications/QuicKeys
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* Variable text is contained within angle bracket characters < and >. For example, “look in
your User folder, <user>/Library/QuicKeys, for your Shortcuts folder.”

Contextual Menu Terminology

Parts of QuicKeys use contextual menus. These menus, as their name suggests, change depending
on the context under which they are activated. Contextual menus are activated when you right-
click (multi-button mouse) or control-click (hold your keyboard’s control key down while clicking
with a single-button mouse) on a user interface element such as a shortcut name, editor toolbar, or
a scope. For the sake of brevity in this manual, the term “right-click” will be used when we want to
activate a contextual menu.

Modifier Keys

These symbols appear in this manual (and throughout Mac OS X) to represent modifier keys.
¥ Command
. Option
~ Control

4 Shift
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Basics

This section introduces the important concepts behind QuicKeys. It describes various components
of the QuicKeys 4 package, and how they interact. Take a few minutes to read this material and
gain a working vocabulary for the product. Once you have a handle on the fundamentals, you'll be
ready to dig in and start customizing your Macintosh.

Shortcuts

Shortcuts are the main way you automate your computer using QuicKeys. Shortcuts are very
powerful, but are easy to make. That’s because QuicKeys can make them for you by recording
practically anything you can do. All you have to do is tell QuicKeys when to start recording and
when to stop recording. QuicKeys will then make a new shortcut containing steps that reproduce
your actions.

Of course if you want, you can always create and edit shortcuts by hand. It’s not difficult. You can
even manually edit shortcuts which were created with the recording feature.

QuicKeys 4 comes with a number of predefined shortcuts that perform several useful functions.
These are a good starting point and reference. Look them over as you explore the product—they’ll
give some insight into what can be done with QuicKeys. As you use QuicKeys you'll create many
shortcuts of your own, adding to this collection and creating a portrait of the way you interact with
your computer, fitting your Macintosh to your work style.

Note: Shortcuts are covered in greater detail in Chapter 4 of this manual.

Single-step & Multi-step Shortcuts

Single-step shortcuts automate simple one-step tasks, such as typing your name, opening your
Documents folder, or launching an application. By adding additional steps onto a single-step
shortcut, you can create multi-step shortcuts to automate more complex tasks.

Examples of these multi-step tasks include moving and resizing a window; placing a graphic in
InDesign, resizing it, and applying an object style; or mounting a network drive and copying files to
it.

Instant Shortcut

This is a special shortcut you can use for making quick, temporary recordings of your actions. You
can use it over and over again as long as you need. It sticks around until you record a new Instant
Shortcut. You can also save a copy if you have an especially good Instant Shortcut that would be
useful again in the future.

Note: Instant Shortcuts are covered in greater detail in the “Instant Shortcuts” section of Chapter 4
of this manual.
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Actions

Actions are the building blocks of shortcuts. All the actions that QuicKeys can perform are covered
in Chapters 8 — 14 Take a moment to browse through those pages.

Each step of a shortcut tells QuicKeys which action to perform and how to perform it.

Step Results

When a shortcut is played, it evaluates each action as a success or failure. For example, if a Menu
Selection step cannot find the specified menu item, that step’s step result is “Failure.” By default, a
failed step will cease playback and present a window notifying you of that failure. Conversely, when
a step succeeds, playback of that shortcut proceeds to the next step if one exists.

You can specify different behavior for the success and failure of each step using the Step Results tab
of the Information pane in the Shortcut Editor. For more information on the Step Results tab, see
“The Shortcut Editor” in Chapter 4.

If you modify step results often (and most people don’t, the default behavior being adequate) you
can turn on step result controls for all your steps. For more information see “The Appearance Pane”
in Chapter 3.

Triggers

A trigger is the signal for QuicKeys to start playing a shortcut. When you create a shortcut, you
can assign one or more triggers to it. For example, you can assign $F3 (Command + F3) as a hot
key trigger that launches Microsoft Word, or you can create a day & time trigger to automatically
launch your e-mail application at 7:30 AM while you're still brushing your teeth.

Note: Triggers are covered in greater detail in Chapter 4 of this manual.

App Event - Shortcuts can be triggered automatically after a specific application opens, quits,
becomes front-most, leaves the front, or stops responding.

Day & Time - You can select times and days of the week for QuicKeys to automatically trigger a
shortcut.

Device - With this trigger type you can directly assign shortcuts to buttons on your mouse,
trackball, joystick, and even keys like Eject and Mute on your keyboard.

Drive - Shortcuts can be triggered when a drive is mounted or unmounted.

File System — These triggers let QuicKeys fire shortcuts based on changes to the contents of a
tolder or other file system related reasons.
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Function - These triggers allow you to make your own custom AppleScript trigger functions that
are checked periodically. If they return TRUE, QuicKeys will fire their shortcut.

Hot Key - You assign a keystroke or combination of keystrokes to activate a particular shortcut.

MIDI - These triggers let you fire Shortcuts via MIDI enabled musical instruments or equipment.
You can even specify musical chords as triggers to give you an incredible variety of possibilities.

QuicKeys Menu - QuicKeys places a small black “Q” menu up by your clock in the top right corner
of your screen. Shortcuts may be added to and triggered from this menu.

Repeat - Once you've created a shortcut, a Repeat trigger will cause it to repeatedly activate after a
set amount of time has passed.

Speech - If you have a headset or microphone attached to your Mac, you can assign a unique
phrase for any QuicKeys shortcut you make, which when spoken will activate that shortcut.

Time Range - This option is technically a qualifier rather than an actual trigger. It will not directly
trigger a shortcut, but if you group this qualifier with another trigger, you can limit that trigger’s
operation to specified time ranges.

Scope

Scope is the realm of operation for a trigger. You can specify the scope of your triggers to limit the
applications under which that shortcut can be triggered. A shortcut can have more than one scope
if so desired. Scope comes in two major types: All Applications and Application-specific.

All Applications - When scoped to All Applications, a shortcut trigger will be active no matter
which application is in front.* For example, your F1 key might be set up to hide the front
application. If you scope it to, say, Safari, then the F1 key would only hide the front application if
it happened to be Safari. You would need to scope that hot key to All Applications for it to work as
desired for any application.

* with the exception of excluded applications

Application-specific - A trigger scoped to a specific application will only be active when that
application is in front. You can assign more than one application scope to a shortcut if needed.

Scope Interaction

Triggers scoped to a specific application always take precedence over those scoped to All
Applications. This is useful for special case situations where you may not want your F1 key
triggering the same shortcut in Safari (for example) that it does in your other applications.
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Excluded Applications

You can designate any application as being “Excluded” from the All Applications scope.
Applications so designated, when front-most, prevent the triggering of shortcuts that are scoped
to All Applications. For example, if you exclude iMovie from All Applications, shortcuts scoped to
All Applications will not trigger if iMovie is the front-most application. Applications can even be
excluded on a per shortcut basis.

Note: Scope is covered in greater detail in Chapter 7 of this manual.

Abbreviations

Abbreviations let you type a short word in a document and automatically replace it with longer
text, run a QuicKeys Shortcut, or even paste in a QuicKeys Clip.

Note: Abbreviations are covered in greater detail in Chapter 5 of this manual.

Toolbars

0D 0O 0O  Example Toolbar

QuicKeys Toolbars are floating toolbars that you can create with e
buttons representing your QuicKeys shortcuts. Then you can play @ @ \‘t B
these shortcuts with a single click.

Toolbars can be opened and closed with a hot key or by selecting them from the QuicKeys Menu or
the QuicKeys Dock Menu. They can be universal, or they can be scoped to specific applications—
accessible only when the scoped application is running,.

Note: Toolbars are covered in greater detail in Chapter 6 of this manual.
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Tutorial — Your First Shortcut

What faster way to learn to use QuicKeys than to actually use QuicKeys? This short tutorial
presents step by step instructions for making a simple shortcut.

The Problem

“I often create new documents that begin with the exact same text every time.”

The Solution

Build a shortcut that will both open a new document and type your text for you.

How To

I.

Open the QuicKeys Editor. (Click the QuicKeys icon in the dock, or select Open QuicKeys
Editor from the QuicKeys Menu.)

Click Create—either the toolbar button or the menu. Select User Actions > Type
Keystroke. This creates a new shortcut (and opens it in the Shortcut Editor) with Type
Keystroke as the first step.

Click in the Type Keystroke field and press Command+N (88 N).
Optional: Give this step a custom name. To do so, double-click its current name, Type

Keystroke “3 N”, and then type “Open new document.”

Next, you want your text to be 2 v (@ Waitfor New Window ™
typed, but we need to be sure

. . Wait For: [ Window i
the new document window is _ .
. Window Name: | Is '-I!‘
open before QuicKeys starts = ——

typing. Click Add Step and Window Type: [ Document Window 3
select QuicKeys > Wait >

Wait for Window. This adds a

Wait for Window step to the e P =
shortcut. Window State: | New =

[ Timeout: | Step succeeds after = 30 ¥ seconds

Set Window Type to Document
Window. Set Window Is to
Front-most. Set Window Sate to New.

Now that we are certain the window is ready, we can have QuicKeys type the text. Click
Add Step and select Text > Type Text. This adds a Type Text step to the shortcut.

Enter your text in the Text to Type field. (Type the text, copy and paste, or drag and drop.)

Note: A Type Text step only types text. If you want to paste text with formatting into your
new document, you will use an Insert Clip step.
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8. To set the Trigger for ®00 Untitled Shortcut 1 o
this shortcut. Leave (») (@) S O
the trigger type set Play  Rec are Re Shortcut On
to Hot Key, and click
the current trigger
to edit it. A small

[-]+] hotkey + @ . Key

window pops up. Press ] — —

Control+B (~ B) and 1 ;
. Shortcut Steps  What this sh @ Trigger when pressed p v =
then close that window. = ey e

() Trigger when released

Scopes & Triggers Whera, when, and why this shartcut runs. Add Scope ~ n

¥ HE All Applications 5

NOte.‘ Although hOt | ] Hot key is sticky
keys are the mOSt ] Timeout: Step succeeds afte, o e
common triggel‘, they 2 v A Tvoe text The auick red fox iumped over ... W

are far from the only type.

Optional: Do you want this shortcut to work in all applications or only your word processor?
To set it’s scope (where it works) to just one application, click the current scope, All
Applications. If your word processor is running, select it from the list; otherwise, select
Select Application and navigate to it.

9. All that is left is to save and name the shortcut. Press Command+S on your keyboard or
click the File menu and select Save Shortcut. If you close the Shortcut Editor without
saving, QuicKeys will prompt you to save. No matter which method you use, QuicKeys will
prompt you to name the shortcut. This is the name that will appear in the shortcut list.

Now, open your word processor and press Control+B (~ B) to see QuicKeys in action.

Alternate Solutions

As your knowledge of QuicKeys 4 grows, you will discover alternate and more powerful ways to use
it. Clips and abbreviations are two other ways to insert text.

In a shortcut like this one, Create Clips and Insert Clips actions allow you to collect text and
graphics on the fly, and retrieve them from those collections when needed. Think of Clips
collections as unlimited permanent clipboards.

An alternative to a shortcut, is the Abbreviation feature. Abbreviations let you type a short word in
a document that is already open and automatically replace it with other longer text.

The Sky’s the Limit

Although this shortcut is quite simple, some shortcuts are even simpler. On the other hand, some
shortcuts can have 30 or more steps, repeating loops, decisions, and variables.

This tutorial illustrates many of the important aspects of QuicKeys 4. You’ll use the same basic
procedure for many of the shortcuts you create, and as you grow wise in the ways of automation,
you’ll discover many variations on this basic theme. Whether your shortcuts are simple or complex,
the only limit is your imagination.
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The QuicKeys Editor

The QuicKeys Editor is your control center for creating, modifying, and organizing your shortcuts,
abbreviations, toolbars, and clips. The most fundamental parts of the QuicKeys editor include: the

QuicKeys Editor toolbar, the source list, the content area, and the footer.

LIBRARY

QuicKeys Editor

Triggers
= Shortcuts ™ [[] Clips - GatheryManage All Applications
~C
/¥ Abbreviations
B8 Toolbars T ] Clps - Insert\Type All Applications
=
v
[:] Clips —
™ H  Hide Front Application All Applications
SCOPES i
B Al Applications ™ HE  Hide Other Applications All Applications
ONLINE 2
& Quickeys Online ™ ® hmmm All Applications
F3
M & hmmm2 All Applications
s
M & iTunes — Next Track All Applications
s Quickeys Menu
M £, [Tunes - Previous Track All Applications
e QuicKeys Menu
™ £ [Tunes - Stop\Play All Applications
~ space QuicKeys Menu
M “,  [Tunes - Volume Down All Applications
=
™ £ [Tunes - Volume Up All Applications ~
= |a
1 5
& n + | - -

The QuicKeys Editor Toolbar

At the top of the QuicKeys Editor window is a toolbar.

Create - This create menu is similar to the Create menu on the QuicKeys menu bar (covered later
in this chapter) but with an additional section: Create New. Here you can select New Shortcut,
New Abbreviation, or New Toolbar.

Record - Click this button to tell QuicKeys to start interpreting and recording your actions. See
the “Recording” section of Chapter 4 for more information.

QuicKeys On/Off — Shuts off all triggers, taking QuicKeys “out of the way” if necessary without the
need to quit the program.
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Shortcut Search - Enter your text and QuicKeys will find matching shortcuts.
Play - (Not present by default) Use this to play a selected shortcut.

Customize - (Not present by default) Use this to customize the toolbar.

The Source List

The source list always has categories for Library, Scopes, and Online. The Searches and Remotes
categories will appear when applicable. Select an item in any of these categories to change the
content in the content area.

Library

Shortcuts — A list of all your shortcuts. See “The Shortcuts List” later in this section.
Abbreviations - A list of all your abbreviations. See “The Abbreviations List” later in this section.
Toolbars — A list of all your toolbars. See “The Toolbars List” later in this section.

Clips - Allows you to manage your clips. See “The Clips Manager” in Chapter 7.

The Scopes List

The second category of the sources list is your Scopes list. It allows you to view your shortcuts,
abbreviations, and toolbars by scope.

By default the All Applications scope will appear here. The list will also include the names of all
applications to which you have scoped your shortcuts, abbreviations, and toolbars. For example, if
you have built items specifically for use within Word, Safari, and Mail, your Scopes list will include
those three applications. If you click on the Safari scope, the shortcuts, abbreviations, and toolbars
lists will show only those items scoped to work when Safari is the front-most application.

The category Unscoped Items will appear if you have any shortcuts that have no scope. Shortcuts
placed on toolbars, in the QuicKeys Menu, and embedded in other shortcuts do not necessarily

need to be scoped.

When viewing by scope, use the bar across the top of the content area to select Shortcuts,
Abbreviations, or Toolbars.

In this mode, the shortcuts, abbreviations, and toolbars lists will function as when selected from
the Library category with the exception that the scope is not listed.

Note: Scope is covered in greater detail in Chapter 7 of this manual.
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Abbreviations

QuicKeys Editor

LIBRARY Toolbars for All Applications
@ shortcuts On | Type |Shemeut . A |Triggers
M Abbreviations ™ [[]  Clips - Gather\Manage e
TanlEns M [[] Clips - Insert\Type AV
L ctips o . Hide Front Application _FL_
SCOPES M HE  Hide Other Applications F2
4 ® hmmm —
ONLINE T ® hmmm2 F5
&) QuicKeys Online ™ & iTunes - Next Track A e QuicKeys Menu
SEARCHES T L iTunes - Previous Track date QuicKeys Menu
Wew Search Name 4l L iTunes - Stop\Play ~ space QuicKeys Menu
™ % iTunes - Volume Down i
™ “  iTunes - Volume Up AT
] |l  Open Address Book fO S A S B
™ Open Calculator c0 S C A
M (@] Open Documents Folder ~F D
M i OpeniCal ~0 1 C
] 3 Open iTunes SO B LB T
) [®  Open Mail “0 M A .
™ @  Open QuicKeys Editor ~0 QK | ‘openeditor i
— P P et - [
& N + | = e

QuicKeys Online

In QuicKeys Online you will find lots of resources to help you get the most out of QuicKeys 4.

* Browse the Shortcut Gallery to learn about and download shortcuts you can use right now:
* View helpful Tutorials for beginner, intermediate, and expert users.

* Do you need technical help? Visit the QuicKeys Support website.

* Visit the QuicKeys Community to chat about all things QuicKeys with other users.

All of this can be accessed from within QuicKeys by clicking QuicKeys Online. Internet access is
required.

Note: QuicKeys Online is covered in greater detail in Appendix A of this manual.

Searches

QuicKeys 4 includes the ability to search for shortcuts. You can save your searches under the
Searches heading in the source list.

See “Search Results” later in this section.
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Remotes

‘When you are setting up the QuicKeys Anywhere application on an iPhone or iPod Touch those
devices will show here.

More information on this feature can be found in Appendix C.

The Content Area

This area can display the Shortcuts List, the Abbreviations List, the Toolbars List, the Clips
Manager, or search results. This area can also display the content for QuicKeys Online, which
is covered in Appendix A, and the controls for setting up remote devices, which is covered in
Appendix C.

Resizable Columns - All except the On, Type, and Show columns can be resized by using your
mouse to grab and drag the divider lines between the column headers.

Sort - Clicking column headers will sort the list by that particular column.

Contextual Menu Support — Right-clicking listed items will bring up a contextual menu allowing
you quick access to certain features. You can edit, rename, or play an item, turn an item on or off,
and Select All, Cut, Copy, Delete or Export the some items.

The Shortcuts List

When you select Shortcuts from the Source List, or select a scope in the Source List and select
Shortcuts from the bar at the top, the right side of the QuicKeys Editor window fills with the
Shortcuts List. This area will display a list of your shortcuts.

Which shortcuts appear will depend on whether anything is selected in the Scopes list to the
left. For example, if you click on Safari in the Scopes list, only shortcuts that are scoped to Safari
will show up in the list. But if you click on Shortcuts in the Library list, the list will display every
shortcut.
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eanO0n QuicKeys Editor

=}
3
-
=
®

Triggers

*= Shortcuts M [[] Clips - Gather\Manage
¥ Abbreviations
Toelbars ™ [C] Clips - Insert\Type
ij Clips
4l B Hide Front Application
SCOPES
B All Applications M HE  Hide Other Applications
ONLINE
E Quickeys Online 4l @ hmmm
) ® hmmm2
M £ [Tunes - Next Track
g & iTunes - Previous Track
M & iTunes - Stop\Play
™ £, [Tunes - Volume Down
M £ [Tunes - Volume Up
@ i+ | =

All Applications
~C

All Applications
-~

All Applications
FL

All Applications
a2
All Applications
SEN
All Applications
5

All Applications
oo QuicKeys Menu

All Applications
aln Quickeys Menu

All Applications
~ space Quickeys Menu

All Applications

AL
-

All Applications

st

Fa»

B

On/Off column - Turn individual shortcuts on and off here. Shortcuts that are off cannot be
triggered. Sorting by this column separates the “on” shortcuts from the “off” shortcuts.

Type column - This column displays a helpful icon indicating what type of shortcut it is, or a
custom icon you assign. Sorting by this column sorts your shortcuts by shortcut type.

Shortcut column - This column displays the names of your shortcuts. Sorting by this column is
alphabetical by shortcut name. The shortcut can be renamed here without needing to open it.

Triggers column - This column displays the trigger for
each shortcut. Sorting by this column groups similar
trigger types together. Unless you are viewing by scope,
this column also list the scope for the trigger.

Clicking on a trigger in the shortcuts list will allow you to
edit it directly from the QuicKeys Editor window rather
than having to open the shortcut.

o Hot Key

[ F1 1

{*) Trigger when pressed
"] Hot key repeats

ﬂ
@

() Trigger when released
] Hot key is sticky
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The Abbreviations List

When you select Abbreviations from the Source List, or select a scope in the Source List and select
Abbreviations from the bar at the top, the right side of the QuicKeys Editor window fills with the
Abbreviations List. This area will display a list of your abbreviations. Which abbreviations appear
will depend on whether anything is selected in the Scopes list to the left. For example, if you click
on Word in the Scopes list, only abbreviations that are scoped to Word will show up in the list. But
if you click on Abbreviations in the Library list, the list will display every abbreviation.

8an0o QuicKeys Editor =
¥

LIBRARY On Completion | Scope

& Shortcuts M © © B All Applications | appreyiation: |snmn

" Avbreviaions U @ SRR pHleAHon S 1

&8 Toolbars ™M ® H All Applications Ignore case

[j Clips M @ B All Applications Completion: Shortcut  Clip
COrRT g myem| my_email_address@mywebs... B All Applications

B All Applications ™M mynm My Name B All Applications 8

) g myphn 515-221-1801 B All Applications
Adobe InDesign C54 o

o e | i Aoplcaons S| N =
ONLINE ™M ™ H All Applications

&) Quickeys Online ™ et 8:12 PM, May 25, 2009 I All Applications Style: [ Rich Text ]

SEARCHES

Options: g Match case of typed abbreviation
(] New Search Name

E Append typed trigger

Completes: ["As set in preferences H
Scope: r.!.AHApchations I-‘vl
Usage: ™ Replace typed abbreviation

"1 Only completes in known text areas
»)

On/Off column - Turn individual abbreviations on and off here. Abbreviations that are off cannot
be triggered. Sorting by this column separates the “on” abbreviations from the “oft” abbreviations.

Abbreviation column - This column displays the names of your abbreviations. This is the text you
type in order to use the abbreviation. Sorting by this column is alphabetical by abbreviations name.

Completion column - This column displays the completion of each abbreviation. This is the text,
shortcut, or clip that QuicKeys inserts in place of or in addition to the abbreviation you typed.
Sorting by this column is alphabetical

Scope column - This column indicates the scope for the abbreviation. Sorting by this column is
alphabetical by scope name. If you are viewing by scope, this column will not appear.

Abbreviation Editor - This area of the window allows you to edit abbreviations. The Abbreviation
Editor is covered in Chapter §
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The Toolbars List

When you select Toolbars from the Source List, or select a scope in the Source List and select
Toolbars from the bar at the top, the right side of the QuicKeys Editor window fills with the
Toolbars List. This area will display a list of your toolbars. Which toolbars appear will depend on
whether anything is selected in the Scopes list to the left. For example, if you click on Mail in the
Scopes list (which will appear if you have toolbars scoped to Mail), only the toolbars that are scoped
to Mail will show up in the list. But if you click on Toolbars in the Library list, the list will display
every toolbar.

SO0 QuicKeys Editor =]

LIERARY Show | Type | Tool |Scope |Hot Key

@ Shortcuts ™ B8 Examp B All Applications  unassigned
/¥ Abbreviations ] B8 Untitle [l Adobe InDesign € unassigned
r:] Clips

SCOPES
B all Applications
li8] Adobe InDesign C54

ONLINE
E Quickeys Online

Show column - Show or hide individual toolbars here. Sorting by this column separates the
“shown” toolbars from the “hidden” toolbars.

Type column - This column displays a helpful icon indicating what type of toolbar it is. Sorting by
this column separates the “standard” toolbars from the “docked” toolbars.

Toolbar column - This column displays the names of your toolbars. Sorting by this column is
alphabetical by toolbar name.

Scope column - This column indicates the scope for the toolbar. Sorting by this column is
alphabetical by scope name. If you are viewing by scope, this column will not appear.
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Hot Key column - This column displays the hot key (if any) assigned to each toolbar. Sorting by this
column sorts the toolbars in hot key order.

Search Results

Type your search terms in the Shortcut Search field. The results will appear in the same format as
the Shortcuts List does.

(%) Limit search to: ( g Shortcuts %) (&) ( New ) ( Save )
[ All + ) of the following are true i+
| Shortcut Name ) |_contains * ) open [=] ()
| Shortcut Comments + | |_contains +) (= ()

The controls at the top of the results can be expanded, by clicking the plus (+) on the far right of
a line, and become the Advanced Shortcut Search so you can add additional parameters and refine
your search further.

The Footer
The footer is the bar along the bottom of the window:
DOWNLOAD ACTIVITY Download Activity
Resize
Add Item  Delete Item Number of Items
= n + - Gl

Download Activity - While you are downloading shortcuts from QuicKeys Online this pane opens
to show you the progress. Click the first button to close it

Resize - Click and drag to change the size of the source list.

Add - Click the button with the plus sign (+) to add a new shortcut, abbreviation, toolbar, or clip
(depending what is currently selected in the Source List).

Delete - Click the button with the minus sign (-) to delete the selected shortcut, abbreviation,
toolbar, or clip.

Number of Items - Indicates the number of items in the current view.
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The QuicKeys Menu

The QuicKeys Menu provides quick access to some of QuicKeys basic
components, as well as a list of shortcuts to which you have assigned

QuicKeys Menu triggers.

The QuicKeys Menu is located in your computer’s menu bar
near the system clock. This menu can be turned on and off on
the Appearance pane of QuicKeys preferences.

QuicKeys On/Off — Shuts off all triggers, taking QuicKeys “out
of the way” without the need to quit the program.

Open QuicKeys Editor - Opens the QuicKeys Editor.
Subscopes - This item appears only when advanced features

are turned on in QuicKeys preferences. Use the submenu to
change the currently active subscope.

Toolbars — Show or hide individual Toolbars from this
submenu.

Edit Toolbars - Opens the QuicKeys Editor window to the
Toolbar List so you can edit toolbars.

Play Instant Shortcut — Plays the Instant Shortcut.

Edit Instant Shortcut — Opens the Instant Shortcut Editor.

CUIL ITIsLalll 11T LR, ..

YOW Flaying

EXample >nortcut

Q Satl:lePM Q

s - &
) “eve: LN

Tﬁ rn QuicKeys Off
Open QuicKeys Editor...
Subscopes >

Toolbars =
Edit Toolbars...

Play Instant Shortcut
Edit Instant Shortcut...

Stop Playback

Start Recording
Start Recording Instant Shortcut

Cancel Recordii

4 iTunes - Next Track
v iTunes - Previous Track
* iTunes - Stop\Play

Now Playing - If a shortcut is playing, the name of the

shortcut and the current step appear in this menu.

Pance Plavhark

Pause/Resume Playback - If a shortcut is playing, this will pause playback. If a shortcut is pause,

this will resume playback.

Stop Playback - If a shortcut is playing, this will stop playback entirely:.

Start/End Recording - Starts QuicKeys interpreting and recording your actions. Selecting End
Recording stops recording and opens a new shortcut with your actions inside.

Start Recording Instant Shortcut - Similar to Start Recording, but your actions are saved to the

instant shortcut. Select End Recording when you are finished.
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Cancel Recording - Cancels recording in progress; no shortcut is created.

Shortcut list - Any shortcuts you create with triggers of type “QuicKeys Menu” will show here,

below the last menu divider line.

The QuicKeys Dock Menu

Clicking the QuicKeys Dock icon will open the QuicKeys Editor. Right-clicking or
clicking and holding the QuicKeys Dock icon brings up the Dock menu.

The QuicKeys Dock icon and QuicKeys Dock menu can be turned on and off on the

Appearance pane of QuicKeys preferences.

The QuicKeys Dock menu is nearly identical to the
QuicKeys menu which is described in detail on the previous
page; however, the following menu items are unique to the
QuicKeys Dock Menu:

Keep in Dock - Select this option if you want QuicKeys to
remain in the Dock even when it is not running,.

Open at Login - Select this option if you want QuicKeys to
launch when you log in to your computer. If this preference
is not selected, your shortcuts will not work until you've
launched QuicKeys manually.

Show in Finder - Switches the Finder to the front and
opens your Applications folder, or whichever folder

happens to contain the QuicKeys 4 application.

Hide — Hides QuicKeys and any associated windows.

Duick eves Oin
ILCREYS: LUIN

Turn QuicKeys Off

Toolbars [
Edit Toolbars...

Play Instant Shortcut
Edit Instant Shortcut...

[T -]
[ ]

o D gl
op FlaybDack

Start Recording
Start Recording Instant Shortcut
Cancel Recording

iTunes - Next Track
iTunes - Previous Track
iTunes - Stop\Play

Keep in Dock
Open at Login
Show in Finder

Hide
Quit - Quits the QuicKeys application. Quit
\/’
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QuicKeys Menu Bar

When QuicKeys is the front-most application, its menu bar is available. What follows is a
description of each item in each menu on the QuicKeys menu bar.

The QuicKeys Application Menu

About QuicKeys - Opens the About QuicKeys window that
contains version and licensing information as well as buttons
which take you to the product registration page or allow you to Preferences. . 3,
enter an new activation key. QuicKeys Satup...

About QuicKeys

QuicKeys Online {3H

Preferences - O th icKeys Pref indow. S
pens eQulc eys TCICIrences window. dee Eheck for UpdEﬂE...

Chapter 3. Send Feedback...

QuicKeys Setup - Opens QuicKeys Setup. This is the same Services >

window you would have seen the first time you ran QuicKeys after Hide QuicKeys a8

you installed it. See page 7. Hide Others aH
Show All

QuicKeys Online - Accesses QuicKeys online in the QuicKeys Quit QuicKeys 32Q

Editor. Here you can browse the Shortcut Gallery to learn about
and download shortcuts; view helpful tutorials for beginner,
intermediate, and expert users; visit the QuicKeys Support website; and visit the QuicKeys
Community to chat with other users. Internet access is required. QuicKeys Online is covered in
greater detail in Appendix A of this manual.

Check for Update - If you are connected to the internet this item will check to see if your version
of QuicKeys is the most current.

Send Feedback - This item will open your web browser to the QuicKeys product feedback page.
Internet access is required.

Services > Create QuicKeys Shortcut — This option can be used to instantly create new QuicKeys
shortcuts from selected text inside documents or from items selected in the Finder. QuicKeys will
create Type Text or Open Items shortcuts depending on what you have selected. This menu item is
only active when QuicKeys is not the front-most application.

Hide QuicKeys — Hides the QuicKeys application from view:

Hide Others - Hides all running applications except QuicKeys.

Show All - Shows all running applications.

Quit QuicKeys - Quits the QuicKeys application.

QuicKeys 4 User Guide August 2009 26




Chapter 2 — QuicKeys Interface

Note: If you are running a 30-day demo version of QuicKeys, this menu will also contain “Enter
Activation Key” as a menu item. Select this to enter your purchased activation key and remove the

30-day demo timer.

The File Menu

New Shortcut — Opens the Shortcut Editor with a new
untitled shortcut without any steps.

New Abbreviation — Switches to the Abbreviations List and
creates a new abbreviation.

New Toolbar - Switches to the Toolbars List and creates a
new untitled toolbar.

Open - Opens the selected item.

Save Shortcut - Saves the currently open shortcut.

New Shortcut... 3N
New Abbreviation... N
New Toolbar... BN
Save Shortcut 385
Edit Instant Shortcut... {r 38l

Save Copy of Instant Shortcut

cate >Cope

B N JE

Save Shortcut Protected — Allows you to save a shortcut so

that all data (except the name of the first step) is encrypted. Import Shortcuts...

Export Shortcuts...

Note: You will need to set up the Master Password in the Subscribe to Shortcuts...

Security pane of the preferences to be able to save your Page Setup... fraep
shortcuts as protected. Print... 8P

Rename Shortcut — Allows you to rename the currently
open or selected shortcut.

Duplicate — Duplicates the selected item.
Edit Instant Shortcut - Opens the Instant Shortcut Editor.

Save Copy of Instant Shortcut - If you have created an Instant Shortcut that would be useful to
keep around, select this item to save a copy of it. This opens it in the standard Shortcut Editor so
that you can assign scopes and triggers and rename it.

Reassign Scope - If you have a scope selected in the main QuicKeys Editor window; this item will
allow you to change that scope to another application in all shortcuts simultaneously. For example,
if an application to which you have scoped shortcuts undergoes a name change, you can use this
option to change the old scope to match the new application name.

Duplicate Scope - If you have a scope selected in the main QuicKeys Editor window, this item
will allow you to duplicate that scope in all shortcuts at once. For example, if you have two word
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processors, you can quickly scope your existing shortcuts for the for the first to also work in the
second.

Delete Scope - Delete the selected scope from all shortcuts. Any shortcuts which had this scope as
their only scope will become unscoped shortcuts.

Import - Shortcuts, abbreviations, or toolbars that you have exported as a backup, or another user
has exported to share, can be imported.

Export — Export selected shortcuts, abbreviations, or toolbars to back them up or to share with
other QuicKeys users.

Subscribe to Shortcuts — Subscribe to shortcut repositories. To learn more, see Appendix F, Sharing
Shortcuts.

Page Setup - This opens the standard page setup dialog for printing.

Print - Prints a list of all shortcuts in a selected scope, complete with icon, shortcut name,
comments, scope, and trigger information.

The Edit Menu

Undo/Redo - Allows you to undo or redo such actions

as deleting or rearranging shortcut steps in a multi-step
shortcut. Deleting entire shortcuts is not something you can
undo.

Cut - Cut the selected item to the system clipboard. R
Select All A

Copy - Copy the selected item to the system clipboard.
y Py Y P Shortcut Search EF
. Find... #aF
Paste - Paste the contents of the system clipboard. Cloce Find .
Delete — Delete the selected item. Format >
Spelling and Grammar >
Select All - Select all shortcuts in a scope or all steps in a Special Characters... T

shortcut.
Shortcut Search - Sets focus to the Shortcut Search field at the top of the QuicKeys Editor.
Find - Opens the Advanced Shortcut Search display.

Close Find - Closes the Advanced Shortcut Search display:.

Format — Allows you to format text in clips and in rich text abbreviations.

QuicKeys 4 User Guide August 2009 28




Chapter 2 — QuicKeys Interface

Spelling - Opens the standard Mac OS X spelling controls.

Special Characters — Opens the Mac OS X Special Characters palette.

The View Menu

Hide Editor Toolbar — Hides/Shows the toolbar at the top

of the QuicKeys Editor or Shortcut Editor.

Customize Editor Toolbar — Allows you to customize
the contents of the QuicKeys Editor or Shortcut Editor

toolbar.

Show/Hide Help Bar - Toggles the Help Bar in the

Shortcut Editor.

Hide Editor Toolbar
Customize Editor Toolbar...

Hide Help Bar
Show Shortcut Information I
Show Shortcut Variables N

Shown Scoped ltems [

Show/Hide Shortcut Information - Toggles the Information pane in the Shortcut Editor.

Show/Hide Shortcut Variables — Toggles the Variables pane in the Shortcut Editor.

Shown Scoped Items - In the QuicKeys Editor, use this submenu to select which items to view in
the content area—shortcuts, abbreviations, or toolbars—when viewing by scope.

The Create Menu

Search - Let’s you search for a specific action.

Favorites - Shows the Shortcut Actions you
have set as your favorites. Favorites can be set
in the Shortcut Actions Palette.

Actions - Files, Internet & Network, QuicKeys,
Scripting, System, Text, User Actions — When
an item is selected from one of these submenus
a new QuicKeys shortcut of that type is
created. However, if a shortcut is already front-
most, selecting from this menu will add a new
step to that shortcut rather than create a new
shortcut.

Open Shortcut Actions Palette - Opens the
Shortcut Actions Palette, a palette with all your
shortcuts and all actions conveniently listed.

ravorites

(8 Wait for User

Actions

=y Files

@ Internet & Network
& QuicKeys

. Scripting

B System

A Text

k User Actions

vy vYyYVYTYTVYYY

Open Shortcut Actions Palette A

| Mouse over an item to see its
description
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The Shortcuts Menu

Play - Plays the selected shortcut.

Turn On Shortcut Debugging — Enables debugging mode
to help you decipher problems you might be having with

shortcut creation and playback.

Turn Shortcut Off/On - Shuts off or turns on any selected

shortcuts.

Add Scope Exception - When you have the Shortcut
Editor or Abbreviation Editor open for an item with an
All Applications scope, you can select this item to show

Play NHP
Turn On Shortcut Debugging

Turn Shortcut Off O

Submit to Shortcut Gallery...
Send Shortcuts to Support...

the Exceptions Editor for that scope for that shortcut or abbreviation.

Edit Step Results — Opens the Step Results window so you can edit the selected step’s Step Results

settings.

Apply Typing Speed to Siblings - In a multi-step shortcut that contains multiple typing steps, the

typing speed of all steps within that shortcut can be matched to the currently selected step with

this menu item.

Submit to Shortcut Gallery — Sends the selected Shortcuts to Startly for submission to the Shortcut
Gallery. This gallery can be accessed by all QuicKeys users in the QuicKeys Online area of the
QuicKeys Editor. Please note all submissions become the property of Startly Technologies and are
reviewed before being posted to the gallery. Shortcuts may be edited before being added to the

gallery.

Send Shortcuts to Support - Allows you to send shortcuts to our support team at their request.

The Window Menu

Close - Closes the front-most window.
Zoom - Zooms the front-most window.

Minimize - Shrinks the front-most window and puts it

in the Dock.

QuicKeys Editor - Opens the QuicKeys Editor
window. See “QuicKeys Editor” in Chapter 3.

Excluded Applications - Opens a window containing

Close *EW
Zoom

Minimize ¥M
QuicKeys Editor ¥E

Excluded Applications
Devices

Variables and Functions Editor {3V

Bring All to Front

a list of applications that you've told QuicKeys to not trigger shortcuts in. This applies only to
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shortcuts scoped to All Applications; you can still scope shortcuts to excluded applications directly
if desired. Excluded applications are covered in Chapter 7.

Devices — Opens the Devices window so you can add additional mice, keyboards, and similar
devices to be used for triggers. The Devices window is covered in Appendix B.

Variables and Functions Editor - Opens the Variables and Functions Editor. Variables are covered
in Chapter 7.

Bring All to Front - Pulls all windows associated with QuicKeys to the front.
The Help Menu

Search - Searches in QuicKeys for help based
on what you have entered. ]

QuicKeys Help. ..

QuicKeys Help - Opens the system Help welcome to QuicKeys...
Viewer window to display QuicKeys Help. QuicKeys Community...

Welcome to QuicKeys - Opens the QuicKeys
Welcome screen in the QuicKeys Editor. Internet access is required.

QuicKeys Community - Directs your web browser to the QuicKeys Community discussion forum.
Internet access is required.
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To access QuicKeys’ Preferences, select Preferences from the QuicKeys application menu, or

press Command+comma (88 ,) while QuicKeys is the front-most application. The preferences
window is divided into ten panes: General, Appearance, Triggers, Abbreviations, Typing, Recording,
Notification, Remote, Add-Ons, and Security.

The General Pane

e&nn QuicKeys Preferences

General Settings

EAutomaticallv name single-step shortcuts
[ Automatically save shortcuts

[ Select front application scope when opening QuicKeys Editor

[ Open QuicKeys at login
¥ Warn befare quitting

Updates

[ Automatically check for updates | weelkly I |
W send System Profile
[ Automatically download updates

Check Now

Reset "Do Not Show Again" Messages

General Settings

Automatically name single-step shortcuts - With this option turned on, most new shortcuts will
automatically be named according to the type of shortcut it is. You can always change this name if
it is not to your liking.

Automatically save shortcuts - If this option is off, QuicKeys will prompt you to save edited
shortcuts when you try to close them. If this is turned on, they will automatically be saved before
closing.
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Select front application scope when opening QuicKeys Editor - If this option is selected, the last
known front application is automatically selected in the Scopes section when the QuicKeys Editor
is opened.

Open QuicKeys at login - Select this preference if you want QuicKeys to launch when you log in to
your computer. If this preference is not selected, your shortcuts will not work until you've launched
QuicKeys manually.

Warn before quitting - If you select this option, QuicKeys will ask, “are you sure” when you try to
quit the program. This helps prevent inadvertently quitting QuicKeys.

Updates

Automatically check for updates - Select this option to enable automatic checks for updates to
QuicKeys hourly, daily, weekly, or monthly. Internet access is required.

Send system profile - Send a description of your computer and software to Startly when checking
for updates.

Automatically download updates - Select this option to have updates automatically downloaded.
When they are done you will be asked if you want to install them.

Check Now button - Whether or not you set QuicKeys to check automatically, you can check now:

Reset“Do Not Show Again” messages

Reset button - If you click this reset button, QuicKeys will reset all of its “Do not show again”
check boxes. For example, if you have shut off warnings such as the one when you delete a shortcut,
you can turn them back on by clicking this Reset button.
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The Appearance Pane

eoOn Quickeys Preferences

Appearance

EShow QuicKeys Menu in menu bar

gShow QuicKeys icon in Dock

Changing this setting will affect all users of this copy of QuicKeys and
only takes effect after relaunching QuickKeys.

EShow QuicKeys Menu in Dock

gShow QuicKeys Editor window on launch

™ Show playback controls f in menu bar Hll

Create Menu

Show Favorites: | 5 H-'

Action Description: Ed Display action descriptions

Advanced

[ Show advanced features
Toggles availability of some scope, subscope, and step result controls.

Subscope Switches: [ Show in window Hll

Appearance

Show QuicKeys Menu in menu bar - Turns the QuicKeys Menu, located up by your system clock,
on and off.

Show QuicKeys icon in Dock — When this box is checked, the QuicKeys icon is displayed in the
Dock when QuicKeys is running. You may want to turn this feature off if you don’t care to have
QuicKeys in the Dock. Any changes made to this preference setting will affect all users on that
machine.

Show QuicKeys Menu in Dock - If this menu is turned off, the handy options available to you
when you right-click the QuicKeys Dock icon will no longer be there.

Display QuicKeys Editor window on launch - If this is turned on, the QuicKeys Editor window will
open whenever you launch the QuicKeys application.

QuicKeys 4 User Guide August 2009 34




Chapter 3 — QuicKeys Preferences

Show playback controls - If checked QuicKeys will always show playback controls in the selected
location. “In menu bar” refers to the right side of the menu bar where the QuicKeys menu is. “In
window” refers to the Playback Palette.

Create Menu

Show Favorites - Controls whether and how many of your favorites are shown in the Create menu.
Even if not shown in the menu, they are still available in the Shortcut Actions Palette.

Action Description - When checked descriptions are shown for items in the Create menu as they
are highlighted.

Advanced

Show advanced features - This option toggles the availability of some scope, subscope, and step
result controls. The exact features are identified when they are covered in this manual.

Subscope Switches - Select whether any subscopes you have created should show in the window,
using Growl, or not at all.

Note: Scope and subscope are covered in Chapter 7.
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The Triggers Pane

eoOn Quickeys Preferences

Triggers
Triggers: M Enable shortcut and abbreviation triggers
[ Toggle triggers with hot key
Default Trigger: | Hot Key Hll
Input Compatibility: [ QuicKeys sees user actions first Hll
Input Compatibility controls which software sees user
actions first. Changing this may affect how Hot Keys,
Abbreviations, and Recording work.
Hot Keys
Auto Sticky: S Hot Keys are sticky when grouped
Sticky Duration: )
.f 1 1 Y 1 1
Short Long
Speech
Speech Triggers: [ | Enabled
Speech Prefix: jQuicKevs
Speech Prefix is an optional word or phrase you can
say before Quickeys speech triggers.
MIDI
MIDI Mote #60 is: | C4 B

Triggers

Enable shortcut and abbreviation triggers — Turning this preference off will effectively disable
QuicKeys until it is turned back on. This is the same as turning QuicKeys on or off with the switch
on the QuicKeys Editor toolbar or from the QuicKeys menu.

Toggle triggers with hot key - If you turn this preference on, you can assign a hot key which will
cause QuicKeys triggers to become disabled until you press that hot key again.

Default Trigger - When you create a new trigger for a shortcut, the type of trigger you have
selected here is what will automatically be assigned to your shortcut: none, app event, day & time,
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device, drive, file system, function, hot key, MIDI, QuicKeys menu, repeat, speech, or time range.
Hot key is the most common.

Input Compatibility - This option controls whether QuicKeys or other software sees user actions
(e.g., typing, clicking) first. The default selection is QuicKeys sees user actions first.

Hot Keys

Hot keys are sticky when grouped - When this preference is turned on, multiple hot keys that

are grouped together in a shortcut will be considered “Sticky.” Sticky hot keys must be pressed in
sequence to trigger a shortcut. For example, if you assign both Fr and F2 as hot keys for a shortcut,
and group them together, pressing F1 and then F2 within a couple of seconds will trigger the
shortcut.

Sticky Duration - Increase or decrease the amount of time a sticky hot key remains sticky:.
Increasing the duration means you have more time to press follow-up hot keys after having pressed
the first one.

Speech

Speech Triggers Enabled - With this option turned on (and a microphone attached to your
computer), QuicKeys can listen for speech input if you have assigned phrases to shortcuts as
triggers. You should familiarize yourself with the Speech Recognition portion of your System
Preference’s Speech pane if you are going to use this type of trigger.

Speech Prefix - If desired, QuicKeys can be set to require that a specific phrase be spoken before it
will start comparing what it hears to what you have entered as speakable phrases for your triggers.

MIDI
MIDI Note #60 is — Select C3, C4, or C5 to specify which note is MIDI note #50.
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The Abbreviations Pane

eann Quickeys Preferences

Abbreviations Complete: [ When a trigger is typed Hll
Completion Sound: f No Sound Hll

Abbreviation Triggers

';:_;' Enter lgnore with: €+ [~} m
F .
| Escape lgnore with: < ]
() Non-Breaking Space lgnore with: © @
oy
) Return lgnore with: {+ a

M
— "
() Space lgnore with: {+ [~} I+

= | & | Select the characters that will trigger Abbreviations to complete.

New Abbreviations: E Ignore case
E Match case of typed abbreviation

EAppend typed trigger
E Replace typed abbreviation
"1 Only complete in known text areas

Abbreviations Complete - Select whether abbreviations should complete immediately when the
abbreviation is typed or if they should wait until a trigger is typed. Individual abbreviations can be

K

set to complete “as set in preferences,” “immediately when typed,” or “when a trigger is typed.”

Completion Sound - Select which sound, if any at all, should play to indicate an abbreviation has
completed.

Abbreviation Triggers - If any of your abbreviations will be set to complete when a trigger is typed,
select which characters should be considered triggers. Triggers can be created, deleted, and edited

by clicking the plus, minus, and pencil buttons.

New Abbreviations — Set the default options for new abbreviations.
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The Typing Pane

eann Quickeys Preferences

Typing Speed
e} 0.00sec  (  Sync All Typing Actions... )
1 1 1 1 I
Slow Fast

Typing Actions

Mew Typing Actions: B Type Text
O Insert Text

Special Paste & Insert Handling

Typing Speed

Applications in this list are given
extra help to accept abbreviations,
clips, and insert text actions.

Slider - Set the global typing speed for all new actions where QuicKeys types text. On slower
systems QuicKeys may type faster than the system’s typing buffer; adjust this slider to prevent that

from happening.

Sync All Typing Actions button — Each shortcut step that can type text will have its own slider
much like the Typing Speed slider here. These individual shortcut sliders take precedence but can

all be reset to match the preference’s typing speed by clicking this button.

Typing Actions

Type Text/Insert Text — Most actions in QuicKeys that can enter text can either type the text using
simulated key presses or by inserting/pasting into your document. Each shortcut step that can type
text has its own type/insert text setting. This preference specifies the default setting when making

a new step that enters text.
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Special Paste & Insert Handling

Some applications are unaware of changes to the contents of the system clipboard, which can cause
problems with insert operations. Selecting “Make applications accept insert” or “Make applications
recognize Clip actions” when editing various steps will force all applications to check with the
system clipboard.

Designating specific applications for special paste and insert handling reduces this need.
Applications added to this list will always receive special handling regardless of the step specific
setting. In addition, they will receive special handling for abbreviations.

Adding applications which do not need special handling will only unnecessarily slow your shortcuts
and abbreviations.
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The Recording Pane

eann Quickeys Preferences

Scope Creation

i Automatically assign scope when recording

Instant Shortcut

[ Show Instant Shortcut editor after recording

Action Analysis

[ Do exhaustive click and typing analysis

Some applications' user interfaces may not be accessible to QuicKeys during recording.
Exhaustive analysis may allow recording in those applications.

Scope Creation

Automatically assign scope when recording - When QuicKeys records your actions it can check
which application you are recording in and automatically assign that application as the scope for
that shortcut.

Instant Shortcut

Show Instant Shortcut editor after recording - Select this option to have the editor automatically
open after recording an instant shortcut.

Action Analysis

Do exhaustive click and typing analysis — Some applications’ user interfaces may not be readily
accessible to QuicKeys during recording. Exhaustive analysis may allow recording in those
instances, but it is recommended this feature be kept off unless specifically needed.
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The Notification Pane

eann Quickeys Preferences

E-mail Notifications

Recipients:

[+]-](al

Sender:

SMTP Server:

Notification Script

Script File: | Choose a script file

( Choose Script File... )

When a shortcut step results in failure (or success), QuicKeys can present a dialog to notify you,
Alternately, the results can be sent via e-mail or parsed by an AppleScript or shell script (bash, perl,
python, etc).

E-mail Notifications

Recipients - Enter the e-mail address(es) and/or group(s) to receive step result e-mail notifications.

Sender - Enter the address this e-mail will appear to come from. Depending on your mail server,
this may need to be a valid user account allowed to relay through that server.

SMTP Server - Enter the address of the server to relay the e-mails. You may need to contact your
ISP for this information if you aren’t sure what to enter.

Notification Script

Script File - Select the script file QuicKeys will run for a run script step result. Click Choose Script
File and navigate to it, or drag it into the well. The path will then display in the well.
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For a run script step result, QuicKeys passes the following values as command line arguments in
this order:

1) Notification title

2) Notification message

3) The specific step number that sent the notification
4) The name of the step that sent the notification

5) The name of the shortcut that the step belongs to

6) Whether the step was successful or not (YES or NO)
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The Remote Pane

eann Quickeys Preferences

QuicKeys Anywhere
Remote Control: [ | Allow remote control
Network Port: _5[}100

Changing the network port requires toggling “Allow Remote Control from Devices"
as well as a configuration change on each device listed below.

Remotes: [ Name | Identification

[-]

Remote Administration

Remote Admin: [ | Allow remote administration

Network Port: _ 50000

Changes to Remote Administration settings only take effect after relaunching QuicKeys.

Network Security

The ports specified above must be enabled in any network firewall running on this computer.

( Configure System Firewall... )

QuicKeys Anywhere

Allow remote control - Toggles whether QuicKeys should listen for remote control devices, both
for pairing and for playback.

Network Port - If desired you can change the network port through which QuicKeys communicates
with remote control devices. The default port is 50100.

Remotes — Before a device is allowed to control QuicKeys remotely, it must first pair with
QuicKeys. Pairing is not exclusive to one device, so the list is all devices that have successfully
paired with this copy of QuicKeys. If the device should no longer be allowed to control QuicKeys,
use the minus (-) button to remove it.

Note: Remote control devices are covered in Appendix C.
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Remote Administration

Allow remote administration - This setting allows or disallows the remote network administration
of QuicKeys.

Network Port - If desired you can change the network port through which QuicKeys communicates
with another copy of QuicKeys. The default port is 50000.

Network Security

Configure System Firewall - Opens the Security pane in System Preferences so that you can
configure your firewall.
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The Add-Ons Pane

e&nn QuicKeys Preferences

"
-

Add-Ons are plugins for other applications. QuicKeys uses Add-Ons to get information that
is not normally available from those applications.

Input Manager

QuicKeys uses an Input Manager to safely and reliably load Add-Ons. If you want Add-Ons
loaded automatically you can install the QuicKeys Input Manager. You may be asked to
authenticate as an admin user to install or uninstall the QuicKeys Input Manager.

( Uninstall Input Manager :1

Why is an Input Manager neaded? @

For more information about Add-Ons, see "QuicKeys Help" in the Help menu.

Some features of QuicKeys require information from other applications that isn’t normally
available. Descriptions of elements of web pages and notification of when web pages have
finished loading are critical to making the Web Launcher and Web Actions work correctly and,
unfortunately, are not accessible outside of Safari.

To get access to this information, QuicKeys 4 now ofters add-ons. Add-ons are simply plugins for
other applications that allow QuicKeys to retrieve the information needed to make interacting
with these applications possible.

The Input Manager loads the following add-ons:

QuicKeys Web Action Assistant allows the QuicKeys Web Actions action to interact with some
applications, such as Safari, that use WebKit.

QuicKeys Webpage Load alerts the QuicKeys Web Launcher action when web pages have
completed loading in some applications that use WebKit, such as Safari.

Input Manager - Click Install Input Manager to install the Input Manager. You may need to
authenticate as an admin user. If Safari is running, you will need to quit and relaunch it for the
changes to take effect. When the Input Manager is installed, the button will change to Uninstall
Input Manager so that you can uninstall it if you want to.
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The Security Pane

eoOn Quickeys Preferences

Protected Shortcuts

Master Password: [: Create Keychain )

QuicKeys Keychain Options

Auto-Lock: ¥ Lock after 1 ; minutes of inactivity
! Lock when computer falls asleep

! Lock when screen saver becomes active

Options: || Allow editing if keychain is unlocked

QuicKeys 4 has the ability to securely encrypt shortcuts so that they may only be played and edited
by users who know the Master Password. This allows you to store sensitive data in a shortcut.

Protected Shortcuts
Master Password - This button will appear as either Create Keychain or Change Master Password.

Create Keychain — Before you can encrypt a shortcut, you must provide a password. Please keep
this password safe! Once a shortcut has been encrypted, there is no recovery of the data other
than providing this password. Lost passwords cannot be reset, not even by Startly. There is a
field which allows you to supply a hint for yourself

Change Master Password — Once a password has been set, you can change it by entering the
current password and the new password. There is an option for “Remember password in login
keychain”; however, storing this password in the login keychain can compromise security, so be
sure to read the security warning that appears.

Note: The command for saving a shortcut as protected is in the File menu.

QuicKeys Keychain Options

Auto-Lock - If no auto-lock options are selected, the keychain must be manually relocked: either
by a shortcut with Lock Keychain action (Create > System > Computer Tools) or by the Keychain
Access utility (in your Applications > Utilities folder).
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Lock after inactivity — Relock the keychain once a certain amount of keychain-related
inactivity has occurred. Normal usage of QuicKeys or the OS does not reset this timer unless it
specifically calls upon a keychain-secured item.

Lock when computer falls asleep — Relocks the keychain when the computer goes to sleep.

Lock when screen saver becomes active — Relocks the keychain when the screen saver becomes
active.

Allow editing if keychain is unlocked - If unchecked, you must always present a password to edit a
shortcut regardless if the keychain is currently unlocked. Selecting this option will allow editing of
a shortcut if the keychain is currently unlocked.

QuicKeys 4 User Guide August 2009 48




Chapter 4 — Shortcuts

Creating Shortcuts

Shortcuts can be created in a number of ways, both from inside and outside QuicKeys. Instant
shortcuts work a little differently and are covered in the “Instant Shortcuts” section of this chapter.

Within QuicKeys Itself

On the QuicKeys Editor toolbar, click Create. Navigate through the submenus to select an action.
This creates a new shortcut with that action as the first step. Selecting an action from the Create
menu will do the same thing.

From the File menu, select New Shortcut; or press Command+N. This creates a new shortcut with
no steps. Clicking the plus (+) on the QuicKeys Editor footer while viewing the Shortcuts List will
do the same thing.

On the QuicKeys Editor toolbar, click Record Me. QuicKeys begins recording your actions. (See
the “Recording” section of this chapter for details.) When you end recording, your new shortcut
has your actions during the recording converted into steps. Selecting Start Recording from the
QuicKeys Menu or QuicKeys Dock Menu will do the same thing.

Drag and drop a file, application, or folder onto the open QuicKeys Editor window: This creates a
new shortcut with an Open Items action (set to this item) as the first step.

Drag and drop text from a document onto the open QuicKeys Editor window: This creates a new
shortcut with an Type Text action containing the selected text as the first step.

To learn how to create shortcuts from clips, see Chapter 7.

From the QuicKeys Menu or Dock Menu

From either menu, select Start Recording. QuicKeys begins recording your actions. (See the
“Recording” section of this chapter for details.) When you end recording, your new shortcut has
your actions during the recording converted into steps.

With QuicKeys Toolbars

Drag and drop a file, application, or folder onto a QuicKeys toolbar. This creates a new shortcut
with an Open Items action (set to this item) as the first step. Drag text onto a toolbar to create a
Type Text shortcut. Drag a URL onto a toolbar to create a Web Launcher shortcut.

In Other Applications Using the Services Menu

Your system’s Services submenu (found under the application menu) contains a Create QuicKeys
Shortcut menu item. If you select text in a document or a file or folder from the Finder, choosing
this menu item will instantly create a shortcut of the appropriate type. Note: Not all applications
support the Services menu.
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The Shortcut Editor

The Shortcut Editor appears ®00 Untitled Shortcut 2 | =
when you create a new shortcut (> (e ) /
or open an existing shortcut for
editing.
¥ B All Applications

From the QuicKeys Editor... eo hotkey & F6

* Select a shortcut and then
select Open from the File
menu.

* Select a shortcut and
press Command+Down

Arrow.
No Steps in Shortcut
. Add Here
*  Double-click a shortcut. o
* Right-click a shortcut and
select Edit.
More than one shortcut editing
WlndOW can be Open at the same Select a step to see a description of what it does.
time. This is convenient for io= 0

copying and pasting or dragging
and dropping steps from one
shortcut to another.

The most fundamental parts of the Shortcut Editor include the Shortcut Editor toolbar, the Scopes
& 'Triggers area, the Shortcut Steps area, the help bar, the information pane, the variables pane, and
the footer.

Note: When a shortcut editing window is open, that shortcut is disabled so it will not trigger. If a

shortcut you recently edited isn’t triggering, it may be that you left the editing window open for
that particular shortcut.

The Shortcut Editor Toolbar
Like the main QuicKeys Editor window, the Shortcut Editor window has a customizable toolbar.
Play - Play the shortcut.

Record More - Click this button to tell QuicKeys to resume interpreting and recording your
actions. Steps recorded will be added to the current shortcut rather than creating a new shortcut.
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Rename - A quick way to rename the shortcut.

Shortcut On/Off - One way to turn a shortcut on or off. The on/off state is then indicated in the
Shortcuts List.

The Scopes & Triggers Area

The Scopes & Triggers area of the editor is where you specify in which applications your shortcut
can be triggered, and what types of triggers will activate your shortcut. A shortcut can have more
than one scope, and each scope can have more than one trigger. This area can be enlarged by

dragging the Resize Bar E on the Shortcut Steps heading downward with your mouse, and each
scope can be collapsed/minimized by clicking on the reveal triangle next to the name of each scope.

¥ [ Adobe InDesign C54 +

o0 hot key %+ F3

¥ B Adobe Photoshop CS4

o0 hot key %+ F3
Y & Safari 5
(—1+] hot key % F4

The number of interface elements in the Scopes & Triggers area is somewhat daunting. But each
item is easily identified with ToolTips; simply hover your mouse over any button or pop-up list for
a couple of seconds to see what that item is.

Scope Subscope Add/Remove Scope

¥ HE All Applications ¥ All Parts of All Applications %

[—1+] hot key % F&

@0 O hot key 5 F7

/AN N\

" N
Add/Remove Trigger Trigger Type  Edit Trigger
Group with Preceding Trigger

Scope pop-up list - To set the scope for a particular trigger, choose an item from this list. If the
application you want is not listed, choose Select Application and navigate to it.
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Subscope pop-up list - If advanced features are turned on in preferences, you can set up and
choose subscopes with this pop-up list. Subscopes break application scopes into more focused
mini-scopes. They are explained in the “Scope” section of Chapter 7 of this manual.

Add/Remove Scope buttons — These gray buttons occupy the top right corner of the Scopes &
Triggers area. These buttons are used to create additional scopes or to delete selected scopes.

Trigger Type pop-up list - Choose the type of trigger you want to activate/play the shortcut.
Triggers are explained in detail later in this chapter.

Edit Trigger button - Depending on the type of trigger you are creating, clicking this button will
open a small trigger editing window. Make the selections desired and close the trigger editing
window to complete your trigger.

Add/Remove Trigger buttons — A scope can have multiple triggers. Click on the green button
with the plus (+) in it to add a new trigger. Click the red button with the minus () in it to delete a
trigger.

Group with Preceding Trigger button - If you add a second trigger to a scope, a square, blue button
with a plus (+) in it will appear. Clicking this button will group that trigger with the one above it.
This is explained in the “Iriggers” section of this chapter.

The Steps Area

The Steps area is where you edit the actions you want your shortcut to perform. This area of the
Shortcut Editor will contain one or more steps.

You can select multiple steps by clicking one and then shift-clicking or command-clicking
additional steps.

Shortcut 5teps What this shortcut does when it runs. [ Add Step - | =

1 » & Type Long Date

2 » A Typetext'at'

E @ EE

3» O TypeTime

Each step’s contents may vary widely from the next, and these are covered in the chapters devoted
to actions. There are also some elements common to every step.
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Add/Remove Steps

N
Shortcut 5teps What this shortout does whan it runs. [ Add Step - | — J =

Hide Front Application E

IMGHM Front AppD\ation P-%-]

Step Results: ' ___ x+@ |

Step Number Reveal Steplcon Step Name Enable/Disable Step Step Results

Add/Remove Steps buttons - Clicking the Add Step button will open a pop-up list that mirrors the
Create Menu, allowing you to add a new step to the shortcut. Clicking the Remove () Step button
will delete any steps you have selected at the time.

Step Number - A step’s number is located in the upper left corner of the step.

Reveal triangle — The small triangle to the right of the step number can be clicked to minimize or
reveal the contents of a step.

Step icon - The small icon to the right of the reveal triangle identifies what kind of QuicKeys
action it is.

Step Name - To the right of the step icon is the step’s name. This name is automatically created
from the action you choose and the options you specify. However, you can edit this name by
double-clicking it.

Enable/Disable Step button - The upper right corner of a step contains a small check box that can
be clicked to enable or disable a specific step within a shortcut.

Step Results buttons - If advanced features are turned on in preferences, these elements are
indicators as to how a step’s success or failure will be handled by QuicKeys. The button on the left
shows what QuicKeys will do if that step completes successfully, the one on the right indicates
what happen if that step fails. Clicking on these buttons will open a control so you can make
changes to the Step Results behavior. Without these buttons, you can set step results behavior in
the information pane.

Some steps have an additional feature. You can click resize = and drag to make the step larger.

The Help Bar

When the help bar is turned on, it displays a short description of what a step does. It can be turned
on and off from the View menu.
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The Information Pane

Click the button with the small i to open the information pane. It can also be turned on and oft
from the View menu.

Shortcut Info Tab

[Shmtcutlnfu | Shortcut Toolbars | Shortcut Comments | Step Comments | Step Results ]

Shortcut Icon: | [l Created: -—-
Last Played: May 27, 2009 9:27:48 PM

Show Playback Controls: [ Use Preferences Setting 'ﬂ Play Count: 3

i = 1 &

Shortcut Icon - To customize the look of your shortcut (particularly useful on toolbars) paste or
drag and drop a new graphic into the icon well.

Show Playback Controls — Indicate whether this shortcut will use the playback controls preference
setting, hide the controls even if preferences is set to show them, or show the controls (of the type
set in preferences) even if preferences is set to not show them.

Statistics — The right side of the pane displays the date the shortcut was created, the date and time
it was last played, and the number of times it has been played.

Shortcut Toolbars Tab

This tab lists all the toolbars on which this shortcut appears. If a toolbar has multiple tabs, the tab
name is listed as well.

Shortcut Comments Tab

This tab has a field in which you can enter comments about this shortcut. These comments appear
as a ToolTip when you hover over the shortcut in the QuicKeys Editor and are included when you
print the Shortcuts List.

Step Comments Tab

This tab has a field in which you can enter comments about the selected step. These comments
only appear here.
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Step Results Tab
[ Shortcut Info | Shortcut Toolbars | Shertcut Comments | Step Comments | Step Results ]
On Step Success: [ Jump to Step l-%-] [ Mext Step i-%-]
On Step Failure: [ Stop Shortcut l-%-‘ | Show Dialog i-%-] . m

i = iof?/é

When a shortcut is played, it evaluates each action as a success or failure. By default, if a step
succeeds playback continues with the next step, and if a step fails, playback stops and QuicKeys
presents a dialog to notify you.

If you need to, you can specify different behavior for the success and failure of each step.

On Step Success — Chose Jump to Step and specify a step. Or choose Stop Shortcut and specify a
notification method.

On Step Failure - Chose Jump to Step and specify a step. Or choose Stop Shortcut and specify a
notification method.

To specify a step choose Next Step, This Step, or any specific step in the shortcut.

To specify a notification method, choose Do Not Notify, Show Dialog, E-mail, Growl, or Run
Script. Click the notifications button ' #_J to open the Notifications Preferences and set the
parameters for e-mail and script notifications.

The Variables Pane

Click the button with the = sign to open the variables pane. It can also be turned on and off from
the View menu. The variables pane lists and allows you to manage the variables referenced by the
shortcut.

Referenced Variables @) Global Local | In Use ()
Variable Name | Value | Persistent | Used
IDMumber 0 O 1
Clipkoard You can click resize and drag to ... 0 [
1 = 1 /;,:

All/Global/Local - Choose to view just the global variables, just the local (specific to this shortcut),
or all variables.

In Use - Select this option to view just the variables currently in use in this shortcut. Otherwise the
pane will display all variables that have been referenced since the shortcut’s creation.
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Create New Shortcut Variable — Click the plus (+) to create a new shortcut (local) variable.

Variable Name — This column shows the name of the variable. Double-click the name to change it.
Value —This column shows the current value of the variable. Double-click the value to change it.
Persistent — This column shows whether the variable is persistent. Click the check box to change it.

Used — This column shows how many times the variable is used in this shortcut. If the variable is
not being used, you can click the X to remove it from the list.

For more information on variables, see Chapter 7.

The Footer

The footer is the bar along the bottom of the window:

i = 7ot9
Information - Click the button with the small i to open the information pane.
Variables - Click the button with the = sign to open the variables pane.

Number of Steps - Indicates the number of steps in the shortcut. Also indicates how many; if any,
steps are currently selected.
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Triggers

A trigger is the signal for QuicKeys to start playing a shortcut. Triggers are set in the Scopes &
Triggers area of the Shortcut Editor.

Trigger Types
App Event

Shortcuts can be triggered automatically after a specific

application opens, quits, becomes front-most, leaves the | @ Application Event

front, or stops responding. Application: [ & Safari L2
Event: [Dpens '—H
Example: Let’s say that whenever you open Safari you EventDelay: | 5 7| secs

want to open several web pages. You can create a
shortcut with Web Launcher actions and use § seconds
after Safari launches as the trigger.

Application - Choose the application which will be used as the trigger. If the desired application
is not running it will not show in this list and you will have to choose “Select Application” and
navigate to it.

Event — Choose the event you want QuicKeys to watch for in relation to the chosen application.
* Opens —Trigger when the chosen application is launched.
*  Quits —Trigger when the chosen application quits.
* Becomes Front —Trigger when the chosen application becomes front-most.

* Ends Front —Trigger when the chosen application is no longer front-most.

Event Delay - Delay the actual triggering of the shortcut for as long as needed to account for things
like slow loading applications.

Day & Time
Shortcuts can be triggered automatically at a @ Day & Time
certain date and time. Days: 0s Om @M1 Mw @7 Mr s

Time: | 1:00 AM[3]

Example: At 1:00 AM, Tuesday through Saturday,
QuicKeys can start up your computer and begin Trigger: () Only at specified tme

backups or other maintenance tasks. SEELL S
Computer: | | Wake | 1 minute before

Days — Put a check in the box next to each day ™ start up | 5 minutes before -+
that you want this trigger to be active.

Time - Set the time of day at which you want this trigger to activate.
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Trigger - Specify whether the trigger should fire only at the specified time or at any time it is
overdue.

Computer - If your computer may not be awake or on at the time you specify, QuicKeys can wake
it or start it up for you.

Device
With device triggers you can directly assign @ Device
shortcuts to buttons on your mouse, trackball, Action: Button 3 on any device &
joystick, and even keys like Eject and Mute on [ SetAction.. | Other Actions » |
your keyboard' Madifiers: [} % Command
(] 4 shift
Note: If you are simply wanting to assign a [ X Option
key or combination of keys such as Fr or L1 Central
Command+M as a shortcut trigger, use a hot ("Advanced Options... )
key trigger.

[ Setup Devices... )

Action — Choose which button on which
device (a specific device or any device) you
want to use as a trigger. Use the Set Action button to put QuicKeys in a “listening” mode while you
press the button or key you want to use. Or, use the Other Actions menu to choose from common
buttons and keys. You can click the pencil icon to rename the action.

Modifiers - Adding modifier key requirements to Device triggers lets you define more triggers per
device. For example, you might have the 3rd button on your trackball set as a trigger to launch
Safari, but pressing Option while clicking your 3rd trackball button launches Internet Explorer
instead.

Advanced Options — This button opens the Advanced Device Trigger Options window. Most
often no advanced settings will need to be made. This window is covered in the “Device Triggers”
appendix.

Setup Devices — This button opens the Devices window so that you can set which devices can be
used with QuicKeys for device triggers. This window is covered in the “Device Triggers” appendix.

Drive
Shortcuts can be triggered when a drive is mounted or & Drive Connection
unmounted. Drive: | Any Drive

Action: [ Mounted

Drive - Select a specific drive or any drive.

Action - Select whether the shortcut should be triggered when that drive is mounted or
unmounted.

QuicKeys 4 User Guide August 2009 58




Chapter 4 — Shortcuts

File System

File system triggers let QuicKeys © File System
fire shortcuts based on changes to
the contents of a folder or other file
system related reasons.

Monitor path: [ Macintosh HD [

[] Follow path if moved (except to Trash)

Max folder depth: ‘—Q— 2
1 1 1 1

Example: If you want to know [ lgnore changes to subfolders
when someone adds something to (] store changes in | Global
your dropbox use this to trigger
a shortcut with a notification
(shortcut status) action. You could even create a shortcut to begin processing the files.

Monitor path - Specify the folder you want to monitor for changes. Drag a folder into the well, or
click the folder button to navigate to it.

Follow path if moved (except to Trash) — Select this option to have QuicKeys keep track of the
path even if you move it or rename it.

Max folder depth — QuicKeys can keep track of changes inside subfolders of the specified folder. To
monitor inside subfolders set the path to 2 or more. Specify 1 to only monitor changes just inside
the specified path.

Ignore changes to subfolders - Changes to folder are not reported, but changes to files will still be
reported.

Store changes in — QuicKeys can record the changes that occurred in a QuicKeys variable. Select
which variable should be used.

Function

Function triggers allow you to make your own custom @ Function Trigger

AppleScript trigger functions so that almost anything Function: | Check Drive Space |4
can become a QuicKeys trigger. The script is checked Runevery: ‘30 (i [minutes 5]

periodically, and if it returns TRUE, QuicKeys will fire
the shortcut.

Example: If you have a drive on a remote machine and need to know when it is getting full, create a
script to check it and then use a notification (shortcut status) action to send you an e-mail. Or use
QuicKeys to move or delete files automatically.

Function - Choose from the list of functions you have created in the Variables and Functions
Editor (see Chapter 7).

Run every - Select seconds, minutes, hours, and days, and enter a number in the available field
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Hot Key
You can assign a keystroke or combination of keystrokes @ Hot Key
with or without modifier keys as a shortcut trigger. This = (8~

is by far the most common trigger used with QuicKeys.
It can be as simple as pressing your F1 key or as complex
as pressing a series of chained hot keys.

{*) Trigger when pressed
"] Hot key repeats

() Trigger when released
1 Hot key is sticky
Hot Key — When this field is highlighted, the next
keystroke or key combination you press will be assigned
as the hot key trigger. If the key combination appears in red text, that key combination is already
assigned to another shortcut, so you may need to consider using a different key combination.

Note: Two or more shortcuts assigned the same hot key trigger may both fire when that key
combination is pressed. Their simultaneous activation depends on the assigned scope of those hot
key triggers.

Trigger when pressed/released - This pair of radio buttons let you choose between setting your
trigger to fire when the designated key is pushed down or when it is released. Most hot keys are set
to trigger when pressed; only special cases would benefit from triggering upon release.

Hot key repeats — Normally if you press and hold a key which is set as a hot key trigger in
QuicKeys, it will only trigger that shortcut once. But if you turn on the hot key repeats option,
holding the hot key down will trigger the hot key as rapidly as you have your key repeat rate set in
your system preferences.

Hot key is sticky - When a hot key is set sticky, pressing that key will still trigger the shortcut
unless there is another trigger grouped with it. If there is another hot key grouped with a sticky
hot key, the two must be pressed in sequence to activate the shortcut. This setting is something of
a legacy item for hot keys that were created sticky in earlier versions of QuicKeys. If your goal is to
create chains of keystrokes as triggers you can simply create and group them in the desired order
rather than turn on this sticky setting.

MIDI
These triggers let you fire shortcuts from MIDI @ mipi
enabled musical instruments or equipment. You can Trigger Action: [ Control Change |4 ( Set.. )
even specify musical chords as triggers. . |2
. . : : Value: | Any val :
Trigger Action - Specify the type of MIDI signal alue: | Ay Yalue —
for this trigger. Select Note On, Control Change, or
Program Change from the pop-up menu. MIDI Device: | Any Device )
Channel: [ Any Channel '%]

Or use the Set button to put QuicKeys in a
“listening” mode while you press the key or use the
control you want to set as the trigger.
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Control - (Only present with Control Change) Specify the MIDI control signal that will cause the

trigger to fire.
& mMiDi

Trigger Action: [ Note On I-H l: Set... ]

Value - (Only present with Control Change) Set
how the value of the control signal is evaluated. Notes:

Notes - (Only present with Note On) Specify the

notes or notes that when played will cause trigger to

fire.
-

MIDI Device: | Any Device

Program - (Only present with Program Change)
Specify the program that when changed to via a
MIDI signal will cause the trigger to fire.

I-%-l
I'%'l

Channel: [ Any Channel

2 Mo

MIDI Device - Specify which MIDI device QuicKeys
will listen to for this particular trigger.

Trigger Action: ( Program Change ‘-H ( Set... )

Program: 0 T

. . il i :
Channel - MIDI signals can be sent on different Pt G A -
Channel: | Any Channel '-H

channels. Specify the channel to listen on here.

QuicKeys Menu

This is a good way to trigger infrequently needed shortcuts, avoiding
the need to remember seldom used hot keys. If the QuicKeys Menu is
not visible then either QuicKeys is not running or the menu preference
has been shut off.

@ Show in QuicKeys Menu

Repeat

Repeat triggers will repeatedly activate after a set amount of time
has passed. If the repeat trigger is scoped to All Applications

that shortcut will start firing when you close the Shortcut Editor I
and the allotted amount of time has passed. If it is scoped to a
particular application, it will start triggering after that application
is opened.

) Repeat

lEII @ [ minutes \-H

Example: A repeat trigger can be used to create an auto-save feature in particular application.
Simply scope it to that application, use a repeat interval of 10 minutes or so, and add a step that
types Command+S or chooses Save from the menu.

Repeat Interval - Select seconds, minutes, hours, and days, and enter a number in the available

field.

Speech i

Open TextEdi
If you have a headset or microphone attached to your Mac 2 — )
and configured properly, you can assign a unique phrase for ()
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any QuicKeys shortcut you make, which when spoken will activate that shortcut. The phrase you
choose combined with the prefix specified in QuicKeys Preferences trigger pane is what you need
to say to trigger a given speech shortcut.

Example: If you are setting a speech trigger for launching TextEdit you may want to enter a phrase
something like “Open TextEdit.” Combine that with the prefix and your speech phrase becomes
“QuicKeys, open TextEdit.”

Note: QuicKeys is not directly interpreting your spoken commands; that technology is part of
Mac OS X and QuicKeys is simply making use of it. If you have difficulty getting shortcuts to fire
reliably with speech triggers there is no adjustment to QuicKeys that can be made. Instead look
into your microphone quality, sensitivity, and configuration; the trigger phrases you have chosen;
and the way you annunciate when speaking those phrases.

Phrase - Enter the desired phrase to combine with any speech prefix and speak as a trigger.

Time Range
Thls Option is technicaﬂy a @ Time Range Use time ranges to modify or limit other triggers.
qualiﬁer I‘ather than an aCtual From: Hour: | Al : To: Hour: L I PM :
trigger. It will not directly trigger Minute: . Minute, .
a shortcut, but if you group this
qualifier with another trigger, you Month: | Any Month: | Any
can limit that trigger’s operation to Day: | Any Day: | Any
specified time ranges.

Year: Any Year: Any
Example: Outside working hours WeekDays: s MM MT Mw M1 MF s

you may want to disable a certain
shortcut trigger so it will not fire
when its hot key trigger is pressed. To do so you would create a time range trigger and group it with
a hot key trigger.
From — Starting time to make the grouped trigger active.
To - Ending time to make the grouped trigger inactive.
Week Days - Days on which the grouped trigger is active.
There are a few basic rules to how the time range trigger qualifier behaves:
¢ Ifyou assign both a From and a To number for any unit (a unit being defined as a minute,
hour, day, month, etc.), triggers grouped with your time range qualifier will only be active
between those From and To values. For example, if you set the Hour as From 8§ AM To 5

PM, a grouped hot key will not work before 8 AM or after 5 PM.

* Ifyou leave a field blank, QuicKeys assumes “Any” value is acceptable.
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* If you enter a value in a units From field but leave the To field blank, QuicKeys assumes the
highest number possible in that field. For example, if you enter 15 in the From Minutes field
and leave the To Minutes field blank, the grouped trigger will be active from “:15 to Any”, or
from 1§ minutes after until the end of that hour.

* Ifyouleave both the From and the To fields of a particular unit blank, that unit is ignored.
For example, if you leave both the From Day and To Day fields blank, the day of the month
is ignored when QuicKeys checks to see if the grouped trigger should be active.

* If you uncheck any of the Week Days, the grouped trigger will never be active on those
unchecked days of the week.

Trigger Grouping

QuicKeys can be told to group a number of triggers in the same scope. Grouping triggers means
that both conditions must be true for the shortcut to fire. To group a trigger with the one above it,
simply click the blue button with the plus sign in it. When triggers are grouped this button changes
to a minus sign which you can click to ungroup that trigger from the one above it. Grouped triggers
are easily identified by the surrounding light gray frame.

Why Group Triggers?

There are essentially two reasons you would want to group triggers:

Chaining hot keys - If you group two or more hot key triggers, QuicKeys will treat them as “sticky”
and expect to see them pressed in order to trigger their shortcut. For example, if you group a hot
key trigger of F5 and another hot key trigger of F6 you’ll need to press F5 then press F6 within

the next couple of seconds to trigger the shortcut. More than two hot key triggers can be chained
together with grouping.

Grouping hot keys opens up an endless supply of intuitive chains of key presses you can use to
trigger your shortcuts. For example, all of your application launching shortcuts could be triggered
by chained hot keys. Each chain might begin with Control+A (for application) followed by a couple
of letters relating to the application name, such as X and L for Microsoft Excel.

Scopes & Triggers Whersa, when, and why this shortcut runs. [ Add Scope - | = J

¥ I All Applications &

(- 1+] hot key % * A
o0 B2 hot key + X
e B hot key % L

Adding a time range qualifier to a trigger — Any trigger can be grouped with one or more time
range qualifiers to restrict the times when that shortcut can be activated. A single time range
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qualifier can restrict a shortcut to firing only between 8:00 AM and §5:00 PM for example. If you
want to also restrict it to firing only between Noon and 4:00 PM on Saturday, just group a second
time range qualifier.

¥ [ All Applications 3

(-1+] hot key % F7

et B2 time range * 8 AMto 5 AM on MTWTF
o0 O hot key 3 F7

et B time range % 12 PMto 4 PM on 5

When Not to Group Triggers

Grouping triggers is a powerful tool, but if used improperly it will make your shortcut unable to be
triggered. When grouped, the triggers are connected with a “logical AND” which means that both
of the triggers must be ON or TRUE at exactly the same time for the shortcut to run. For example,
if you tried to group a hot key trigger with a Date & Time trigger set for at 4:37 PM, will you be
able to press that hot key at exactly 4:37:00 PM?

¥ [ All Applications 3

(-1 +] hot key 3+ ~C

0 B speech & "Clips"
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Steps

Actions are the building blocks of shortcuts. Each step tells QuicKeys which action to perform.

For example, Press Button is an action available in the Create or Add Step menus. Select this action
to add it to your shortcut as a step. Then, set the options so QuicKeys can find the button by name
or location, and your step is complete.

Most everything you need to know about steps is covered in the “Shortcut Editor” section of this
chapter and in the chapters covering the individual actions. There are two additional topics to
cover here: searching for actions and using the Shortcut Actions Palette.

Action Search . CO—

There are two types of search fields in QuicKeys: Shortcut Search and Action Search. Shortcut
Search is covered in the “QuicKeys Editor” section of Chapter 2.

The Action Search field is found in the Create menu (in the menu bar and from the Create button
on the QuicKeys Editor toolbar), in the Add Step menu (in the Shortcut Editor), and in the
Shortcut Action Palette.

Enter your text and QuicKeys will find matching actions.

Shortcut Actions Palette

When building your shortcuts, you can drag and drop actions and existing shortcuts in. The
Shortcut Actions Palette makes this easy.

800

() i) S )
e oty Late 0

» i Files f Assign variahle
(® Internet & Network | (7] Batch Processor
» QuicKeys Begin Repeat Loop
» +» Scripting I Bring All Windows to Front
» I3 System Cy' Button
» A Text @ Cancel Recording
» k User Actions Cascade Windows
@ Favorites [LJ] Change Folder
E Shartcuts & Check for Application

» Check for Button

» Check for Date & Time

Z= Check for Menu

@ Check for Window

k Click 5

@ Quickeys Plugin Actions. Double click an action to begin.
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You can open the palette from the Create menu (in the menu bar and from the Create button on
the QuicKeys Editor toolbar) and the Add Step menu (in the Shortcut Editor).

All Groups - Select All Groups to see all the available actions in alphabetical order. Select any
category or subcategory to see the corresponding actions.

Favorites — Select Favorites to see just your favorite actions. Select any action and click the

favorites button to tag it as a favorite.
Shortcuts - Select Shortcuts to see all of your shortcuts.

Information - The area at the bottom of the palette displays information about the selected item.
Click the information button to turn it on or off.
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Recording

Shortcuts can be built manually, or QuicKeys can make them for you by recording practically
anything you can do. All you have to do is tell QuicKeys when to start recording and when to stop
recording. QuicKeys will then make a new shortcut containing steps that reproduce your actions.
Just add a trigger and a do a little tweaking and you’ll be up and running with a new shortcut.

Start Recording

There are several ways to tell QuicKeys to start recording:
* Select Start Recording from the QuicKeys Menu or from QuicKeys’ Dock menu.
* From within the QuicKeys Editor, click the Record Me button in the toolbar.
* When editing a shortcut, click the Record More button in the toolbar.

* Press Command-+Fr to trigger the Toggle Recording shortcut that was installed by default
with QuicKeys 4.

Note: If you press the Option key when you start recording, the “Do exhaustive click and typing
analysis” preference will toggle to the opposite setting for the current recording.

All of these methods open the QuicKeys Recording palette.
While this palette is present, QuicKeys is monitoring and
recording your every action.

QuicKeys Recording

Recording

I:: Cancel Recording :]I {: End Recording ::I

Stop Recording

‘When you want to stop recording, use one of the following options:
* Select Stop Recording from the QuicKeys Menu or from QuicKeys’ Dock menu.
* Click the End Recording button in the QuicKeys Recording palette.

* Press Command+FTr to trigger the Toggle Recording shortcut that was installed by default
with QuicKeys 4.

When you end recording, your new shortcut opens in the Shortcut Editor with your actions during
the recording converted into steps.

Cancel Recording

End recording saves your actions, while canceling stops recording and discards any recorded steps
from that recording session.
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To cancel recording, use one of the following options:
* Select Cancel Recording from the QuicKeys Menu or from QuicKeys’ Dock menu.

* Click the Cancel Recording button in the QuicKeys Recording palette.

Recording Preferences

There are two settings on the QuicKeys Preferences Recording pane which relate to the recording
of regular shortcuts.

Automatically assign scope when recording - When QuicKeys records your actions it can read
which application you are recording in and automatically assign that application as the scope for
that shortcut.

Do exhaustive click and typing analysis — Some applications’ user interfaces may not be readily
accessible to QuicKeys during recording. Exhaustive analysis may allow recording in those
instances, but it is recommended this feature be kept oft unless specifically needed.
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Debugging Shortcuts

QuicKeys has a debugging tool that can help you troubleshoot your recordings. Select Turn on
Shortcut Debugging from the Shortcut menu to activate this tool.

Using Debugging

The QuicKeys playback palette will appear whenever you play a _ _ QuicKeys
shortcut while debugging is turned on. Use the single step button
(the second from the left) on this palette to step through your S e e e
recording one shortcut step at a time.

During playback, when QuicKeys encounters a Click,
Windows, Button, Pop-up Menu, or Wait type action,

the debugger will take over and ask for your input. [Nonel+
[Basic Graphics Frame]

* If the step shown by the debugger is correct, fasic Text Frame]
click the Continue button. Object Sivke ©

* If the step shown is not accurate, click the
Stop & View step button. The Shortcut
Editing window will appear with the
questioned step highlighted.

* Click the Stop button during debugging to
simply stop.

( Stop ) ( Stop & ViewStep ) ( Continue )

Correct window for click point?

This debugging feature is very useful and will help you figure out whether or not QuicKeys is
finding the desired buttons and windows on playback. Problematic steps identified by debugging
can either be hand edited or deleted and recorded again.

Timing Is Everything

Sometimes a shortcut may work perfectly when stepping through it in debugging mode, yet fail
when played normally. The majority of the time the real problem during playback is timing. Buttons
and windows won’t be found, menu items won’t be active, etc., if the timing of a sequence is not
right. It takes time for the system to load an application, draw a new window, switch from one pane
to another, etc., and on slower systems it is much more noticeable.

The solution is often adding the simplest shortcut step that exists in QuicKeys, the Pause action.
A pause of 0.5 seconds here or 2.0 seconds there will often mean the difference between a working
shortcut and one that fails intermittently. To avoid waiting even a tenth of a second longer than
necessary, use a Wait action instead. Use Wait for Button and as soon as the button exists, your
shortcut is off and running.

QuicKeys 4 User Guide August 2009 69




Chapter 4 — Shortcuts

Playing Shortcuts

Shortcuts can be activated or played
* by using the assigned triggers
* by selecting Play from the Shortcuts menu in the QuicKeys Editor.
* by clicking Play on the Shortcuts Editor toolbar

* from within another shortcut with an Insert Shortcut step

Instant shortcuts can be played
* by selecting Play Instant Shortcut from the QuicKeys Menu

* by creating and using a shortcut with a Play Instant Shortcut action

When you play a shortcut, the Playback Controls appear (if you have not turned this feature off in
QuicKeys’ preferences), giving you feedback regarding the progress of the shortcut that is playing.
When the shortcut finishes playing, the playback controls will disappear.

The preference setting determines the default behavior of playback controls: whether to show

or not; and when shown, to appear in the menu bar or in a window called the Playback Palette.
Individual shortcuts can be set to use the playback controls preference setting, hide the controls
even if preferences is set to show them, or show the controls (of the type set in preferences) even if
preferences is set to not show them.

Menu Bar Playback Controls

QuicKeys Menu - Click the black Q to see the QuicKeys menu. (@ n_m Satl:16PM Q

Play/Pause Button — This button pauses a playing shortcut and resumes a paused shortcut.
Stop Button - Clicking this button will stop a playing shortcut.

Playback Palette Controls

Play/Pause Button - This button pauses a playing shortcut and __ _ Quickeys
resumes a paused shortcut. " )

1 Pause shortcut for 60 seconds

Single Step Button — When a shortcut is paused you can use this
button to execute the next step in the shortcut.

Stop Button - Clicking this button will stop a playing shortcut.

Step Number and Name - Across the bottom of the QuicKeys playback palette is the name of the
step that is currently playing.
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Instant Shortcut

Instant Shortcut is for those times you just want to quickly automate something and keep right on
going. This special shortcut lets you make a quick, temporary recording of your actions that can be
played back over and over until you record a new instant shortcut. You can, of course, save a copy
to add to your collection of useful shortcuts.

Recording the Instant Shortcut

From the QuicKeys menu or the QuicKeys Dock menu, QuicKeys Recording
select Start Recording Instant Shortcut. After that, the Recording Instant Shortcut
actual recording process for the instant shortcut is the same
as for a regular shortcut.

I:: Cancel Recording End Recording ::I

Important Note: Recording an instant shortcut overwrites the existing instant shortcut.

When you are finished recording, your instant shortcut is ready to use. However, if you have
selected “Show Instant Shortcut editor after recording” on the Recording pane of QuicKeys
Preferences, the Instant Shortcut Editor will open when recording stops. Your instant shortcut will
ready to use once you review the shortcut and close the editor.

You may want to use a regular shortcut with the Start/Stop Recording Instant Shortcut action to
control recording rather than making the selection from the menu.

Note: One of the default shortcuts for QuicKeys 4 is Start/Stop Recording Instant Shortcut.

Playing the Instant Shortcut

The instant shortcut does not have a trigger the way regular shortcuts do.

You can play your instant shortcut by selecting Play Instant Shortcut from the QuicKeys menu or
the QuicKeys Dock menu. However, you may want to use a regular shortcut with the Play Instant
Shortcut action to trigger your shortcut rather than making the selection from the menu.

1 * 7 Play Instant Shortcut

Quickeys Action: [ Play Instant Shortcut I-H

The Instant Shartcut is a special shortcut you
can use for quick, temporary recordings of
YOour actions.

Note: One of the default shortcuts for QuicKeys 4 is Play Instant Shortcut.
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The Instant Shortcut Editor

The Instant Shortcut Editor
appears when you record a
new instant shortcut (if you
have selected this option

on the Recording pane of
QuicKeys Preferences) or
when you open the instant
shortcut for editing.

1 v & Click at location 1373 h 333 v

Click Location

Horizontal: | 1373 |@ [ SetLlocation... ) Click Location is where the mouse cursor
b will be moved to and the button pressed
From the QuicKeys menu, the verweats [ 533]) e
QuicKeys Dock menu, or the Click Relative To: (¥ Display Details
File menu within QuicKeys, e G
SCICCt Edit Instant ShOftCUt. Horizontal: | 1365 |@ [ SetLlocation... ) Release Location is where the mouse
. cursor will be moved to and the button
Or press Command+Shift+1. Vertical: 7a7]f2) et L
Release Relative To: B Display Details
The Instant Shortcut Editor > Details

is very similar to the Shortcut
Editor.

Select a step to see a description of what it does.

Saving the Instant
Shortcut

As soon as you create it, your instant shortcut is saved and ready for use... as an instant shortcut.
If you would like to save it for long-term use, select Save Copy of Instant Shortcut from the File
menu.

No Scopes in Shortcut ——J
Add Scopes Here

This opens your shortcut in the standard Shortcut Editor. Simply assign one or more scopes and
triggers, name it, and save it.
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Abbreviations let you type a short word (an Abbreviation) in a document and automatically replace
it with other longer text, run a QuicKeys shortcut, or even paste in a QuicKeys clip. Abbreviations
are extremely useful for typing all the things you type often.

Creating Abbreviations

From the File menu, select New Abbreviation; or press Option+Command+N. This creates a new
abbreviation. Clicking the plus (+) on the QuicKeys Editor footer while viewing the Abbreviations
List will do the same thing.

The Abbreviations Editor is part of
the QuicKeys Editor whenever you Abbreviation: | newabbr |
are viewing the Abbreviations List. M ignore case

Completion: Shortcut  Clip

Abbreviation — The name of your
abbreviation is the text you type to
set the abbreviation in motion.

Ignore Case - Select this option

in order to have the abbreviation Extras: | Add Text Element R
complete regardless if it is typed in
upper or lower case. Style: | Plain Text HA

Options: E Match case of typed abbreviation

Completion - Select Text, Shortcut, # Append typed trigger

or Clip to indicate how this
abbreviation will be completed.
Each of these options is covered
later in this section.

Completes: [ As set in preferences |+!

Scope: [ E All Applications

Usage: E Replace typed abbreviation
Completes - Choose whether "1 Only completes in known text areas
this abbreviation should complete
immediately when typed or when Rt
a trigger is typed regardless of the
preferences setting, or if it should complete as set in preferences.

Scope - Set the scope of this abbreviation.
Usage -

Replace typed abbreviation — Select this option to have the completion replace the
abbreviation. Clear this option to have the completion append the abbreviation.

Only completes in known text areas — If you find this abbreviation is firing inappropriately—for
example, in an application that uses letters to switch tools, you may coincidently switch tools in
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an order that spells out one of your abbreviations—select this option so that this abbreviation
only completes in known text areas. However, some actual text areas may not technically be
known text areas. If your abbreviation is not completing when you feel it should, remove this
option and consider using a scope exception.

Preferences - To review or change your preferences on the Abbreviations pane, click the Open
Abbreviations Preferences ' button.

Text Completion

The most common type of abbreviation is
one that replaces (or appends) the text you
type with longer text.

Completion: (=1} Shortcut Clip

Simply type (or copy and paste) the text
you wish to have inserted into the

Completion field. Extras: 'r Add Text Element '-"'-‘

Extras - You can use an abbreviation for Style: [ Plain Text F
more than just ordinary text. Select any
extras from the menu and they will appear

Options: E Match case of typed abbreviation
EAppend typed trigger

in the field above.
Style - Your completion can be plain text or rich text. To format ek Elements
rich text, paste it already formatted or select Format from the Date & Time >
Edit menu Text Insertion Cues >
Options— Clobal >
Functions >
Match case of typed abbreviation — Without this option the P
completion text will always be inserted in whatever pattern & (concat)
of upper and lower case you created it. Select this option if + (plus)
you would like your completion transformed to all caps or - (minus)
initial cap if that is how you type the abbreviation. /" (divided by)

= (set equal to)
% (multiplied by)
Append typed trigger — If this abbreviation uses a trigger negative
(e.g., space) to complete and you would like that trigger to

. . . . Left Parenthesis
be included in your document, select this option.

Right Parenthesis
Comma
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Shortcut Completion

Abbreviations can play shortcuts instead
of typing text.

After selecting Shortcut in the
Completion area of the Abbreviation
Editor, select the shortcut you wish to

play.

Clip Completion

Abbreviations can even insert clips.

After selecting Clip in the Completion
area of the Abbreviation Editor, select
the clip that you wish to complete this
abbreviation.

Completion:  Text Clip

[] Clips - Cather\Manage i

Ej Clips - Insert\ Type

¢} Copy of Instant Shortcut
©® Example Shortcut

B Hide Front Application
H Hide Other Applications

i iTunes - Next Track

* iTunes - Previous Track

Completion:  Text Shortcut £80:

Group Selected:
All Groups

PR

~ Example Clip

LK

S

Viewing Group:
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QuicKeys Toolbars are small floating palettes that enable you 00 O Example Toolbar

to play shortcuts with a single click. These toolbars have three (FooTab | Second Tab }
components: the toolbar itself, the buttons on the toolbar, and T 2= [

the toolbar tabs. You can create or edit these components using e @ @ ‘l.t == )

the Toolbar Editor sheet.

Toolbars can be opened and closed with a hot key or by selecting them from the QuicKeys Menu
or the QuicKeys Dock Menu. They can be universal or they can be scoped to specific applications,
accessible only when the scoped application is running,.

Note: It’s important to note that the toolbars discussed in this chapter are floating toolbars you
create to hold and play your shortcuts; whereas the QuicKeys Editor and Shortcut Editor toolbars
are simply part of the QuicKeys application user interface.

Creating Toolbars

From the File menu, select New Toolbar; or press Shift+Command+N. This creates a new toolbar
and opens the Toolbar Editor sheet. Clicking the plus (+) on the QuicKeys Editor footer while
viewing the Toolbars List will do the same thing,.

The Toolbar Tab

Name - This is the name of the new
toolbar as seen in its title bar.

00

| Toolbar | View Tabs |

Hot Key - You can show or hide a
QuicKeys toolbar with a hot key.

Mame: |Untitled Toolbar

Select the Hot Key field and press Hot Key: |unassigned Clear
the key(s) you want to use to display [ = .
the selected toolbar. Click the Clear T ————— 1+
button to remove your hot key

selection.

Scope - You can choose whether a
toolbar displays only when a specific (oK )

application is front-most, or whether
it appears regardless of which
application is in front.
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The View Tab

Type - There are two types of
toolbars, standard and docked:

Standard toolbars can be
moved anywhere. You can click
on the title bar of the toolbar
and drag it to another location.

A docked toolbar attaches

to the edge of the computer
screen. This type of toolbar is
useful when you always want
to know where your toolbar is.
You can drag docked toolbars
from one side of your screen
to another. Docked toolbars
will spring back to the closest
screen edge when you drag
them away from an edge.

Ve

I Toolbar | WView | Tabs |

Type: [ Standard |+l M Always on top

lcon Size: = ————— 32,32

Placement: [ lcon Only (No Name) I+]

Resize: ™ Automatically

Orientation: ® Horizontal () Vertical
Tabs: ®Top  (OBottom () Left (O Right

i)

Always on top - Select this option to ensure that this toolbar always displays on top of other active
application windows. This option is useful because it gives you easy access to the toolbar.

Icon Size — Use the slider bar to specify the size of icons in your toolbar. The dimensions of the
icons appear next to the slider.

Placement - Select how the shortcut name and icon should be placed in relation to each other:

Name Only (No Icon)
Name Right of Icon
Name Above Icon

Name Overlaps Icon

e Icon Only (No Name)
*  Name Left of Icon

* Name Below Icon

Resize — Select Automatically to cause this toolbar to resize to accommodate a change on a toolbar.
If you have turned off this option, you can resize a toolbar by clicking on the lower right corner of
the toolbar and dragging.

Orientation — Choose whether you want your toolbar to display horizontally or vertically.

Tabs - If your toolbar has multiple tabs, this setting tells QuicKeys where to put those tabs.
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The Tabs Tab

You can create multiple tabs for

your QuicKeys toolbars. Multiple
tabs enable you to organize the
buttons and make your toolbars more
compact. Click the Add Tab button to
add a tab and provide a name for the
tab in the Tab Name field.

The toolbars first tab will be named
the same as the toolbar itself unless

you change it.

Edit the names of existing tabs by
selecting them from the Tabs menu.

Select a tab and click Delete tab to
delete it.

Editing Toolbars

You can use the following methods to bring up the Toolbar Editor

L0 O O Example Toolbar |

' Toolbar  View | Tabs }

Tabs: | Second Tab |+i

Tab Name: Second Tab

( Delete Tab ) ( Add Tab )

heet: Edit Toaolbar...
sheet: Delete Toolbar...
*  From the QuicKeys Editor Toolbar List, double-click the Iclon Size...
name of a toolbar. This will also show the toolbar if it is not Placement >
lready shown Toolbar Type >
already shown. v Automatically Resize
* At any time the toolbar is shown, right-click it and select Edit Add Tab...
Delete Tab [

Toolbar.

Right-clicking a toolbar brings up a contextual menu that lets you
make changes to your toolbar. These are the same settings as on the

Toolbar Editing sheet.
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Adding Shortcuts to Toolbars

You can add shortcuts to QuicKeys toolbars using any of the following methods:

Drag shortcuts from the Shortcuts List or Shortcut Actions Palette and drop them onto a
toolbar.

Drag and drop a file, application, or folder onto a toolbar. This creates a new shortcut
with an Open Items action (set to this item) as the first step and adds that shortcut to the
toolbar.

Note: Dropping a file onto an existing toolbar button that represents an application will
open the file in that application if possible.

Drag text onto a toolbar to create a Type Text shortcut.

Drag a URL onto a toolbar to create a Web Launcher shortcut.

Note: When you drag an item onto a toolbar that has the automatically resize option turned on,
the buttons already present will move except for application buttons which can act as drag & drop
launchers. You may need to press Command+Option to force application buttons that are already
there to move out of the way so you can put the new button in place.

You can remove shortcuts from your toolbars in these ways:

Toolbar buttons are automatically deleted when the shortcut represented by that button is

deleted.

Toolbar buttons can be removed from the toolbar by Command+dragging them off of the
toolbar.
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Using Toolbars

You can display QuicKeys toolbars by selecting them from the QuicKeys Menu or from the
QuicKeys Dock menu.

You can also assign a hot key trigger for a toolbar in the Toolbar Editor sheet and then display or
hide the toolbar by pressing the hot key:.

Use one of the following methods to hide a toolbar:
* (Click the close button on the toolbar.

* Select the toolbar from the QuicKeys Menu. Press the Hot Key assigned to the toolbar.
You can delete a toolbar from the QuicKeys Editor, or by right-clicking it and choosing Delete.

When you hover over a toolbar button, descriptive text appears helping you identify the purpose of
each button.

Toolbars can be more than just a place to trigger shortcuts from. You can use them to open files by
dragging and dropping them on Open Application shortcuts. For example, if you have two or more
text editing or word processing programs, create an Open Application shortcut for each one and
place them together on one toolbar. If you double-click a file, it will open in the default application
for that file type, but you can easily open it in the application of your choice my dragging and
dropping it on your toolbar.
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If you have been using QuicKeys for awhile or have been reading this manual, you will have noticed
that clips, scope, variables, and functions allow you to make very powerful shortcuts. This chapter
covers these four topics in more detail.

Clips

The Clips feature is a bit like the system clipboard, but with a memory. Unlike items on your
system clipboard, QuicKeys clips are saved even if you restart your computer or quit QuicKeys. It
is a permanent collection of boilerplate text (formatted or unformatted) and/or graphics that you
can retrieve at any time to paste or type into documents.

The Clips Manager

The Clips Manager is part of the QuicKeys Editor window: Select Clips from the source list to
access it.

PN

QuicKeys Editor

O (& ' [Q -
Create  Record Me | QuicKeys On Shortcut Search
LIBRARY Viewing Group: | All Groups '

& Shortcuts
W Abbreviations
[E8] Toolbars

SCOPES Example Clip  Emerson Quotes QK lcons
. All Applications
5] Adobe InDesign €54
A Unscoped Items

ONLINE
E QuickKeys Online

Name: All Groups ( f&~)

Type: Clip Group

= o+ - y

The top half of the Clips Manager allows you to browse ViewingCroupl All Groups SEmerson Quotes )
e "}

your clips. The header shows you (and allows you to
change) which group you are viewing. It also allows you to switch between icon view and list view.
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The bottom half of the Clips Manager allows you to edit your clips. It’s appearance and features
change depending on whether you select a group, a text clip, an image clip, or a universal clip.

Note: The QuicKeys Editor toolbar and footer are covered in Chapter 2.

Groups

You do not have to create clip groups, but as you accumulate more and more bits of text and
graphics in your clips collection, you will likely find them useful.

',ﬁv;

Select any group to work with it. You can edit the name in the
Delete Group "QK lcons’

Name field. Use the Action menu to delete the group and all the
clips in it, create an insert clip shortcut that allows you to choose T S OTRCLT I N R
from the clips in this group, create an abbreviation that allows you Create Abbreviation with Clip
to choose from the clips in this group, or create a new group. The Create New Group

Create New Group option is always available from this menu.

Text Clips

Select a text clip and it will appear in the lower half of the manager. You can edit the name in the
Name field.

Use the Action menu to duplicate this clip, delete this clip, create an insert clip shortcut that
inserts this specific clip, or create an abbreviation that inserts this specific clip.

Mame: |Foolish consistancy -
Type: Text Clip Duplicate Clip
Delete Clip
A foolish consistency is the hobgoblin of little minds, a »sophers and
divines. Create Shortcut with Clip

Create Abbreviation with Clip

Create Mew Group Save
T —

You can edit and format the text of the clip itself. Use these options from the Edit menu:

* Format — Allows you to format text in clips and in rich text abbreviations.
* Spelling — Opens the standard Mac OS X spelling controls.
* Special Characters — Opens the Mac OS X Special Characters palette.

Click Save to save your changes.
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Image Clips
Select an image clip and it will appear in the lower half of the manager. You can edit the clip’s name
in the Name field.

Use the Action menu to duplicate this clip, delete this clip, create an insert clip shortcut that
inserts this specific clip, or create an abbreviation that inserts this specific clip.

Mame: Trigger 5 e /
Type: Image Clip

&

@a = &) (e B (1)) Save
Zoom In ActuaISize\ Move/ Crop Image to Selection  Open Image Edit Panel

Zoom Out  Size to Fit Select

You can edit the image itself with the controls along the bottom and with the Image Edit panel.

Image Edit

Image Edit

Adjust Effects

Click Save to save your changes.
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Universal Clips

Select a universal clip and it will appear in the lower half of the manager. You can edit the clip’s
name in the Name field.

Use the Action menu to duplicate this clip, delete this clip, create an insert clip shortcut that
inserts this specific clip, create an abbreviation that inserts this specific clip, convert this clip to a
text clip, or convert this clip to an image clip.

Name: |New Clip - X

Type: Universal Clip

D m This clip contains several images embedded in the
available text. Convert the clip to choose which

image to use.

One word to type them all! i
Let's start with Abbreviations. Abbreviations let you type v

| Convert to Text Clip | (_ Convert to Image Clip |

Universal clips cannot be edited. To edit, first convert this clip to either a text clip or an image clip.

Universal clips cannot be edited, but they can be converted.

Click Convert to Text Clip to permanently change this clip to a text clip. (If you need to retain the
original universal clip, duplicate the clip first.) Formatting and images can be retained in a rich text
format text clip. However, universal clips may have extra application specific information included
with them. This information is discarded in the conversion process.

Click Convert to Image Clip to permanently change this clip to an image clip. (If you need to retain
the original universal clip, duplicate the clip first.) All data except the image will be discarded. If
the universal clip contained more than one image, you will be prompted to choose which image to
use.
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Create New Clip

Clips can be created with a Create Clip shortcut (covered later in the section) or in the Clips
Manager (covered here).

Create New

Nameu L Rlmsas i
Universal clip from clipboard contents

WV E + Text clip from clipboard contents
New empty text clipping

Image clip with file
Duplicate Clip [ Cancel :l I: Create Clip :l

Click the Add Item (+) button on the footer. Use the Name field to assign a name to your new clip.
Then use the options menu to select which type of clip to create.

*  Universal clip from clipboard contents — The current contents of the system clipboard will
be displayed for your review. You can change the contents of the clipboard and the field will
automatically update.

* Text clip from clipboard contents — This option works the same as the one above, but
creates a text clipping instead.

* New empty text clipping — Select this option to create a new empty text clipping. Then
enter and format your text.

* Image clip with file — Select this option and then drag an image file into the well or click the
Choose Target button to navigate to it.

* Duplicate Clip —This option only appears if a clip is selected in the upper half of the Clips
Manager. Selecting this will duplicate that clip.

Click Create Clip to save your new clip.
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Clips Actions and Shortcuts

There are two QuicKeys actions you can use to work with clips in your shortcuts: Create Clip and

Insert Clip. These are covered in Chapter 12.

QuicKeys 4 comes with two pre-made shortcuts which use these actions: Clips — Gather\Manage
and Clips — Insert\Type. Understanding how these two shortcuts work can help you understand

how to get the most out of your own clips shortcuts.

Clips — Gather\Manage

The Clips — Gather\Manage shortcut has just one
step: a create clip action.

Other than the action itself (create clip) and the
compatibility setting, all of the options in the step
specify the default behavior of the shortcut and can
be changed when the shortcut is played. If you have
not made a selection at the time you trigger the
shortcut, there will be a delay and then you will be
prompted to use the contents of the clipboard or
cancel.

If you have a selection in the front application when
the shortcut is triggered, the Create Clip window
will open.

Clips - Gather\Manage =

¥ HE All Applications 5

(-1+] hotkey # ~C

1 v [ MakeClip from selection ™

Clip Action: | Create Clip v

@ Use selection in front application

O use contents of clipboard

Saved Clip Type: | Universal Clipping %

Compatibility: [_] Make applications recognize clip actions

|_] Emerson Quotes

] QK Icons

Source Group:

All Groups

| ——— ¥r=
Viewing Group:

io= L

Use the Clip Name field to assign a name to this new clip. You can change the Source and Saved
Clip Type if you wish. If the group specified by the shortcut is not the want you want, select a

different group. Click Save to save your new clip.

e 0 Created® 0000000000000

Clip Name: INew Selection Clipping

Source: | Selection H

QK lcons

Saved Clip Type: [ Universal Clipping H

Emerson Quotes

Everything is online... even QuicKeys!

Then there is the new QuicKeys Online - an online resource
center available from right inside the QuicKeys Editor. Here
you can find the Shortcut Callery where you can download pre-
made Shortcuts submitted by other users {and you can share
your own, too, if you wish), view tutorials, and read regularly
updated tips and tricks of how to use QuicKeys (posted via
QuicKeys on Twitter).

Destination;

All Groups

Universal clippings may represent multiple types of data.

Viewing Group: | All Groups

e ) o)
S

A
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Clips - Insert\Type

The Clips — Insert\Type shortcut has just one step:
an insert clip action.

Other than the action itself (insert clip), all of the
options in the step specify the default behavior of
the shortcut and can be changed when the shortcut
is played. If a specific clip where selected, this
shortcut would insert that clip using the settings
from the shortcut and not prompt you.

Place your cursor where you want your clip inserted
and trigger the shortcut.

Select the clip you wish to insert. You can change the
paste/type and compatibility options if you need to.
Click Insert to insert your clip.

Clips - Insert\Typ =]

¥ E All Applications

(-1+] hotkey & ~V

Clip Action: [ Insert Clip

@ Paste clip when inserting

) Type clip when inserting =} 0.00 seC
Slow Fast

Compatibility: [] Make applications recognize clip actions

" Example Clip

[ Newciip

"4 New Selection Clipping

(7] Emerson Quotes

7] QK lcons

Source Group:

All Groups

=] BRI
Viewing Group: [ All Groups

io= lofl

 Example Clip

(0] New ciip

_;' New Selection Clipping

ﬁ Emerson Quotes
1] QK Icons

All Groups

Group Selected:

Viewing Group:

® Paste clip when inserting
(O Type clip when inserting

——0

Slow Fast

0.00 sec

" Make applications recognize clip actions

QuicKeys 4 User Guide

August 2009

87




Chapter 7 — Beyond the Basics

Scope

Scope is the realm of operation for a trigger. You can specify the scope of your triggers to limit the
applications under which that shortcut can be triggered. A shortcut can have more than one scope
if so desired. Scope comes in two major types: All Applications and Application-specific.

All Applications — When scoped to All Applications, a shortcut trigger will be active no matter
which application is in front.* For example, your F1 key might be set up to hide the front
application. If you scope it to, say, Safari, then the F1 key would only hide the front application if
it happened to be Safari. You would need to scope that hot key to All Applications for it to work as
desired for any application.

* with the exception of excluded applications

Application-specific — A trigger scoped to a specific application will only be active when that
application is in front. You can assign more than one application scope to a shortcut if needed.

Scope Interaction

Triggers scoped to a specific application always take precedence over those scoped to All
Applications. This is useful for special case situations where you may not want your F1 key
triggering the same shortcut in Safari (for example) that it does in your other applications.

Reassigning Scope

You can reassign the scope of a shortcut trigger when you have the Shortcut Editor window open.
However, if you want to reassign all shortcut triggers from one application to another, or from one
application to all applications, there is an easier way. This can be useful when you upgrade from one
version of a product to another.

In the QuicKeys Editor all of your scopes are listed in the Scopes section of the source list. Select
the scope you want to reassign and select Reassign Scope from the File menu (or right-click the
scope). This will cause the Reassign Scope sheet to appear where you should verify the Current
Scope then select the application you'd like for the New Scope.

Note: The Reassign Scope sheet also allows you to reassign subscopes. This use is covered under
“Subscope” later in this section.

Duplicating Scope
You can duplicate the scope of a shortcut trigger when you have the Shortcut Editor window open.
However, if you want to duplicate all shortcut triggers in one application to another, or from one

application to all applications, there is an easier way. This can be useful if you want all the triggers
you set up for one application to also work in another.

In the QuicKeys Editor all of your scopes are listed in the Scopes section of the source list. Select
the scope you want to duplicate and select Duplicate Scope from the File menu (or right-click the
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scope). This will cause the Duplicate Scope sheet to appear where you should verify the Current
Scope then select the application you'd like for the New Scope.

Note: The Duplicate Scope sheet also allows you to duplicate subscopes. This use is covered under
“Subscope” later in this section.

Deleting Scopes

You can delete a scope from a shortcut when you have the Shortcut Editor window open. However,
if you want to delete all shortcut triggers for a particular application, there is an easier way. This can
be useful when you no longer use an application.

In the QuicKeys Editor all of your scopes are listed in the Scopes section of the source list. Select
the scope you want to delete and select Delete Scope from the File menu (or right-click the scope.
Shortcuts that are left without any scopes assigned will be “unscoped” and can be located by
selection Unscoped Items from the source list.

Unscoped Items

Unscoped shortcuts have no functioning trigger. However, they can be used in other shortcuts with
the insert shortcut action, in abbreviations, and on toolbars.

Subscope

Creating Subscopes

Subscopes can only be created from within a Shortcut Editor window. And, advanced features must
be turned on in the QuicKeys Preferences Appearance pane (see Chapter 3). If you wanted to create
a subscope in Mail, for example, you'd need to open a shortcut scoped to the Mail application. In
the shortcut’s Scopes & Triggers area, to the right of the Mail scope is the Subscope pop-up list.

Clicking on the Subscope pop-up list will reveal all of the subscopes available in the parent scope,
Mail. You can instantly create a new subscope by selecting Other Subscope from the list and typing
in the name of the new subscope you want created.

Subscope Interaction

Subscopes obey these simple rules:
* If you subscope a shortcut trigger, it will only trigger when that subscope is active.
* The “All parts of <application>” subscope is universal when that application is front-most. In

other words, all shortcuts with a subscope set to “All parts of <application>” will be active if
that application is in the front.
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. Upen YuicKkeys caitor...
Using Subscopes
You can change the subscope that is active from Toolbars , Y Subscopes Off
the Subscopes submenu of the QuicKeys Menu or Edit Toolbars...
b . Switch Sub h Subscopes Off
y using a Switch Subscope shortcut. Play Instant Shortcut Project A
Edit Instant Shortcut... + Project B

Reassigning Subscopes

You can reassign the subscope of a shortcut trigger when you have the Shortcut Editor window
open. However, if you want to reassign all shortcut triggers there is an easier way.

In the QuicKeys Editor all of your subscopes are listed in the Scopes section of the source list.
Select the subscope you want to reassign and select Reassign Scope from the File menu (or right-
click the scope). This will cause the Reassign Scope sheet to appear where you should verify the
Current Subscope then select the application you'd like for the New Subscope.

Duplicating Subscope

You can duplicate all shortcut triggers to another subscope.

In the QuicKeys Editor all of your subscopes are listed in the Scopes section of the source list.
Select the subscope you want to duplicate and select Duplicate Scope from the File menu (or right-
click the scope). This will cause the Duplicate Scope sheet to appear where you should verify the
Current Subscope then select the application you'd like for the New Subscope.

Deleting Subscopes

You can delete a subscope from a shortcut when you have the Shortcut Editor window open.

Scope Exceptions

You may have a shortcut trigger or an abbreviation scoped to all applications, but there are
applications that you don’t want it work in.

Scopes & Triggers  whers, when, and why this shortcut runs.

[ psascpe - | - |

@ Exceptin: Adobe Acrobat Pro

For a shortcut, select the scope in the
Shortcut Editor and then select Add
Scope Exception from the Shortcut
menu.

-~ All Applications 5

hot key 5+ ~C

For an abbreviation, select the abbreviation in the Abbreviation List and then select Add Scope
Exception from the Shortcut menu.

Click the add (+) button and select an application to add it to the list. To remove an application
from the list, select it and click the remove (-) button.
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Excluded Applications Window

You may have an application that you simply don’t want any of you shortcuts to fire in. Or, if you
do want some shortcuts in that application, you plan to scope those shortcuts to that application.

The Excluded Applications window allows you to 00 Excluded Anplications
exclude applications from the all applications scope. rases i tre l Amplcatons” scape il e tsabiod
In other words, anytime you use the all applications these applications.

scope, it really means “all applications except the © iChat

applications in the excluded applications list.” You 7 Tl

can still have an application-specific scope for any of

these applications.

Access the Excluded Applications window by

selecting it from the Window menu (or by right-

clicking the All Applications scope in the QuicKeys B

Editor source list). Click the add (+) button and S

select an application to add it to the list. To remove
an application from the list, select it and click the
remove (-) button.
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Variables

QuicKeys variables can be of great assistance in multi-step shortcuts to hold, modify, and retrieve

information as the shortcut plays. They are also of use in shortcuts and abbreviations where you
want to insert information which changes over time.

The Variables and Functions Editor

The QuicKeys Variables and Functions Editor contains all of the variables you have created,

plus the built-in variables, and all of the functions you have created, plus the built-in functions.

Functions are covered in the next section of this chapter.

Note: Built-in variables cannot be edited.

™7 Clobal

> E Shertcut Local

¥ FUNCTIONS
» [ ]Equation Functions
» [ Trigger Functions

Source List

The source list has two categories: Variables and Functions. Select an item in either of these
categories or their subcategories to change the content in the content area.

g LA
¥ VARIABLES

| IDNumber |

Clipboard
Computer Name
Date and Time
Desktop Folder
Documents Folder
Downloads Folder
Home Falder

Host Name

IP Address

iTunes Current Track Na...

Login Mame {long)
Login Mame (short)
My First Name

My Last Mame

My Mame

Pictures Folder

| Value

]

Calculated value
Calculated value
Calculated value
Calculated value
Calculated value
Calculated value
Calculated value
Calculated value
Calculated value
Calculated value
Calculated value
Calculated value
Calculated value
Calculated value
Calculated value
Calculated value

| Type
Number

Dictionary

Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text

| Creator
User
Quickeys
Quickeys
Quickeys
Quickeys
Quickeys
Quickeys
Quickeys
Quickeys
Quickeys
Quickeys
Quickeys
Quickeys
Quickeys
Quickeys
Quickeys
Quickeys

Name: | IDNumber

e

Value: 0 Rewvert to Default
[] Persistent
Default Value: 0 Same as Current

XY | +7| =

Note: Functions will be covered in the next section of this chapter.
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Global - This subcategory lists all the global variables —variables available to any shortcut or
abbreviation. This includes the built-in variables and any global variables you have created.

Shortcut Local - This subcategory lists all the variables that are specific to a shortcut. Select this
item to view all local shortcuts, or click the reveal triangle and select a shortcut to see only the
variables for that shortcut.

Content Area

Select any variable to display its details in the details area.

Name - The Name column shows the names of your variables. Double-click on the variable name
to edit it.

Value column - The Value column shows the contents of each variable. You can manually change
the value of a variable by double-clicking it and editing it. “Calculated value” means that you cannot
set a value; it will be calculated. If you wish, you can force it to calculate with the equation tester
(covered below).

Type column - The Type column shows the type of data contained in a variable. Common data
types are number and text.

Variable Details Area

This area is only present when viewing variables.

Name - This field contains the name of the selected variable. You can change it here.

Value - This field shows the current value of the selected variable. You can change it here.
Revert to Default - Sets the value of a selected variable to that variable’s default value.
Persistent — Select this option to have the value stored in the variable remain even if QuicKeys
is restarted. With this option unselected, the variable will be set to its default value whenever

QuicKeys is launched.

Default Value - The default value of a variable is automatically loaded into a variable whenever
QuicKeys is launched.

Same as Current - Click this button to designate a selected variable’s current value as the new
default. The default value of a variable is automatically loaded into a variable whenever QuicKeys is
launched.
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Equation Tester

The equations tester is always available by clicking the “x = y” button on the Variables and
Functions Editor footer.

Date & Time [

Equation Tester
Egquation: IDMumber - Secondary ID | GIuEaI- >
Ll = S Shortcut Local >
Functions [
Answer:  17-35
-18 - .
& (concat)
i *
[ Add Eguation ltem v] E— + (pl.ush
g g et = (minus}
/ (divided by)

(set equal to)
. . . . *  (multiplied by)
Enter one or more equations into the Equation field and click Evaluate. negative
The results will appear in the Answer field. Use the Add Equation Item

. . Left Parenthesis
to enter variables, functions, and operators.

Right Parenthesis
Comma

Footer
< j x4+ - y

Duck - Click her to make QuicKeys Variables and Functions Editor float above all other windows
so you can watch the values of your variables change as your shortcuts play back.

Resize — Click and drag to change the size of the source list.
Equation Tester - Click the “X=Y” button to open the equation tester.

Add - Click the button with the plus sign (+) to access the new item menu. Select Create New
Variable, New Equation Function, New Trigger Function, or Install Default Functions.

Delete - Click the button with the minus sign (-) to delete the selected variable or function.

Creating and Editing Variables

New variables can be created in the Variables and Functions Editor by clicking the Add button on
the footer and choosing Create New Variable. The can also be created in the variables pane of the
Shortcut Editor by clicking the Add button in its upper right corner. Variables can be renamed in

either location, too.

The value of a user created variable can be changed by the action of a shortcut or by manually
changing it in the Variables and Functions Editor. The values of the built-in variables are calculated
and cannot be changed directly; e.g., the value of the date variable will change when the date
changes.
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Variables Actions

There are three main “variables actions” and other actions which make use of variables. When
working with variables in a shortcut, use the variables pane of the Shortcut Editor to manage the
variables referenced by the shortcut. It’s interface is covered in Chapter 4.

The Assign Variable action (Create > QuicKeys > Variables > Assign Variable) is used to move data
into your variables during playback of your shortcuts. With this action you can set the variable to
a specific value, the value of another variable, or the result of an equation, or have the shortcut
prompt the user for a value or variable/equation.

The Compare Variable action (Create > QuicKeys > Variables > Compare Variable) is the tool you
use to test the contents of a variable and translate it into step results. You can compare the variable
to a specific value, the value of another variable, or the result of an equation, or have the shortcut
prompt the user for a value or variable/equation. You can test to see if it is equal to, greater than,
contains text, is empty, or more. The result of the comparison will always be true or false, which
directly translates to step results of success or failure.

The Use Variable action (Create > QuicKeys > Variables > Use Variables) is what you use to retrieve
the contents of a variable and type or insert it into document or display it on your screen.

Repeat Loop (Create > QuicKeys> Repeat Loop) can use the value of a variable to determine how
many times the loop should repeat.

The AppleScript action (Create > Scripting > AppleScript) can assign the script result to a variable.
Combine this with a Compare Variable step in a powerful multi-step shortcut.

Web Actions (Create > Internet & Network > Web Actions) make use of variables, as well.
Elements that QuicKeys can retrieve a value from can store that value in a variable for later use.
Some elements can have their value set to the value of a variable.

Variables in Abbreviations

Abbreviations can be used to insert variables very much like the Use Variable action in a shortcut.
The completion field of a text abbreviation has an Extras menu with all the same options as found
in the Add Equation Item menu of the Equations Tester and the Assign, Compare, and Use Variable
actions.

Variables in Triggers

File system triggers let QuicKeys fire shortcuts based on changes to the contents of a folder or
other file system related reasons. QuicKeys can record the change that occurred in a variable.
When you are creating the trigger, simply select which variable should be used.

Then, in that shortcut you may include a compare variable or use variable step that includes one of
the file system trigger functions to process that data.
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Functions

Functions are scripts you can use to extend QuicKeys functionality in several places. They can be
used in variables actions, abbreviations, and function triggers. You can create and edit your own
functions in the Variables and Functions Editor.

The Variables and Functions Editor

As covered in the previous section, the QuicKeys Variables and Functions Editor contains all of
p Y
your variables and functions. Variables are covered in the previous section of this chapter.

¥ VARIABLES on function_name(} $
@ Global return "maximum”
end function_name

> E Shortcut Local

= on function_uuid(}
FLiLLil return "BDBA7CF3-74C5-4FCR-BBO6-361CBC5497ER"
v[__]Equation Functions end function_uuid

LE FileSystem Trigger Fu...
bﬁL' & G on function_paramcount(}
15 uncoicns return 2

minimum
# 4 on function_calculate(paramOne, paramTwo)
4 random if paramOne is greater than or equal to paramTwo then d-
ﬂ square root return paramOne as string
# Untitled Equation Func... else

. . return paramTwo as string

?ﬁTngger Functions end if
Ep Check Drive Space end function_calculate
Ep Simple AM-PM Trigger
Ep Untitled Trigger Funeti... | .. Copyright ©2005 Startly Technologies, LLC. All rights reserved.
== This Startly Software is provided by Startly on an "AS IS" basis. STARTLY MAKES NO [

-- WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED
== WARRANTIES NF MNOM-TMERTNGEMENT MERCHANTARTI TTY AND FITMESS FNR A PARTIC -

( Compile :l I: Save J

< I xv ++ - 7

Source List

The source list has two categories: Variables and Functions. Select an item in either of these
categories or their subcategories to change the content in the content area.

Note: Variables were covered in the previous section of this chapter.

Equation Functions — QuicKeys includes many pre-built functions for manipulating data. For more
information on individual functions, select each function and refer to the notes. FileSystem Trigger
Functions allow you to work with data stored in a variable by a file system trigger. List Functions
apply specifically to lists.
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Trigger Functions — These are functions that can be used to trigger your shortcuts. For information
on using them, refer to the Triggers section in Chapter 4.

Content Area

Select any function to display the script in the editor area. You can edit function here using the
AppleScript language.

Compile - Click compile to check your function script to make sure it contains valid syntax.

Save - Click Save to check your function script and save your changes.

Creating and Editing Functions

New functions can be created in the Variables and Functions Editor by clicking the Add button on
the footer and choosing New Equation Function or New Trigger Function. Functions are renamed
in the script itself.

The Add button also allows you to choose Install Default Functions. This option allows you to
install any Startly provided functions that were made available after you installed QuicKeys.

Functions in Variables Actions

You can use equation functions in the variables actions — Assign Variable, Compare Variable, and
Use Variable — to extend the abilities of these actions.

Functions in Abbreviations

You can use equation functions in text type abbreviations to make sophisticated completions that
are dynamic each time they are used.

Function Triggers

Function triggers allow you to use your own custom AppleScripts as triggers so that almost
anything can become and QuicKeys trigger.

Only trigger functions, not equation functions, can be used as triggers.

Refer to the Triggers section in Chapter 4 for information on using them.
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With nearly every task we perform on our computers, we face the ;ha"ge ';f}llder )
. . . . . = Manage Files

necessity of navigating to multiple folders numerous times. If you " Opengltems

keep a tally of the number of times you have to navigate to a different .

] ; . R f7| Rename Files
tolder when opening or saving documents, launching applications,
and copying or moving files, you would be surprised by just how much
time you spend doing this time-consuming but unavoidable activity.
QuicKeys can significantly increase your efficiency in this area with the Batch Processor, Change

Folder, Manage Files, Open Items, Rename Files actions.

Batch Processor

Create > Files > Batch Processor

Batch Processor actions let you repeatedly run a shortcut that performs actions for all the files in a
particular folder.

1 v [i] Batch Processor H

Source Folder: D Finder Selection
8 Specified Folder ( Choose Folder... ]

Choose a folder to batch process

E Backup source folder

Open Files in: [ Mo Application Specified FG-]

Choose an application to open the files

—J

Play Shortcut: [ Drag shortcut to play here. k&

Source Folder - Specify whether the source folder for this action should be the one selected in the
Finder (at the time the shortcut runs) or a specific folder. Click Choose Folder and navigate to it, or
drag it into the well. The path will then display there.

Backup source folder - Select this option to have QuicKeys create a backup of your source folder
before it begins processing. The back up will be named “<sourcefoldername> backup” and be found
in its parent folder.

Open Files in - Select an application to open the files. Select it from the menu or drag it into the
well. The path will then display there.

Play Shortcut - Drag the shortcut to be played into the Play Shortcut well. Click the Shortcut
Actions Palette button "= to open the palette. This gives you a list to drag the shortcut from.
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Change Folder

Create > Files > Change Folder

The Change Folder action enables you to switch to a previously specified folder in any standard
Open or Save dialog, or in the Finder. This lets you jump to frequently used folders with the touch
of a key rather than clicking around. This shortcut behaves differently depending on the context
under which it is triggered:

* Open/Save Dialog: Changes the open/save location to the specified folder.

* Finder Window: Changes the front-most Finder window to the specified folder, or may open
the designated folder in a new window depending on Finder Preferences settings.

* In the Finder: If no windows are open, creates a new window opened to the specified folder.

1 v [ Change Folder - (Undefined) i

Choose folder to switch to in Open, Save, and Finder windows.

Choose Folder...

Click Choose Folder and navigate to the folder you wish to specify, or drag it into the well. The
path will then display there.
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Manage Files

Create > Files > Manage Files

The Manage Files action will copy or move files from one location to another for you. For example,
you can use this shortcut to move files from one folder to another on your hard drive, to a USB

or Firewire drive, or to a network drive. Triggered by a hot key when desired, or by a timer on a
schedule, it can act as a quick and dirty file backup system.

Copy Files

Create > Files > Manage Files > Copy Files

1w & Copy Finder selection to folder E

File Action: | Copy w‘-i

E Wait for action to finish

[ Replace existing items in destination

Source: ®) Finder Selection

D Specific Item Choose Source...

Destination: O Trash
{® Specific Folder [ Choose Destination... j

Choose a destination folder.

File Action — Choose copy to copy the source to the destination.

Wait for action to finish — Select this option to force QuicKeys to wait for this action to finish
before proceeding to the next step of your shortcut.

Replace existing files - If you check this box, files that you copy will overwrite any files of the same
name in the destination folder. Use with care!

Source - Specify whether the source for this action (the item to be copied) should be the one
selected in the Finder (at the time the shortcut runs) or a specific item. Click Choose Source and
navigate to it, or drag it into the well. The path will then display there.

Destination - Specify whether the destination for this action (the place to which the item is
copied) should be the Trash or a specific folder. Click Choose Destination and navigate to it, or
drag it into the well. The path will then display there.
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Move Files

Create > Files > Manage Files > Move Files

1 a Move Finder selection to folder E

File Action: | Move l-H

E Wait for action to finish

[Tl Replace existing items in destination

Source! (®) Finder Selection

O Specific Iltem Choose Source...

Destination: O Trash
BSpeciﬁc Folder I: Choose Destination... :]

Choose a destination folder.

File Action — Choose Move to move the source to the destination.

Wait for action to finish — Select this option to force QuicKeys to wait for this action to finish
before proceeding to the next step of your shortcut.

Replace existing files - If you check this box, files that you move will overwrite any files of the
same name in the destination folder. Use with care!

Source - Specify whether the source for this action (the item to be moved) should be the one
selected in the Finder (at the time the shortcut runs) or a specific item. Click Choose Source and
navigate to it, or drag it into the well. The path will then display there.

Destination - Specify whether the destination for this action (the place to which the item is
moved) should be the Trash or a specific folder. Click Choose Destination and navigate to it, or
drag it into the well. The path will then display there.
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Open ltems

Create > Files > Open Items

The Open Items action will open any file, folder, or application you specify. For example, you can
create an Open Items shortcut for each of your most frequently used applications, putting them at
your fingertips in a flash.

1 r .4 Openitem M

Open: O Finder Selection

@ specified fem

Choose an application, file, or folder to open.

["] If item is a folder open its contents instead

Open With: | Default Application F'G-]

Open with default application

Open - Specify whether the item to be opened should be the one selected in the Finder (at the
time the shortcut runs) or a specific item. Click Choose Item and navigate to it, or drag it into the
well. The path will then display there.

If item is a folder open its contents instead — Select this option to open all the items within the
folder rather than the folder itself.

Open With - Select an application to open the files. Select it from the menu or drag it into the well.
The path will then display there.

There are other ways to create open items shortcuts:

* Drag and drop a file, folder, or application onto the shortcut list in the main QuicKeys
Editor window.

* Dragand drop a file, folder, or application onto a QuicKeys toolbar.
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Rename Files

Create > Files > Rename Files
The Rename Files actions provide sophisticated batch renaming of files.

All Rename Files actions begin with the same options for the target file(s). And all have the same
example section.

Target - Specify whether the item to be renamed should be the one selected in the Finder (at the
time the shortcut runs) or a specific item. Click Choose Target and navigate to it, or drag it into the
target file or folder well. The path will then display there.

If item is a folder rename its contents instead - Select this option to rename all the items within
the folder rather than the folder itself.

Example - The before column contains some made of filenames. The after column changes
dynamically based on your selections to show you the effects of those settings.

Add Prefix

Action - Choose Add Prefix to append text to the beginning of the filename(s).

1 EE('_I Insert prefix before filenames E

Target: {®) Finder Selection
() Specific Item Choose Target...

Choose a target file or folder.

E If item is a folder rename its contents instead

Action: | Add Prefix l-%-‘
Example: | Before | After
Florida Vacation.jpg AFlorida Vacation.jpg
3rd Quarter earnings report.DOC B3rd Quarter earnings report.DOC
Excessive spaces file .txt C Excessive spaces file .txt
bea_arthur_as_femputer.aif Dhea_arthur_as_femputer.aif
Text: I| I
Sequence: [ Alphabetical l—H

Starting value: A @ Ordering: [ Text First l-%-]
Step by: | 1 D Presort: [ Filename Ascending '-H

Pad to length: |1 @ [] Add space after sequence

Text - Enter the text you would like added to the filename(s).
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Sequence - To number (or letter) your files in order, select Alphabetical, Numerical, or None. The
options for alphabetical and numerical are the same.

Starting value - This is the value the will be added to the first file, typically 1 or A.
Step by - This is how much greater the next value will be. For example, 6 step by 1 becomes 7.
Pad to length - This is the minimum length of the sequence. For example, 7 padded to 3 is 0o7.

Ordering - Chose Text First or Sequence First to control how the text you may have entered
and the sequence will be added to the filename.

Presort - To control which files receive which sequence values, you can direct QuicKeys to
sort the files by filename, creation date, modification date, or file size before appending the

sequence.

Add space after sequence - Select this option to add a space after the sequence character(s).

Add Suffix

Action - Choose Add Suffix to append text to the end of the filename(s).

All of the options for Add Suffix are the same as for Add Prefix, with one exception. If you are using
a sequence, the “Add space after sequence” option becomes “Add space before sequence

Find and Replace

Action - Choose Find and Replace to find certain text the filename(s) and replace or delete it.

Action: [ Find and Replace '%‘

Example: [ Before After
Florida Vacation.jpg Florida Vacation.jpg
3rd Quarter earnings report.DOC 3rd Quarter earnings report.DOC

Excessive spaces file .txt Excessive spaces file .txt
bea_arthur_as_femputer.aif bea-arthur-as-femputer.aif
Find: | _ E lgnore case
Replace: -

[C] Treat as Regular Expression | Validate Expression

Find — Enter the text you wish to find. Select “Ignore case” to ignore the case of the text you enter.
Clear this option to have QuicKeys only consider it a match if the case also matches.

Replace - Enter the text you want to replace the found text. Leave blank to delete the found text.
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Treat as Regular Expression - Select this option to process the find field as a regular expression
(regex). (Regular Expressions are beyond the scope of this manual.) With this option selected, the
Validate Expression button will be enabled. Click it to verify you have entered a valid expression.

Convert Case

Action - Choose Convert Case to change the capitalization of the filename(s).

Action: [ Convert Case ]

Example: [ Before
Florida Vacation.jpg
3rd Quarter earnings report.DOC
Excessive spaces file .txt
bea_arthur_as_femputer.aif

Options: | lower case 3

[ Include file extension

After

florida vacation.jpg

3rd quarter earnings report.DOC
excessive spaces file .t

bea_arthur_as_femputer.aif

Options - Select “UPPER CASE” to convert the filename(s) to all capital letters. Select “lower case”
to convert the filename(s) to all lower case letters. Select “Title Case” to capitalize the first letter of

each word.

Include file extension - Select this option to include the file extension in the conversion.

Fixed Name

Action - Choose Fixed Name to change the filename(s) to a specific name.

Action: | Fixed Name 'ﬂ

Example: [ Before
Florida Wacation.jpg
3rd Quarter earnings report.DOC
Excessive spaces file .t
bea_arthur_as_femputer.aif

After
project.jpg
project.DOC
project.txt
project.aif

Mew name: | project

E Preserve file extension

New name - Enter the name you would like the select file’s name changed to.

Preserve file extension - Select this option to leave the original file extension unchanged.

Trim Whitespace

Action — Choose Trim Whitespace to remove spaces from the filename(s).
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Action: | Trim Whitespace I-H

Example: [ Before
Florida Wacation.jpg
3rd Quarter earnings report.DOC
Excessive spaces file .t
bea_arthur_as_femputer.aif

Options: | From both ends I-H

[ Include file extension

| After

Florida Wacation.jpg

3rd Quarter earnings report.DOC
Excessive spaces file.txt
bea_arthur_as_femputer.aif

Options - Select From start of filename, From end of filename, From both ends, or All whitespace.

Include file extension - Select this option to include the file extension in the conversion.
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@ Internet & Network [ 2 =% E-mail

FIl Servers
The actions discussed in this chapter require an internet connection or kX Web Actions
access to another networked computer to be of use. For those with such ¥ Web Launcher

connections, there are several tasks QuicKeys can help you with. These
tasks include preparing e-mail messages, opening or automating web
pages, and mounting server volumes or shared hard drives.

E-mail
Create > Internet & Network > E-mail

The E-mail action lets you predefine the address, subject, and body of an e-mail message for
creation in your default e-mail application. Use it to create templates for frequent messages you
write. Use it as a fast way to start a new message addressed to your most common recipients. It will
even launch your e-mail application if it isn’t running.

1 v =9 Sende-mail - (Undefined) )

Ta:

Subject:

Body:

To create an E-mail shortcut, just fill in the To, Subject, and Body fields as you would when creating
a message in your e-mail application.

Note: You can put multiple addresses separated by commas in the To field.
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Servers

Create > Internet & Network > Servers

The Servers action is a major time saver for anyone needing to frequently mount network volumes.
QuicKeys stores the particulars of the desired server volume and your login information, allowing
you to connect and gain access to your data almost instantly. As part of a morning startup routine,
or the first step in a build-your-own backup routine, the Servers shortcut is indispensable.

1 v I Servers - (Undefined) M
Server Type: ! AppleShare using IP l-%-i
Address:
Wolume:
User Name:

Password:

Leave name and password blank to login as guest.

Server Type - Choose whether the server uses the “AppleShare using IP” or the “AppleShare using
AppleTalk” file sharing method.

Address - (Only present with AppleShare using IP) Enter the IP address (e.g., 192.168.1.100) or
DNS entry (e.g.,server.company.com) of the server you want to access.

Zone - (Only present with AppleShare using AppleTalk) Enter the AppleTalk zone of the server
you want to access.

Server - (Only present with AppleShare using AppleTalk) Enter the name of the AppleTalk server
you want to access

Volume - Enter the volume (hard drive or partition) name you want to access on the server.
User Name - Enter a user name which has access to the server. Leave blank to log in as guest.

Password - Enter the password that goes with your user name on the server. Leave blank to log in
as guest.
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Web Actions

Create > Internet & Network > Web Actions

Web Actions work in Safari to give you amazing control of most web sites and the ever growing
number of web applications.

Web Actions require that an add-on be installed. This add-on allows communication to occur
between QuicKeys and Safari’s implementation of WebKit. If you add a step with a web action
but have not yet installed this add-on, a message with a Manage Web Action Add-On button will
appear. Click this button to open QuicKeys Preferences to the Add-Ons pane.

For information on the Add-Ons pane, see page 46. Click the Add-Ons button ( @) to go directly to
that pane at any time.

1 iﬁ. Automate web page interaction ﬁ_ﬂ

Configuration

["ETT]

{0
. Text Field
USEr name or em...

M3y

vzt Comment: Remember me

Retrieve Value

password: [ Stare value in: a New new :
- Checkbox Set Checked
Remember me <
E Set checkbox to: [ checked = ]
Sign In E_ut'!.an . Accessor
signin_submit
[ document.getElernentByld('signin').elements.namedltem{'remember’) ]
( Choose Element... | (  AddElement~ | ()
Target
Perform in: [ Safari e

Configuration

One web actions step can have many elements within it (similar to the way one shortcut can have
many steps). All the elements of your web action are listed in the left side of the Configuration field
and will be played in the order they are listed. Click an element and drag it up or down to change
the order. Select an element to see its details on the right.

Web actions work best by showing QuicKeys what elements to interact with. Click the Choose
Element button to open the QuicKeys Web Element Locator. This also brings Safari to the front.
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. QuicKeys Web Element Locator
Place your mouse over an 1tem on a

web page. Then press the Caps Lock or e |
tn key to select it. If this is an element Tvoe seiih -
QuicKeys is able to interact with, the

QuicKeys Web Elements Locator will
display details of the element, and you
can click Add to add it to your web
action.

Current Value:

Press caps lock or fn key to lock on a different element. | Add %A |

(__Done )

Alternately, but rarely used except for the wait element, you can manually add elements with the
Add Element menu. In fact, this is the only way to add a wait element.

* Button — Any type of clickable button, including images that act like buttons.

* Text Field - Single-row input fields, like those most commonly found in web forms.

* Password Field — Like text fields, only these obscure their input.

* Radio Button — A specific type of button used when a single selection is possible in a group.

* Checkbox — A specific type of button used to allow multiple selections in a group, or used to
toggle state.

* Select (single value) — Pop-ups that allow a single selection of its items.
* Select (multiple values — Pop-ups that allow selection of multiple of its items

* Textarea — Larger than text fields, these allow for more lines of input and usually are free-
formed.

*  Anchor — A clickable link.

* Wait — Not part of any website. The wait element in a web action corresponds to a pause
step in a shortcut.

Each element can have three possible events: Retrieve Value, Set Value, and Action. Not all
elements support all events. Elements can also have comments and an accessor.

Comments - This is not used in playback. You can change it to whatever you would like. The
comments appear with the element type in the list of elements so that you can distinguish one
button from another, or one text field from the next, etc. Every element type has a comment field.

Retrieve Value - If the element is something that QuicKeys can retrieve a value from, you can store
that value in a variable for later use. QuicKeys will not retrieve values from password elements.
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SetValue - If the element can have it’s value changed, you can have the web action “fill out” that
element. For example, text elements can have text filled in, and radio buttons can have their
selection set. Some elements allow one or more of the following options: custom value (typed into
the web action itself), prompt for value (prompt appears at playback), and use variable (select which
variable to use). Buttons and links do not support setting of values.

Action - If the element can accept a click or a return, you can have the web action perform that
action. Links and buttons support click actions. Text fields have an action as well: simulating
pressing “return” to submit a form. A wait element’s action is to wait.

Accessor - Each element (except for wait) has an accessor. The accessor will likely never need to
be changed. The following information is provided for users who are expert in Document Object
Model hierarchy.

The accessor is the Document Object Model (DOM) key path that allows QuicKeys to access
the element. When QuicKeys is shown the element through the Choose Element button, it
builds a list of all available DOM accessor key paths and automatically selects the one most
likely to work reliably. This is almost always correct, but in some situations may not work. You
can choose other accessors (f there are any) or enter your own.

Target

Performin -

* Safari — Choose Safari to have this web action play back in the browser window: This is the
typical method.

*  QuicKeys Internal WebView — Some web interaction doesn’t need to pull up Safari to do its
playback (e.g., getting the value of a link, changing your clock in/out status in a web based
time clock). Using the internal target, you can possibly automate web sites without ever
having to see them. When you select this option, you will need to enter the URL.

Note: Not all playback will work with the internal target, and it’s best to test/construct the step
with Safari first. Then simply try to see if it works internally. Also, any steps that need user
interaction will need to target Safari.
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Web Launcher

Create > Internet & Network > Web Launcher

While all web browsers store bookmarks for you, you still have to launch your browser, open the
bookmarks, find what you want, and click on it to get where you want to go. QuicKeys cuts to the
chase, launching your browser if it isn’t running, and sending it straight to the web address you
specified in your shortcut.

Note: The web address does not necessarily have to be an HT'TP address. FTP and SSH are
examples of other types of URLs that will work with these actions. In the cases of FTP and SSH,
your default FTP application and the Terminal, respectively, would be launched/targeted rather
than your web browser.

Open URLs
Action - Select “Open URLSs” to open a specific URL (or URLs).

1 v &% Open web address ... i
Action: | Open URLs l-H
[ Open | URL Wait
[ o &
Open in: | New Windew ;]‘ =

Timeout: | Step Succeeds | 4] after [ 30 seconds 2 ()

URL - Click the plus (+) button to create a new line. Enter the URL you wish to open. Use plus to
continue to add URLs. Click the minus (-) to delete URLs.

Open - Only selected URLs will be opened.

Wait - Select this option to force QuicKeys to wait for this action to finish before proceeding to
the next step of your shortcut.

Open in - Select whether the URLSs should each open in a new window or new tab.

Timeout - Select Step Success or Step Failure to control the playback of this shortcut if the actions
does not succeed within a the period of time you specify. This option is only available if the proper
add-on is installed. For information in the Add-Ons pane, see page 46. Click the Add-Ons button
(@ to go directly to that pane.
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Open Selected Text as URL

Action - Select “Open selected text as URL to assume the text selected at the time the shortcut is
played is a URL and attempt to open it.

1 ﬂ Open selected text as URL E

Action: [ Open selected text as URL l-H

[T] Make applications share selection

Make applications share selection — Some applications do not normally share their selections to
the system clipboard, which can cause problems when QuicKeys tries to copy the selected text.
Selecting this option will force all applications to make their selections available. It is not always
necessary to select this option,

QuicKeys 4 User Guide August 2009 113




Chapter 10 — Actions: QuicKeys

=Y QuicKeys «» Decision >

& Insert Shortcut

Most of QuicKeys’ functionality revolves around controlling other B Message

applications, but the actions discussed in this chapter allow you to @® Pause

control QuicKeys itself and to give you more options in complex & QuicKeys Actions >

multi-step shortcuts. Repeat Loop >
& Shortcut Status >
=8 Softkeys
& Variables (2
& Wait >

Decision

Create > QuicKeys > Decision

The decision action lets you incorporate logical tests into your multi-step shortcuts; this can be
very powerful. Decision can test for a wide variety of conditions and determine if that test has
passed or failed. Once the results of the test are known, step results are then used to control what
action occurs next, allowing QuicKeys to react to the current state of your computer.

This illustration diagrams the flow of a simple multi-step shortcut

containing a decision action. This example assumes there are QE ; ]
. . . . —®|  Switch Windows

several windows open in an application, and looks for a specific

window before typing the date and time:

Y

1. Cycle the next window to the front. No mhlmmn?ow Yes
2. Check the name of the window. If the window name is 3 E
“Report,” proceed to the next step, otherwise go back to Cf Type Date & Time |«
step I.
Y
3. Type the date and time in the window named “Report.” @f Type Keystroke: Tab )

4. Enter the keystroke “Tab” and the shortcut ends, ready for
user input.

This simple branching ability can turn a useful multi-step shortcut into a much more powerful
automation action. The need to baby sit your computer while QuicKeys works is drastically
reduced by this sort of decision making capability.

Step Results

Step results allow you to control the flow of a multi-step shortcut depending on whether or not
a step succeeds or fails. QuicKeys’ response to a step’s failure or success is user-defined. You can
specify different behavior for the success and failure of each step.
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On either success or failure, the shortcut can jump to a step or can stop. If you choose jump to a
step, you can specify any step in the shortcut. If you choose stop, you can specify a notification
method: none, dialog, e-mail, Growl, or run script.

Controls for step results are found on the Step Results tab of the Information pane in the Shortcut
Editor. If you do a lot of work with step results, you can add convenient control buttons to every
step by selecting “Show advanced features” on the QuicKeys Preferences Appearance pane.

Types of Decision Actions

There are five types of decisions: Check for Application, Button, Date & Time, Menu, and
Window.

When you look at the contents of the Create > Decision submenu you’ll note that five types

of decision actions are listed. But when you look at the “Check for” pop-up list while editing a
decision step, you'll see only four. The missing item is Check for Menu. Check for Menu is very
closely tied to the Menu Selection action, and as such there are engineering reasons why it will not
work well to make it an option in the “Check for” pop-up.

Check for Application
Create > QuicKeys > Decision > Check for Application

Check For - Select Application to test whether a specific application is running, not running, front
most, not front most, hidden, or not hidden.

1 » <% Check for Application E

Check For: [ Application

Application: | i8] Adobe InDesign €54

2 & @

State: [ Is Running

Application - Choose from the list of running applications, or choose “Select Application...” and
navigate to the desired application.

State -

* Is Running — QuicKeys looks for the specified application. If that application is running, the
step result is “success.” If it is not running, the step result is “failure.”

* Is Not Running — QuicKeys looks for the specified application. If that application is not
running, the step result is “success.” If it is running, the step result is “failure.”

* Is Front Most — If the specified application is in front, the step result is “success.” Otherwise
the step result is “failure.”
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* Is Not Front Most — If the specified application is not in front, the step result is “success.”
Otherwise the step result is “failure.”

* Is Hidden — If the specified Application is hidden, the step result is “success.” If it is not
hidden, the step result is “failure.”

* Is Not Hidden — If the specified Application is not hidden, the step result is “success.” If it
is hidden, the step result is “failure.”

Check for Button
Create > QuicKeys > Decision > Check for Button

Check For - Select Button to test to see if a specific button exists or does not exist, is enabled or is
not enabled, is selected or is not selected, and what type of window it is in.

1 v < Check for Button £
Check For: | Button HH
Button Name: [ Is =

# Ignore case

D]

Button Mumber: 1 i if multiple matches
Exists: | Yes
Enabled: [ Yes

Selected: [ Do not care

EORECRECREE

Button Window: | Main Window

Button Name - QuicKeys looks for a button whose name is, contains, starts with, or ends with the
text you enter.

Ignore Case - If you check this box, QuicKeys will ignore upper/lower case differences when
trying to locate your button.

Button Number - If more than one button that matches your naming criteria exists, QuicKeys
needs to be told which of those buttons it should be looking at.

Exists - QuicKeys needs to be told what attribute of that button should be tested. Primarily you
will want QuicKeys to test whether or not the specified button Exists.

Enabled - QuicKeys can test to see if a button is enabled or disabled (grayed out), or you may not
care which state it is in.
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Selected - Check boxes and radio buttons are testable too! This pop-up list lets QuicKeys check to
see whether or not a particular radio button or check box is checked.

Button Window — When looking for the desired button, QuicKeys can be instructed to find it in a

particular type of window such as, palette, document, sheet, or drawer. Only the front window can
be tested.

Check for Date & Time
Create > QuicKeys > Decision > Check for Date & Time

Check For - Select Date & Time to check the current date and time to see if it is before or after the
date and time you specify:

1 » «» Check for Date & Time 6/24/09 6:00 AM E

Check For; [ Date & Time h‘-l

Date & Time: 6/24/2009 &:00 AM
[ Only check time

Earlier or Later: D Before date & time
{®) after date & time

Date & Time - Enter the Date and Time you would like QuicKeys to compare the current date.

Only check time - Enable this option if you are not concerned with the date and want
QuicKeys to only check the current time.

Earlier or Later — Before date & time / After date & time —These radio buttons tell QuicKeys to
test to see if the current date & time is before or after the date & time you entered.

Example: If you want a multi-step shortcut to react differently before 5:00 PM than after 5:00 PM
every day, you can set the Time field to 5:00 PM and select the “After date & time” radio button.
When the shortcut runs, if it is after 5:00 PM the decision step will report back “Success” as its
step result. If it is before 5:00 PM, the step result will be “failure.”

Check for Menu
Create > QuicKeys > Decision > Check for Menu

The check for menu action tests to see if a specific menu or menu item exists or does not exist, is
enabled or is not enabled, is checked or is not checked.
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The options for this action are more similar to Wait for Menu (covered in the “Wait” section of
this chapter) and Select Menu (covered in the “Menus” section of Chapter 14) than it is to the other
decision actions.

1 v &= Check for in menu T
Menu for Action: Menu: | Details... )
Menu ltem: | Details... )
Ir_ Set Menu for Action... W + | -

[] Is system menu cn right side of menu bar

In Application: ' Front Application ":‘i
Options

Item is Checked: | Don't Care H&]

ltem Exists: ': Yes HH

ltem is Enabled: [ Yes 2]

Show Menu: E Show menus while performing menu action
Alternate: [_| Perform as alternate menu action using modifier keys
3 Command X Option

4+ Shift * Control

Menu for Action - You can click the Set

Menu for Action button, and QuicKeys

will prompt you to select the menu and Choose a menu from the menu bar to set it as the menu for this QuicKeys

. : . action. Click Cancel to leave this QuicKeys action unchanged.

menu item (including any submenus) and

automatically fill in the fields. or vou can To display the menu bar for a different application, select the application
) Y > Y in the pop-up menu below.

fill in the fields manually. Click plus (+) to

add additional lines as necessary. Details

buttons allow you to further refine the

target menu details.

Showing Menu Bar of: | ™ Finder ] I Cancel |

Note: Some applications may provide QuicKeys one set of menus when a shortcut is created, but
display another set upon playback. If the menu item you need is not presented by QuicKeys, you
will need to type the menu item’s name manually.

Is system menu on right side of menu bar - select this options to enable QuicKeys to access these
menus.

In Application - Select the application QuicKeys should look in for the menu.

Item is Checked — A menu item will sometimes have a check mark beside it indicating that
whatever part of the application it controls is turned on. QuicKeys can test a menu item for the
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presence of a check mark. If you set this pop-up to “Yes” QuicKeys will return “success” as the step
result if the target menu item is indeed checked.

Item Exists — Have QuicKeys check to see if the specified menu item exists or does not exist. If you
select “Yes” then the step result for this shortcut step will be “success” if that menu item is found.

Item is Enabled - Menu items that are enabled or active show up in black text, those that are
Disabled or inactive use gray text. QuicKeys can test for this and the shortcut step result will
return as “success” if you set Enabled to “Yes” and that menu item is found to be active.

Show menus while performing menu action - Some applications do not build their menus until
you click on them with your mouse, and they cease to exist once they close. This means QuicKeys
will have to actually open the desired menu to get it to draw its contents and make them accessible.
Also, it is often impossible to test a menu item to see if it exists, is checked, or is enabled unless

its menu is opened. For this reason, this option will have to be checked for almost every Wait for
Menu and Check for Menu shortcut you build.

Perform as alternate menu action using modifier keys - The names of some menu items change

if you open the menu and hold down a modifier key. (Open Safari’s File menu and press the option
key, you should see Close Window change to Close all Windows.) With this option checked,
QuicKeys simulates pressing the modifier key while checking for the desired menu item’s presence.

Check for Window

Create > QuicKeys > Decision > Check for Window

Check For - Select Window to test to see if a specific window of a specific type exists or does not
exist, is front-most, or is not front-most.

Use this test to examine the state of a window and make a decision based on the step results.
Typically you'll want QuicKeys to be checking for the existence of a specific window name, but
specifying the window type (such as document window or a palette) may be desired or necessary at
times.
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1 » «» Check that Window Exists E

Check For: [ Window '-H

Window Name: | Is

M Ignore case

Window Type: [ Any Type of Window P—:-i
o . [ - " Y

Window Is: | Main Window "v'i

Window State: [ Exists F%-i

Window Name - Choose from Is, Contains, Starts with, and Ends with, and enter the name of the
Window for which you are testing.

Ignore Case - If you check this box, QuicKeys will ignore upper/lower case differences.

Window Type - In cases where you may have more than one window with the same name (a
document named Font and a palette with the same name for example), QuicKeys can differentiate
by window type. Choose the type if you need to be specific, or leave it set to Any Type of Window
if the type does not matter.

* AnyType of Window *  Document Window * Palette Window

* Sheet on Any Type of * Sheet on Document * Sheet on Palette Window
Window Window * Drawer on Palette

* Drawer on Any Type of * Drawer on Document Window
Window Window

A drawer requires you to also specify a drawer number and which side (left, right, top, or
bottom) which side of the window it is one.

Window Is -

* Main Window — The main window is essentially the most important window on your screen
at any given time. This is often a document or list window. By testing for the Main window
you can often avoid needing to specify the window name.

* Focused Window — The focused window is the often where your text insertion point is,
or possibly where you have selected a control or object. This is often but not necessarily a
document window; it could also be a palette or toolbar for example.

* Frontmost/Any Level — The level at which the desired window currently resides can also be
specified for testing by QuicKeys. Your choices are Front-most and Any Level. If you simply
want to know if the window is open, use Any Level. But if, for example, you need QuicKeys
to perform operations inside the front window, you'd want to specify Frontmost. In this case
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if the window is open and in front, the step result is “success.” However if the window is
open and not in the front, the step result is “failure.”

Window State -

* Exists — QuicKeys tries to find the window you specified with the first three pop-ups. If
that window exists, the step result is “success.” However, if that window does not exist, it is
“failure.”

* Does Not Exist or Closes — If the specified window does not exist, the shortcut step result is
“success.” However, if that window does exist, it is “failure.”
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Insert Shortcut

Create > QuicKeys > Insert Shortcut

Insert shortcut allows you to insert existing shortcuts inside your multi-step shortcuts. This is
useful for recycling shortcuts you've made, saving you the time of having to recreate them when
you need them again as part of a larger multi-step shortcut.

Imagine you have three shortcuts (A, B, and C) that you run every night, each consisting of 3-5
steps. At some point you decide to put them all into one big multi-step shortcut. Rather than
copying and pasting all of the steps from each shortcut into the larger shortcut of twelve steps,
You can create a new shortcut which consists of three Insert shortcut steps, each triggering your
original shortcuts A, B, and C.

Insert Shortcut imparts new power to step results, allowing you to build a very simple framework
inside a multi-step shortcut that calls out to other shortcuts as determined by the Decision’s step

results.

1 v & InsertShortcut - {Undefined) E

—J

Shortcut: [ Drag shortcut to play here. &

1|2 times

L

Repeat:

Shortcut — Drag a shortcut from the list in the QuicKeys Editor or the Shortcut Actions Palette
onto the drop-well in the Insert Shortcut step. Click the Shortcut Actions Palette button "= to
open the Shortcut Actions Palette.

Repeat - Specify how many times you want the shortcut repeated.
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Message

Create > QuicKeys > Message
Use the Message shortcut to create a custom text dialog, play a sound, speak text, or do a
combination of all three. It is useful as a stand-alone reminder, or can be set up to activate at a

designated point in a multi-step shortcut.

1= ! Display Message E

Title:

Message:

Options: H Display message [ in window B‘

[] Display Cancel button
[} Step automatically | continues + after 60 ', seconds
[T Speak message

[7] play sound: | Default Sound

Title — Enter a title for your message.
Message - Enter the text of your message.
Display message -

* Inwindow — Select this when you want the provided message text to appear in the
QuicKeys Message window

Display cancel button - Click this check box when you want a Cancel button to appear
in the QuicKeys Message dialog. Clicking on the cancel button during playback of a
multi-step shortcut will cause that shortcut to fail.

Step automatically continues/cancels - Specify if the shortcut should continue or cancel
after displaying the QuicKeys Message window and how long you want QuicKeys to wait
before closing the window.

*  With Growl — Select this to use Growl to display the message.

Growl Priority — Set the priority of the Growl message: very low, moderate, normal, high,
emergency.

Stay On Screen - Select this option to have the message stay on screen until you click,
rather than fading off.

QuicKeys 4 User Guide August 2009 123




Chapter 10 — Actions: QuicKeys

Speak message - Click this check box to direct your computer to speak the text or your message.

Play sound - Check the play sound and pick a sound from the list box if you want a system sound
instead of, or to accompany the message when it is triggered.
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Pause

Create > QuicKeys > Pause

Use the Pause shortcut to pause a multi-step shortcut for a specified amount of time. Pauses are
especially helpful when multi-step shortcut playback needs to be slowed down so the operating

system can make necessary items available.

™

1 @ Pause shortcut for 0.5 second

Pause: 0.5 @ seconds

Pause - You must specify how many seconds you want QuicKeys to pause.
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QuicKeys Actions

Create > QuicKeys > QuicKeys Actions

You can use the QuicKeys Actions shortcut to control parts of QuicKeys itself. These shortcuts
perform a variety of tasks such as opening the QuicKeys Editor; pausing or continuing the playback
of a shortcut; and showing/hiding QuicKeys toolbars.

The only shortcuts that can be played while another shortcut is running are single-step shortcuts
that control shortcut playback.

1~ E Open QuicKeys Editor H

o[Tla S0 F-NG] + Open QuicKeys Editor :

S5top Playback

Pause Playback
Continue Playback
Single Step Playback

Show All Toolbars
— Hide All Toolbars -
Toggle Toolbars

Start Recording

S5top Recording
Start/Stop Recording
Cancel Recording

Start/Stop Recording Instant Shortout
Play Instant Shortcut

Switch Subscope
Show Current Subscope

Open QuicKeys Editor

Create > QuicKeys > QuicKeys Actions > Open QuicKeys Editor
This action opens the QuicKeys Editor window:.

Stop Playback

Create > QuicKeys > QuicKeys Actions > Stop Playback

This action stops playback of the shortcut.
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Pause Playback/Continue Playback

Create > QuicKeys > QuicKeys Actions > Pause Playback

Create > QuicKeys > QuicKeys Actions > Continue Playback

These actions pause and continue playback of shortcuts.

Single Step Playback

Create > QuicKeys > QuicKeys Actions > Single Step Playback

Create a single step shortcut with this action. You can then use it to step through a paused or
debugged shortcut one step at a time.

Show Toolbars/Hide Toolbars/Toggle Toolbars

Create > QuicKeys > QuicKeys Actions > Show All Toolbars
Create > QuicKeys > QuicKeys Actions > Hide All Toolbars

Create > QuicKeys > QuicKeys Actions > Toggle Toolbars

These actions control QuicKeys toolbars you have created by showing or hiding them. Use the
Toggle Toolbars option to alternately show and hide multiple toolbars with the same trigger. Show
All Toolbars will only reveal toolbars that are scoped to the application which is front most.

Start/Stop/Toggle/Cancel Recording

Create > QuicKeys > QuicKeys Actions > Start Recording

Create > QuicKeys > QuicKeys Actions > Stop Recording

Create > QuicKeys > QuicKeys Actions > Start/Stop Recording

Create > QuicKeys > QuicKeys Actions > Cancel Recording

Use Start Recording to start QuicKeys recording your actions. Stop Recording will finish and create

the newly recorded shortcut. Start/Stop Recording toggles recording on/off. Cancel Recording will
stop recording and not save the recording.

Start/Stop Recording Instant Shortcut

Create > QuicKeys > QuicKeys Actions > Start/Stop Recording Instant Shortcut

This action toggles recording of the instant shortcut on and off.
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Cancel Recording Instant Shortcut

Create > QuicKeys > QuicKeys Actions > Cancel Recording Instant Shortcut

This action cancels recording of the instant shortcut.

Switch Subscope

Create > QuicKeys > QuicKeys Actions > Switch Subscope

Each shortcut scope can have multiple subscopes, allowing for different actions to be triggered
by the same hot keys but at different times. By creating a shortcut to switch subscopes, you can
turn on/off whole groups of shortcuts assigned to those subscopes with a single keystroke. Use of
subscopes is covered in Chapter 7.

1 E Switch Subscope E
. a B = i
QuicKeys Action: | Switch Subscope *‘v‘]
Subscope Action: | Switch to Next Subscope i-%-]
Scope: [ Front Application ‘—H
Display: [ Use Preferences setting H%w]

Subscope Action -
* Switch to Next/Previous Subscope — Switch to the next/previous subscope within a scope.
* Switch to Specific Subscope — Switch to a specific subscope of a designated scope. Choose
a scope from the Scope pop-up and the Subscope pop-up will appear below it so you can
choose the desired subscope. For example, if you have subscopes of “composing” and “filing”
within your Mail scope, you can switch directly to either of those scopes.

Scope - Select which Scope is having its Subscope switched.

* All Applications — This option will activate the specified subscope within the All
Applications scope.

* Front Application — This option will activate the specified subscope within the front most
application of that subscope exists.

* Choose one of your application-specific scopes from the list.

Subscope - If the Subscope Action is set to switch to a specific subscope, choose the desired
subscope.
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* Subscope List — Select the desired subscope from the list of subscopes associated with the
scope chosen above.

* Subscopes Off — Rather than choose a specific subscope, have QuicKeys turn off any custom
subscopes in the active scope.

Display — Select whether the subscope should display using the Preferences setting, show in
window, show using Growl, or do not show.

Show Current Subscope
Create > QuicKeys > QuicKeys Actions > Show Current Subscope

The Show Subscope action presents a display on screen that shows the currently active subscope in
QuicKeys.

1 E Show Current Subscope H
QuicKeys Action: [ Show Current Subscope *1*']
Display: [ Use Preferences Setting F%-]

Display - Select whether the subscope should display using the Preferences setting, show in
window, or show using Growl.
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Repeat Loop

Create > QuicKeys > Repeat Loop
You can use the Repeat Loop action to replay steps in a multi-step shortcut. Rather than having to
cut and paste several iterations of a series of steps within a shortcut, you can reiterate those steps

easily with a repeat loop.

Repeat Loop requires both a Begin and an End step to work. You’ll need to sandwich the desired
steps below the Begin Repeat Loop step and above the End Repeat Loop step.

Begin Repeat Loop

Create > QuicKeys > Repeat Loop > Begin Repeat Loop

1~ Repeat 2 times E

Repeat Action: [ Begin repeat loop )1‘-‘
2 ol

v
._.-

@ Repeat times

() Prompt for repeat count

O Use value of variable Clipboard

Repeat Action - Select “Begin repeat loop” to repeat the steps between the begin repeat loop step
and the end repeat loop step.

Repeat X times - Select his option and specify how many times you want the loop to repeat.

Prompt for repeat count - Select this option if you want QuicKeys to display a prompt asking you
to choose how many times you want the shortcut steps to repeat at runtime.

Use value of variable - Select this option if you want a variable to determine how many times the
loop should repeat. Then specify which variable.

End Repeat Loop

Create > QuicKeys > Repeat Loop > End Repeat Loop

1 v () EndRepeat E

Repeat Action: [ End repeat loop )1‘-‘

Repeat Action - Select End repeat loop to terminate a Begin Repeat Loop shortcut.

QuicKeys 4 User Guide August 2009 130




Chapter 10 — Actions: QuicKeys

Shortcut Status

Create > QuicKeys > Shortcut Status

Shortcut Status is a way to consolidate the way a shortcut notifies you of how it is running. You
can have other steps jump to this step for their success or fail behaviors in order to do more
sophisticated reporting of why they succeeded or failed.

Dialog Box Notification

Create > QuicKeys > Shortcut Status > Dialog Box Notification
1 ¥ & Post Dialog Motification E

Shortcut Status steps allow combining the results of other steps into one action.

Matification Style: | Dialog Box Notification %{

[ Dismiss dialeg after 30 . seconds

This action shows a dialog window on screen describing the results of the step that ran immediately
before this step.

Dismiss dialog - Select how long the dialog should remain on screen. Leave this option unselected
to have the notification remain until you manually dismiss it.

E-mail Notification

Create > QuicKeys > Shortcut Status > E-mail Notification

1 * & Send Notification via Email E

Shortcut Status steps allow combining the results of other steps into one action.

Naotification Style: [ E-mail Notification ’%i

(W | This action will e-mail the recipients set in the Notifications preferences.
This action sends an e-mail to the accounts specified in the Notifications preference pane
describing the results of the step that ran immediately before this step.

Click the notifications button " ®_J to open the Notifications pane and enter or review the e-mail
accounts.
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External Script Notification

Create > QuicKeys > Shortcut Status > External Script Notification

1 ¥ & Post Notification via External Script E

Shortcut Status steps allow combining the results of other steps into one action.

Maotification Style: [ External Script Notification ‘-H

B | This action will use the script set in the Notifications preferences.
This action runs the notification script that was specified in the QuicKeys Preferences
Notifications pane.
Click the notifications button " _®_ to open the Notifications pane and enter or review the script.

Growl Notification

Create > QuicKeys > Shortcut Status > Growl Notification

1 * & Normal Priority Growl Motification E

Shortcut Status steps allow combining the results of other steps into one action.

Matification Style: [ Growl Motification Pﬂ

Priority: [ Normal l-H

Display: [ Stay on screen

lcon: S Use Quickeys lcon

O specied con

Sends a Growl notification describing the results of the step that ran immediately before this step.
Priority — Select the priority of this message.

Display - Select “Stay on screen” to have the message stay on screen until you click, rather than
tading off.

Icon - Choose what icon to display in the Growl notification.
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Softkeys

Create > QuicKeys > Softkeys

SoftKeys are special kind of toolbar that shows a list of shortcuts. The Each SoftKey toolbar is only
temporarily shown until a selection is made from it.

1 v EE SoftKeys Sl

Key | Shortcut

Open Address Book
Open Calculator
Open iCal

Open Mail

Open Preview
Empty

Empty

Empty

Empty

Empty

Toclbar Color: Iil Text Color: IEI S

Display: H Show on display with mouse

(=TT =T - TSI - T, R S Y I N ]

Softkeys displays a toolbar with up to ten shortcuts. While the toolbar is shown, the shortcuts can be triggered by pressing
the corresponding number keys on your keyboard.

Drag shortcuts to the list to add. Drag inside the list to re-order. Drag off the list to remove.
Shortcut List — The Shortcut list shows you the Shortcuts that will be shown on the SoftKey
toolbar.
Toolbar Color - Specifies the background color of the toolbar.
Text Color - Specifies the color the text on the toolbar.

Show on display with mouse - When selected the SoftKey toolbar will be shown on the screen
that the mouse cursor is on.

Open Actions Palette button — Click ‘= the Shortcut list in Shortcut Action Palette. You can drag
shortcuts from the palette into the list in the SoftKey editor.
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Variables

Create > QuicKeys > Variables

Variables allow you to store, compare, and use information gathered on the fly in a multi-step
shortcut. These variables can be set to remember their values even if you quit and re-launch
QuicKeys or reboot your computer. Alternately they can be told to reset to a specific defined value
whenever QuicKeys is launched.

Variables, including how to create variables other than the System Clipboard, are covered in
Chapter 7.

Assign Variable

Create > QuicKeys > Variables > Assign Variable

The Assign Variable action lets you assign new values to variables while a shortcut is playing. The

value you assign can be a plain number or text, the contents of another variable, or the result of an
equation you build.

1 v | Assign Variable IDNumber ]
Assign to Variable: [ IDMNumber %‘ =
000001, + A1
f Add Eguation ltermn w—i

[ Ask for variable and equaticn when playing

Assign to Variable - Choose the variable you want to work with from this list. If you have created
no variables of your own, the only one in the list will be the System Clipboard.

Value/Equation field — Put the value you want to assign to the chosen variable here. This field
is more than just a text/numerical entry field though! You can build equations in this field that
incorporate mathematical operators and make use of the data from other variables.

Add Equation Item - This list contains all of your variables and functions, a list of mathematical
operators, and a few other items helpful for building your equation in the equation field.

Ask for variable/equation when playing — Rather than predetermining what variable value or
equation you want to use, you can determine it at run time. If you check this box, QuicKeys will
pause playback when this step is reached and ask you for the variable or equation you want to use.
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Compare Variable

Create > QuicKeys > Variables > Compare Variable

The compare variable action lets you compare the contents of a variable with another value. The
entire point of this shortcut type is to test a variable’s value then use the results in conjunction with
step results to branch the flow of your shortcut. For example, you might test to see if the value of

a counter variable you have created has reached a value of “0.” If that value has not been reached,
jump back to step 1 of your multi-step shortcut. If zero has been reached, terminate playback of the
shortcut.

1 ﬁ Compare Variable IDNumber H
Compare Variable: [ IDMNumber '-H [ Equals '-H
Clipboard
[ Add Equation Item Fv-]

["] Mumeric comparison

[T Ask for variable and equatien when playing

Compare Variable — Choose the variable whose contents you want to compare from this list. The
comparison pop-up contains a 14 different methods of comparing the contents of the selected
variable with the value in the next field.

* Equals * Contains Text e IsText

*  Does Not Equal * Does Not Contain Text * Is Not Text

* IsLess Than * IsType * Is Empty

* Is Greater Than * Is Not Type * Is Not Empty

* Is Less Than or Equal
* Is Greater Than or Equal

Comparison equation field - Enter a value or build an equation to compare against the value of the
variable selected in the variable pop-up list.

Add Equation Item - This list contains all of your variables and functions, a list of mathematical
operators, and a few other items helpful for building your equation in the equation field.

Numeric comparison — Check this box if you want to force a numeric comparison of the values of
your variable and the equation field. For example, one of the items you are comparing may contain
the string “3.0” rather than a numeric “3.” To force the 3.0 to evaluate as a numeric 3, you would
need to check this box.
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Ask for variable/equation when playing - Rather than predetermining what variable value or
equation you want to use, you can determine it at run time. If you check this box, QuicKeys will
pause playback when this step is reached and ask you for the variable or equation you want to use.

Use Variable
Create > QuicKeys > Variables > Use Variable

The Use Variable action lets you extract the contents of a variable while a shortcut is playing. The
contents can be typed or pasted by QuicKeys into a document or displayed on your screen.

1 ':_," Use Variable Clipboard E
Use Walue: B Variable: !- Clipboard ’-*H
O Equation:
Add Equation Itemn b

[T Ask for variable/equatien when playing

Action: [ Type Value h%"
Typing Speed: ===} 0.00 sec
Slow Fast

Use Value: Variable — Choose the variable whose contents you want to use from this list. The
contents will be outputted in the manner you choose for the Action portion of this shortcut.

Use Value: Equation — Rather than simply pull the contents from one of your variables, you can
create an equation consisting of variables and operations upon them. The results of the equation
are determined and then outputted in the manner you choose.

Add Equation Item - This list contains all of your variables and functions, a list of mathematical
operators, and a few other items helpful for building your equation in the equation field.

Ask for variable/equation when playing — Rather than predetermining what variable value or
equation you want to use, you can determine it at run time. If you check this box, QuicKeys will
pause playback when this step is reached and ask you for the variable or equation you want to use.

Action - Select the desired radio button to choose the method of output you want QuicKeys to
use. Typing and Inserting into documents will quickly dump the contents of a variable or the results
of an equation into a document for you. Displaying the value lets you OK/Succeed or Cancel/Fail
the step. You can also select and copy the results from the Equation Value window:
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Make applications accept insert — Some applications are unaware of changes to the contents of the
system clipboard, which can cause problems with insert operations. Selecting this option will force
all applications to check with the system clipboard for any changes before inserting.
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Wait
Create > QuicKeys > Wait

The Wait action puts a multi-step shortcut on hold while it waits for a certain condition to occur.
Once that condition is met, the shortcut will proceed to the next step. This is an excellent way

to keep your shortcut playback in sync with what is happening on your computer. Where a strict
pause of X seconds may end up waiting too long or not long enough, the wait shortcut has no such
concern.

Types of Wait Actions

There are six types of things QuicKeys can wait for: Wait for Application, Button, Date & Time,
Menu, User, and Window.

When you look at the contents of the Create > Wait submenu you’ll note that six types of wait
actions are listed. But when you look at the “Wait For” pop-up list while editing a wait step, you'll
see only five. The missing item is Wait for Menu. Wait for Menu is very closely tied to the Menu
Selection action, and as such there are engineering reasons why it will not work well to make it an
option in the “Wait For” pop-up.

Wait for Application
Create > QuicKeys > Wait > Wait for Application

Wait For - Select Application to wait for the state of a specific application to change to running,
not running, front-most, not front-most, hidden, or not hidden.

1 » (& Wait for Application M
Wait For: [ Application '-H
Application: [ [l Adobe InDesign €54 -
State: [ Is Running F-H
[] Timeout: | Step succeeds after = 30 = seconds

”»

Application - Choose from the list of running applications, or choose “Select Application...” and

navigate to the desired application.
State -

* Is Running — QuicKeys checks to see if the specified application is running. If the
application isn’t running, QuicKeys pauses playback of the shortcut until it is.

QuicKeys 4 User Guide August 2009 138




Chapter 10 — Actions: QuicKeys

* Is Not Running — QuicKeys looks for the specified application. If that application is
running, playback of the shortcut is paused until it quits.

* Is Front Most — If the specified application is not in front, QuicKeys pauses the shortcut
until that application moves to the front.

* Is Not Front Most — If the specified application is in front, the shortcut is paused until that
is no longer the case.

* Is Hidden — If the specified application is not hidden, QuicKeys pauses playback of the
shortcut until it becomes so.

* Is Not Hidden — If the specified application is hidden, the shortcut is paused until it is no
longer hidden.

Timeout - Select this option to have QuicKeys wait only a certain amount of time for the

application. Then select whether this should be considered a success or failure and how long
QuicKeys should wait.

Wait for Button

Create > QuicKeys > Wait > Wait for Button
Wait For — Select Button to wait for a specific button to appear or go away, become enabled or not
enabled, become selected (checked) or is not selected. Buttons can be differentiated by not only

name but also what type of window they are in.

1 @ Wait for Button E

Wait For: [ Button l-H

Button Mame: | Is

M Ignore case

Button Number: 1 @ if multiple matches

Exists: [ Yes l-ﬂ
Enabled: [ Yes 'ﬂi-]
Selected: | Do not care HH
Button Window: [ Main Window l-%-]
[] Timeout: | Step succeeds after = 30 = seconds =

Button Name - QuicKeys looks for a button whose name is, contains, starts with, or ends with the
text you enter.
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Ignore Case - If you check this box, QuicKeys will ignore upper/lower case difterences when
trying to locate your button.

Button Number - If more than one button that matches your naming criteria exists, QuicKeys
needs to be told which of those buttons it should be looking at.

Exists - QuicKeys needs to be told what attribute of that button should be tested. Primarily you
will want QuicKeys to test whether or not the specified button Exists.

Enabled - QuicKeys can test to see if a button is enabled or disabled (grayed out), or you may not
care which state it is in.

Selected - Check boxes and radio buttons are testable too! This pop-up list lets QuicKeys check to
see whether or not a particular radio button or check box is checked.

Button Window - When looking for the desired button, QuicKeys can be instructed to find it in a
particular type of window such as, palette, document, sheet, or drawer. Only the front window can
be tested.

Timeout - Select this option to have QuicKeys wait only a certain amount of time for the button.

Then select whether this should be considered a success or failure and how long QuicKeys should
wait.

Wait for Date & Time
Create > QuicKeys > Wait > Wait for Date & Time

Wait For — Select Date & Time to check the current date and time to see if it is before or after the
date and time you specify.

1 v (3 wait until 6/24/09 6:00 AM i
Wait For: [ Date & Time l-H
Date & Time: 6/24/2009 6:00 AM E]
[] Only check time
Timeout: | Step succeeds after = 30—y seconds =

Date & Time - QuicKeys will pause playback of the shortcut until the current time matches the
Date and Time you specified.
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Only check time - Enable this option if you are not concerned with the date and want
QuicKeys to only check the current time.

Wait for Menu

Create > QuicKeys > Wait > Wait for Menu

The wait for menu action waits to see if a specific menu or menu item comes into existence or does
not exist, becomes enabled or disabled, becomes checked or unchecked.

The options for this action are more similar to Check for Menu (covered in the “Decision” section
of this chapter) and Select Menu (covered in the “Menus” section of Chapter 14) than it is to the
other wait actions.

1 v &= Waitfor in menu

™

Menu for Action: Menu:

|_Details... J}

Menu ltem:

Ir_ Set Menu for Action... W

[] Is system menu cn right side of menu bar

In Application: !' Front Application ! H
Options

Itern is Checked: ' Don't Care [

ltem Exists: | Yes HH

Itern is Enabled: ' Yes 2]

|_Details... J}

+ | =

Show Menu: E Show menus while performing menu action

Alternate: [_| Perform as alternate menu action using modifier keys

3 Command X Option

£+ Shift * Control

Menu for Action - You can click the Set
Menu for Action button, and QuicKeys
will prompt you to select the menu and
menu item (including any submenus) and
automatically fill in the fields, or you can
fill in the fields manually. Click plus (+) to
add additional lines as necessary. Details
buttons allow you to further refine the
target menu details.

Choose a menu from the menu bar to set it as the menu for this QuicKeys
action. Click Cancel to leave this QuicKeys action unchanged.

To display the menu bar for a different application, select the application
in the pop-up menu below.

Showing Menu Bar of: | ™ Finder '. | Cancel |
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Note: Some applications may provide QuicKeys one set of menus when a shortcut is created, but
display another set upon playback. If the menu item you need is not presented by QuicKeys, you
will need to type the menu item’s name manually.

Is system menu on right side of menu bar - select this options to enable QuicKeys to access these
menus.

In Application - Select the application QuicKeys should look in for the menu.

Item is Checked - A menu item will sometimes have a check mark beside it indicating that
whatever part of the application it controls is turned on. QuicKeys can test a menu item for the
presence of a check mark. If you set this pop-up to “Yes” QuicKeys will pause playback of the
shortcut until the specified menu item becomes checked.

Item Exists - Have QuicKeys check to see if the specified menu item Exists or does not Exist. If
you select “Yes” then QuicKeys will pause playback until that menu or menu item exists. If you
select “No” then QuicKeys will pause playback until that menu or menu item no longer exists.

Item is Enabled — Menu items that are Enabled or active show up in black text, those that are
Disabled or inactive use gray text. QuicKeys can test for this condition and the shortcut playback
will be paused until the selection you specify here is met.

Show menus while performing menu action - Some applications do not build their menus until
you click on them with your mouse, and they cease to exist once they close. This means QuicKeys
will have to actually open the desired menu to get it to draw its contents and make them accessible.
Also, it is often impossible to test a menu item to see if it exists, is checked, or is enabled unless

its menu is opened. For this reason, this option will have to be checked for almost every Wait for
Menu and Check for Menu shortcut you build.

Perform as alternate menu action using modifier keys - The names of some menu items change

if you open the menu and hold down a modifier key. (Open Safari’s File menu and press the option
key, you should see Close Window change to Close all Windows.) With this option checked,
QuicKeys simulates pressing the modifier key while checking for the desired menu item’s presence.

Wait for User Action
Create > QuicKeys > Wait > Wait for User Action

Wait For - Select User Action to pause playback of the shortcut until the user interacts in a
particular way as defined in advance.
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1 @} Wait for click with main mouse button E
Wait For: [ User Action "H
User Action: | Press Main Mouse Button FH

[C] Timeout: | Step succeeds after = 30 = seconds

User Action - Select which user action QuicKeys should wait for before continuing to the next
step.

* Press Main Mouse Button * Release Main Mouse Button

*  Press Second Mouse Button * Release Second Mouse Button
* Press Third Mouse Button * Release Third Mouse Button

* Press Any Key * Release Any Key

* Press Return * Release Return

* Press Enter * Release Enter

* Press Space * Release Space

* Press Escape * Release Escape

*  PressTab * Release Tab

* Typed Words

Typed Words - If the user action is Typed Words, enter the text QuicKeys should wait for you to
type.

Ignore Case - If you check this box, QuicKeys will ignore upper/lower case differences.
Timeout - Select this option to have QuicKeys wait only a certain amount of time for the user.

Then select whether this should be considered a success or failure and how long QuicKeys should
wait.

Wait for Window
Create > QuicKeys > Wait > Wait for Window

Wait For - Select Window to tell QuicKeys to pause a shortcut until a window matching the
conditions specified exists (or no longer exists).
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1~ @ Wait until Window Exists H

Wait For: [ Window '-H

Window Name: | Is

M Ignore case

Window Type: [ Any Type of Window l-%-]

Window Is: | Main Window HH

Window State: [ Exists l-%-]
[C] Timeout: | Step succeeds after = 30 = seconds

Window Name - Choose from Is, Contains, Starts with, and Ends with, and enter the name of the
‘Window for which you are testing.

Ignore Case - If you check this box, QuicKeys will ignore upper/lower case differences.

Window Type - In cases where you may have more than one window with the same name (a
document named Font and a palette with the same name for example), QuicKeys can differentiate
by window type. Choose the type if you need to be specific, or leave it set to Any Type of Window
if the type does not matter.

* AnyType of Window *  Document Window * Palette Window

* Sheet on Any Type of * Sheet on Document * Sheet on Palette Window
Window Window * Drawer on Palette

* Drawer on Any Type of * Drawer on Document Window
Window Window

A drawer requires you to also specify a drawer number and which side (left, right, top, or
bottom) which side of the window it is one.

Window Is -

* Main Window — The main window is essentially the most important window on your screen
at any given time. This is often a document or list window. By testing for the Main window
you can often avoid needing to specify the window name.

* Focused Window — The focused window is the often where your text insertion point is,
or possibly where you have selected a control or object. This is often but not necessarily a
document window; it could also be a palette or toolbar for example.

* Frontmost/Any Level — The level at which the desired window currently resides can also be
specified for testing by QuicKeys. Your choices are Front-most and Any Level. If you simply
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want to know if the window is open, use Any Level. But if, for example, you need QuicKeys
to perform operations inside the front window, you'd want to specify Frontmost. In this case
if the window is open and in front, the step result is “success.” However, if the window is
open and not in the front, the step result is “failure.”

Window State -

* Exists — QuicKeys tries to find the window you specified with the first three pop-ups and
pauses the shortcut until it can.

* Does Not Exist — If the specified window does not exist, the shortcut does not pause. If it
does exist, QuicKeys pauses the shortcut and waits for the specified window to close.

* Changes Order — QuicKeys takes note of the current level of the specified window, pausing
the shortcut until the level changes.

* New — Waits for a new window matching the criteria to be shown.
Timeout - Select this option to have QuicKeys wait only a certain amount of time for the window.

Then select whether this should be considered a success or failure and how long QuicKeys should
wait.
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[ e saipting > [T

o Workflow

QuicKeys can enhance your AppleScripts by tying them to QuicKeys
triggers. Conversely, AppleScripts can become steps in a QuicKeys
multi-step shortcut, providing more flexibility in how you manipulate your work environment.

AppleScript

Create > Scripting > AppleScript

AppleScript is a programming language designed for controlling applications via Apple Events. It
provides simple commands you can use to customize and automate your Mac. QuicKeys harnesses
this additional power by allowing you to either enter AppleScripts as text directly into a shortcut,
or by reaching out to an already compiled script to execute it as part of a multi-step shortcut.

For example, iTunes is equipped with a handy set of scriptable features. In chapter 3 of this manual,
one of the tutorials shows you how to build shortcuts to manipulate several of iTunes’ more

trequently used features.

Note: When QuicKeys executes an AppleScript step, it is intelligent enough to wait for that script
to finish before continuing on to the next step in the multi-step shortcut.

Script File
Create > Scripting > AppleScript > Script File

1 » < AppleScript E

Applescript Type: | Script File B‘

Choose an AppleScript file.

[: Choose Script File... .,] Open in Editor

Assign Script Result to Variable: [ No Variable ‘-H

Choosing the Script File option reveals a Choose Script File... Button. Click this button to reveal a
standard open file window and navigate to a previously created AppleScript file, then click Choose.
Alternately, you can drag a file into the file well.

Assign Script Result to Variable — AppleScripts can return success or failure or some other value
depending on how they are written. You can have QuicKeys place the script results inside one of
your QuicKeys Variables (see Chapter 7 for more on Variables), just choose the desired variable
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from this pop-up list. If you have not set up any variables in QuicKeys, this pop-up will contain
only “Clipboard” as an option, allowing you to send the script results to the system clipboard.

Text
Create > Scripting > AppleScript > Script Text

1 » < AppleScript E

AppleScript Type: | Text B‘

Check Script

Assign Script Result to Variable: | No Variable I-G-]

Choosing the Text option provides a text box where you can type in your AppleScript. It also
reveals a Check Script button which checks the syntax of the script you entered..

Assign Script Result to Variable - AppleScripts can return success or failure or some other value
depending on how they are written. You can have QuicKeys place the script results inside one of
your QuicKeys Variables (see Chapter 7 for more on Variables), just choose the desired variable
from this pop-up list. If you have not set up any variables in QuicKeys, this pop-up will contain
only “Clipboard” as an option, allowing you to send the script results to the system clipboard.
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Workflow

Create > Scripting > Workflow

This action plays an Automator workflow. Workflows can be made using Apple’s Automator
application.

1 v & Workflow E

Choose a workflow file.

( Choose Workflow... :] Open in Automator

H Wait for workflow to complete
Choose Workflow - Click Choose Workflow and navigate to the workflow you want to play, or drag
it into the well. The path will then display there.
Open in Automator - Click here to open the workflow in Automator.
Wait for workflow to complete - Select this option to have QuicKeys wait for the workflow to

complete before proceeding to the next step. With this option unselected, QuicKeys will simply
start the workflow and then proceed to the next step.
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£ clp -

B Computer Tools [
QuicKeys System Tools cover a wide array of functions, from & Finder >
collecting and retrieving text and graphics clips, to shutting down & Switch Applications
your computer, to switching applications and running terminal 1 Switch Printer
commands. B System Keys [ 3

W Terminal Command

Clips

Create > System > Clips

The Clips actions enable you to gather and store clips of text or graphics in clips groups. The
Clips feature is a bit like the system clipboard, but with a memory. Unlike items on your system
clipboard, QuicKeys clips are saved even if you restart your computer or quit QuicKeys. It is a
permanent collection of boilerplate text (formatted or unformatted) and/or graphics that you can
retrieve at any time to paste or type into a document.

In addition to these two Clips actions, QuicKeys 4 has a Clips Manager which allows you to create
and edit your clips. The Clips Manager is covered in Chapter 7.

Create Clip

Create > System > Clips > Create Clip

i [j Make Clip from selection E

Clip Action: [ Create Clip I-H

%) Use selection in front application

() Use contents of clipboard

Saved Clip Type: [ Text Clipping |-H

Compatibility: [ | Make applications recognize clip actions

P Emerson Quotes

(] QK Icons | L

Source Group:

Emerson Quotes

& 4 e

Viewing Group: =]
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Clip Action -

Use selection in front applications — This option will copy whatever text or graphics you
currently have highlighted/selected in your application, and turn it into a clip for later retrieval.

Use contents of clipboard - This option will copy whatever text or graphics are currently on
your system clipboard, and turn it into a clip for later retrieval. This is useful if you've cut or
copied data to the system clipboard, closed the document, and subsequently decide that data
would make a good clip for your collection.

Saved Clip Type - Specify how QuicKeys should handle the data that’s been collected.

* Text Clipping — QuicKeys will save the text, and some images. If there is text with colors
and styles or any images, the clip will be saved in rich text format; otherwise it’ll just be
saved as plain text.

* Image Clipping — QuicKeys will save only images, and discard any text. If there are multiple
images in the data, you will be prompted to select which image to use.

* Universal Clipping — QuicKeys creates a clip that’s an exact replica of the data. This the
most compatible as it retains all data. However, a clip of this type not directly editable in
the Clips Editor. This clip type also consumes a lot of disk space, especially if there’s a lot of
large graphics in the clip.

Compatibility — Selecting Make applications recognize Clip actions may help if you have problems
pasting a Clip into a particular application.

Groups - You do not need to create clips groups, but they are useful for managing large numbers of
clips. If you would like to save this new clip to a specific group, select the appropriate group.

Details on using clips shortcuts and using the Clips Manager can be found in Chapter 7.
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Insert Clip

Create > System > Clips > Insert Clip

This action can either insert a specific clip or retrieve a list of all the clips in your collection so you
can choose during playback.

i Ei Ask for Clip to paste from group QK lcons E

Clip Action: [ Insert Clip I-H

8 Paste clip when inserting
[:J Type clip when inserting {3} 0.00 sec

Slow Fast

Compatibility: [ ] Make applications recognize clip actions

/¥ Abbreviations

G Instant Shortcut
E QuicKeys Online

&8 Trigger

k¢ Web Action

Source Group:

QK lcons

(2 =) 4w

Viewing Group: | All Groups QK Icons |

Clip Action -

Paste clip when inserting - This option behaves much like pressing Command+V and pasting
something from your system clipboard. This is the fastest and most common way to insert your
clips into your documents.

Type clip when inserting - This option simulates the keyboard typing the clip data into your
document. This only works with text clips, graphics clips cannot be “typed.” Having QuicKeys
type the clip as text might be necessary if the target application cannot accept paste/insert
actions.

Compatibility — Selecting Make applications recognize Clip actions may help if you have problems
pasting a Clip into a particular application.

Clips list - If you do not select a specific clip, you will be prompted when the shortcut is run. This
is useful if you would like a generic insert clips shortcut. To have this shortcut insert a specific clip,

select it from the list.

Details on using clips shortcuts and using the Clips Manager can be found in Chapter 7.
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Computer Tools

Create > System > Computer Tools

The Computer Tools actions lets you automate the process of logging out, putting your computer
to sleep, and showing and hiding applications, among other things.

1 » E Shut Down E
Actior ¥ Shut Down ]
Restart
- Sleep &
Log Out

Hide Front Application
Hide Other Applications
Show All Applications

Bring All Windows to Front
Start Screen Saver
Empty Trash

Switch to Next Space
Switch to Prior Space
Switch to Space

Quit Application
Force Quit Application

Lock Keychain

Shut Down

Create > System > Computer Tools > Shut Down

This action shuts down your computer immediately with no “Are You Sure?” warning. You will still
be prompted to save any unsaved documents.

Restart

Create > System > Computer Tools > Restart

This action restarts your computer immediately with no “Are You Sure?” warning. You will still be
prompted to save any unsaved documents. Your shortcut can continue to play until the system quits
QuicKeys. The shortcut will not resume.
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Sleep

Create > System > Computer Tools > Sleep

This action puts your computer in sleep mode.

Log Out

Create > System > Computer Tools > Log Out

This action logs out of the current user account.

Hide Front Application

Create > System > Computer Tools > Hide Front Application
This action hides the front most application.

Hide Other Applications

Create > System > Computer Tools > Hide Other Applications
This action hides all but the front most application.
Show All Applications

Create > System > Computer Tools > Show All Applications
This action reveals all open, previously hidden applications.
Bring All Windows to Front

Create > System > Computer Tools > Bring All Windows to Front
This action brings all of the windows of the front-most application to the front.
Start Screen Saver

Create > System > Computer Tools > Start Screen Saver

This action starts the user’s screen saver as specified in System Preferences.
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Empty Trash

Create > System > Computer Tools > Empty Trash

This action empties the system trash without the need to switch to the Finder or click on the
Dock.

Note: This shortcut bypasses the system’s “are you sure you want to empty the trash” warning so use
yp y y y p g

it with care.

Switch to Next Space

Create > System > Computer Tools > Switch to Next Space

Switches to the next Mac OS X Space after the current Space.
Switch to Prior Space

Create > System > Computer Tools > Switch to Prior Space

Switches to the prior Mac OS X Space before the current Space.
Switch to Space

Create > System > Computer Tools > Switch to Space

Switches to a specific Mac OS X Space.

1 » E Switch to Space 1 E

Action: [ Switch to Space ’1-‘-] [ 1 '?"l

Specity the number of the space you wish to switch to.
Quit Application
Create > System > Computer Tools > Quit Application

Quits the front most application or a specified application. The user may be asked to save any
modified documents.
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1 » E Quit Front Application E

Action: | Quit Application *-H [ Front Application I-H

Specity which application should be quit. Choose “Front Application,” choose from the list of
currently running applications, or choose “Select Application...” and navigate to the desired
application.

Force Quit Application

Create > System > Computer Tools > Force Quit Application

Force Quits the front most application or a specified application. The user will not be given the
chance to save any modified documents. Any changes to documents will be lost.

As with the quit application action, specify which application should be quit.

Lock Keychain

Create > System > Computer Tools > Lock Keychain

Locks the specified keychain. QuicKeys Keychains can be managed in the Security pane of
QuicKeys Preferences, while Mac OS X Keychains are managed via the Keychain Access
application.

1 v HE Lock Keychain QuicKeys M

Action: [ Lock Keychain H-*-] [Qu'rl:l(ev.rs I-%-i

Specify which keychain to lock.
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Finder

Create > System > Finder

QuicKeys allows you to automate tasks in the Finder.

Apply Label

Create > System > Finder > Apply Label
The Apply Label action let you set or remove the label on files.
1 v K Clear Finder label E

Applylabel: X |l & U o @ &8 &

Target: (®) Finder Selection
D Specific Item Choose Target...

[T] Apply label to folder contents

Apply Label - Select which label to apply:.

Target - Specify whether the item to be labeled should be the one selected in the Finder (at the

time the shortcut runs) or a specific item. Click Choose Target and navigate to it, or drag it into the

well. The path will then display there.

Apply label to folder contents - Select this option to apply the label to all the items within the
folder as well as the folder itself.

Switch Views
Create > System > Finder > Switch Views

The Switch Views action enables you to adjust the appearance of Finder windows.

1 v B Change frontmost window to icons view E

Switch Finder View ta: [ Icons B‘

[T] Change view in all open windows

Switch Finder View To — You can choose to view windows in the Icons view, List view, Columns
view, or Cover Flow view.
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Change view in all open windows - Select this option if you want your switch views step to change
the view of all your open Finder windows. If you do not select this, QuicKeys will only change the
display of the active Finder window.
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Switch Applications

Create > System > Switch Applications

The Switch Applications action enables you to switch between applications with a hot key (or
other trigger) rather than having to use mouse clicks. You can create shortcuts to switch directly
to specified applications, or switch between open applications. As well as being a great stand-alone
shortcut, Switch Applications is a staple of many multi-step shortcuts you may want to build.

1 9 Switch to Next Application E

Switch to: | Next Application '%‘

E Can switch to hidden applications

After Switch: {®) Leave other applications visible
O Hide previous application
O Hide other applications

Switch to - Select which application to switch to.

* Next Application * Previous Application

Switching to the next or previous application is based on the order in which the applications
where launched.

Can switch to hidden applications - Select this option to include hidden applications.

* Last Application — Switches to the last application that was front most before a prior
QuicKeys switch application step was run.

* Select Application —To switch to a specific application, select any open application from the
list or select Select Application and navigate to the desired application.

Open if not running - Select this option to open the application if it is not already:
After Switch - Select whether to hide other applications.
Leave other applications visible - This is what the operating system does naturally when you
use Command+Tab to switch to another application. No application windows are hidden in this

case.

Hide previous application - This option completely hides the previous application from view
after the switch is made. Hidden applications can be revealed by clicking on their Dock icon.

Hide other applications — This options hides all applications other than the one switched to.
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Switch Printer

Create > System > Switch Printer

The Switch Printer action changes your default printer without you having to manually do so in the
print dialog. Print jobs can be easily scripted and printing to multiple printers can be done more
efficiently with this action.

The Switch Printer action is handy as a stand-alone shortcut, but really shines when combined
with a simple File > Print Menu Selection shortcut. For example, to quickly print to your black
and white draft printer you could make a two-step shortcut that does a Switch Printer (to the b&w
draft printer) then select Print from the File menu.

Give it a hot key of Command+P and you’ll always print to your draft printer when you press
Command+P.

For color printing you might instruct the Switch Printer shortcut to select your high quality color
printer before selecting Print from the File menu. Assign Command+Shift+P to this shortcut and
you’ll always print to your color printer when you press that key combination.

Note: The Switch Printer action should be run while an application’s print dialog is closed. If you
invoke an application’s print dialog and subsequently trigger a Switch Printer shortcut, the printer

selection will not change until after you close and re-open the print dialog.

1 * ®1 Switch to Printer Finance Laser]et E

Switch to Printer: [ Finance Laserjet ’1"]

Switch to Printer — This pop-up list contains printers that are already set up for use in your system.
You can define more printers with the Printer Setup Utility found in your /Applications/Utilities
folder.
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System Keys

Create > System > System Keys

System Keys actions are simply one set of Type Keystroke Eject

actions. Other than being more convenient to access, creating Volume Up

them in this way is no different than as Type Keystroke. See Volume Up - Precise

“Type Keystroke” in Chapter 14 for details. Violurne: Down _
Wolume Down - Precise
Mute

Increase Brightness
Decrease Brightness

Wideo Mirroring

Increase Keyboard lllumination
Decrease Keyboard lllumination
Toggle Keyboard lllumination

Play/Pause
MNext Track
Previous Track

Exposé - All Windows
Exposé - Application Windows
Exposé - Show Desktop

Dashboard

1 v B Type Keystroke "eject” M

Type Keystroke: eject ! E j

p Details
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Terminal Command

Create > System > Terminal Command

The Terminal Command action executes UNIX commands without the need to open the Terminal
application. You type in the command you want executed, and QuicKeys feeds it to the operating
system behind the scenes.

1 i Terminal Command - (Undefined) P

Run Command:

MNote commands cannot be run as root.

Run Command - To create this step you simply type the desired command into the Run Command
text box. When you trigger the shortcut the action takes place out of view; no windows or dialog
boxes of any type open. This is a very powerful feature, but it also means you cannot interact with
what your command has set in motion. If, for example, you used this type of shortcut to send a
“sudo” command, you would not be given any way to enter the required password.
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. . . ! Password Vault
QuicKeys Text actions manage text in several useful ways: Text can be X Text Tools >

stored and retrieved at any time with tap of a key, the current date and/ A Type Text
or time can be inserted into documents in just about any imaginable
format, and a password can be injected into multi-step shortcuts with a
more secure form of text storage.

Date & Time

Create > Text > Date & Time

The Date & Time action is pretty straight forward in its uses. You can insert it into documents
you are working on, put it in a multi-step shortcut along with formatted text for up-to-the-minute
boilerplate letterhead, use it to adjust web page “last edited” information, and more.

All date & time actions have some options in common.

Adjust by — Rather than inserting the current date or time, you can adjust the date plus or minus
any number of years, months or days, and adjust the time plus or minus any number of hours,

minutes or seconds.

Example - This field changes dynamically based on your selections to show you the effects of those
settings.

Insert Text - Select this option to Insert/Paste the date and time rather than have QuicKeys
simulate typing it into your document. Inserting is faster but typing works when insert may not.

Make applications accept insert - Some applications are unaware of changes to the contents of
the system clipboard, which can cause problems with insert operations. Selecting this option

will force all applications to check with the system clipboard for any changes before inserting.

Type Text - Select this option to have QuicKeys simulate typing the date and time rather than
using the Insert method.

Slow/Fast Typing Slider - Set the typing speed. On slower systems QuicKeys may type faster
than the system’s typing buffer; adjust this slider to prevent that from happening.

Short Date

Create > Text > Date & Time > Short Date

Type - Select Short Date to insert the date in numerical format.
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1 v & Type Short Date )
Type: [ Short Date l-H
Format: [ Month /Day/Year i—ﬂ
Separator: | [

[7] Leading zero for day
[T Leading zero for month

[ Show century

Adjust by Years: 0 @ Months: 0 @ Days: 0 @
Example: 1/2/09
[:] Insert Text 8 Type Text
Make applications accept insert ) 0.00sec
Slow Fast

Format - Select which elements should be a part of the date and what order they should be in.

* Month/Day/Year * Month/Day * Month
* Day/Month/Year * Day/Month * Day

* Year/Month/Day * Year/Month *  Year

* Month/Year/Day * Month/Year

* Day/Year Month
* Year/Day/Month

Separator - Type a character to separate the elements of the date.
Leading zero for day - A leading zero for the day, makes all days two digits: e.g., 2 becomes o2.
Leading zero for month - A leading zero for the day, makes all days two digits: e.g., 6 becomes 06.

Show century - Showing the century makes all years four digits instead of two; e.g., 09 becomes
20009.
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Abbreviated Date

Create > Text > Date & Time > Abbreviated Date

Type - Select Abbreviated Date to insert the date with abbreviated words.

1 v | © Type Abbreviated Date M
Type: [ Abbreviated Date '-H
Prefix:
[ Weekday . |,
[ Month +
[ Day +

| Year
[7] Leading zero for day
E Show century

Adjust by Years: v] @ Months: 0 L:] Days: v] @
Example: Fri, Jan 2, 2009
() Insert Text ) Type Text
Make applications accept insert =) 0.00sec
Slow Fast

Prefix — Enter text to appear before the date. In the remaining text fields enter text to appear
between the elements.

Weekday/Month/Day/Year — From each of these menus, select an element or none to control which
elements should be a part of the date and what order they should be in

Leading zero for day - A leading zero for the day, makes all days two digits: e.g., 2 becomes o2.

Show century - Showing the century makes all years four digits instead of two; e.g., 09 becomes
20009.

Long Date
Create > Text > Date & Time > Long Date

The options for Long Date are exactly the same as Abbreviated Date, but the result has any words
spelled out instead of abbreviated.
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Time
Create > Text > Date & Time > Time
Type - Select Abbreviated Date to insert the time.

1 v © TypeTime M

Type: [ Time '-H

Time Format: () 24-hour clock Before Moon: | AM

@ 12-hour clock [
After Noon: | PM

Noon & Midnight: () 0:00 —

Separator:
® 12:00
[ Include seconds [T Use leading zero for hour
Adjust by Hours: 0 @ Minutes: 0 @ Seconds: 0 L:]
Example: 12:34AM 2:34PM
() Insert Text ) Type Text
Make applications accept insert =) 0.00sec
Slow Fast

Time Format - Select either 24-hour clock (7:40 PM becomes 19:30) or 12-hour clock

Noon & Midnight - (Only available with 12-hour format) Specify whether noon and midnight are
displayed as “o0:00” or “12:00.”

Include seconds - Select this option to type the time in a format that includes seconds.

Before/After Noon indicators — Provide a designation for morning or afternoon. Leave blank for no
AM/PM designation.

Separator - Enter the character you want to use to separate the hour from the minutes from the
seconds.

Use leading zero for hour — Selecting this option puts a “0” in front of the hour if the hour is a
single-digit number. For example, “7:45” becomes “07:45.”
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Password Vault

Create > Text > Password Vault

Password Vault differs from Type Text only in that it stores the text in a more secure way. By
encrypting and hiding the text you enter, prying eyes can be kept away from any sensitive data you
might want to place in a shortcut.

1 E Password Vault E

Password:

["] Enter password into secure fields only
Text Action: O Insert Text
Make applications accept insert

@ Type Text
Keyboard Layout: [ Current Keyboard Layout h‘-]

Typing Speed: 3 0.00sec
Slow Fast

Password - Enter the text you want QuicKeys to insert or type for you.

Enter password into secure fields only — Select this option to prevent QuicKeys from typing your
sensitive information in clear text.

Text Action —

Insert Text — Select this option to Insert/Paste the text rather than have QuicKeys simulate
typing it into your document. Inserting is faster but typing works where insert may not.

Make applications accept insert - Some applications are unaware of changes to the contents
of the system clipboard, which can cause problems with insert operations. Selecting this
option will force all applications to check with the system clipboard for any changes before

inserting.

Type Text - Select this option to have QuicKeys simulate typing your text rather than using the
insert method.

Keyboard Layout - Specify what keyboard layout will be used to type characters. When
QuicKeys simulates typing text it tries to be behave as much as possible to a user typing on
an actual keyboard. If the text is in a specific language, it may be best to use the keyboard

layout the corresponds to that language.

Typing Speed - Set the typing speed. On slower systems QuicKeys may type faster than the
system’s typing buffer; adjust this slider to prevent that from happening.
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Text Tools

Create > Text > Text Tools

Text Tools actions are a collection of useful text formatting operations. They allow you to quickly
clean up superfluous white space, turn styled text into plain, change case, and more.

1 _5‘1 Reformat Selected Text E

Text Action: ! Reformat ’%‘

[T Prempt for action

Remowes single spaced carriage returns and extra whitespace.

Text to Change: | Selected Text ]

B Replace selected text with changed text
D Leave changed text on clipboard

7] Make applications share selection/accept changes

Text Action - Select which action to perform.

* Reformat — removes single spaced carriage returns and extra white space

* Remove Styles — removes all formatting information such as font and color
* Remove E-mail Quotes — removes e-mail quotes of the form “>”

*  Upper Case - MAKES ALL TEXT UPPER CASE LIKE THIS TEXT

* Lower Case — makes all text lower case like this text

* Title Case — Capitalizes The First Character Of Each Word Like This Text.

Prompt for action - Rather than setting up individual shortcuts for each reformatting option,
you can check this box so when ever you trigger your Text Tools shortcut it will ask you which
type of reformatting you'd like to do.

Text to Change -

* Selected Text — perform the desired reformatting on the text currently selected at the time
the shortcut is run.

* Text on Clipboard — perform the desired reformatting on the text on the system clipboard.

Replace selected text with changed text / Leave changed text on clipboard - These radio
buttons let you tell QuicKeys to replace the selected text with the newly reformatted text,
or you can choose to leave the original text in place and move the reformatted text to the
clipboard.
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Make applications share selection/accept changes — Some applications are unaware of changes to
the contents of the system clipboard, which can cause problems with insert operations. Selecting
this option will force all applications to check with the system clipboard for any changes before

inserting.
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Type Text

Create > Text > Type Text

The Type Text action is great for quickly inserting often-used blocks of text, such as e-mail
signatures or mailing addresses. Within multi-step shortcuts, Type Text often takes over your job of
repeatedly filling out forms.

Password Vault differs from Type Text only in that it stores the text in a more secure way. By
encrypting and hiding the text you enter, prying eyes can be kept away from any sensitive data you
might want to place in a shortcut.

1 A Type Text - (Undefined) E

Text to Type:

Text Action: D Insert Text
Make applications accept insert
8 Type Text
Keyboard Layout: [ Current Keyboard Layout i-%-]

Typing Speed: £  0.00 sec
Slow Fast

Text to Type - Enter the text you want QuicKeys to insert or type for you. You can drag-and-drop a
text selection from any application into this field.

Note: You can drag-and-drop a text selection from any application onto QuicKeys’ main editor
window to instantly create a Type Text shortcut.

Text Action -

Insert Text - Select this option to Insert/Paste the text rather than have QuicKeys simulate
typing it into your document. Inserting is faster but typing works where insert may not.

Make applications accept insert - Some applications are unaware of changes to the contents
of the system clipboard, which can cause problems with insert operations. Selecting this
option will force all applications to check with the system clipboard for any changes before
inserting.

Type Text - Select this option to have QuicKeys simulate typing your text rather than using the
insert method.
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Keyboard Layout - specify what keyboard layout will be used to type characters. When
QuicKeys simulates typing text it tries to be behave as much as possible to a user typing on
an actual keyboard. Sometimes it can be hard to act like real keystrokes for some text. If the
text is in a specific language, it may be best to use the keyboard layout that corresponds to
that language

Typing Speed - Set the typing speed. On slower systems QuicKeys may type faster than the
system’s typing buffer; adjust this slider to prevent that from happening.
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[y User Actions > Cy Button

The actions in this group generally mimic the actions a user makes with __:_ 3;'(“55 :

their mouse dozens of times per day. Selecting menus, clicking buttons, ® Mouse Recording

and manipulating pop-up menus can all be handled by QuicKeys User ¥ Pop-Up Menu

Actions instead; very useful as stand-alone shortcuts, and indispensable ¥ Scroll Wheel

in multi-step shortcuts. & Type Keystroke
Windows >

Button

Create > User Actions > Button

The Button action clicks buttons, check boxes, and radio buttons that appear in windows and
dialogs. Some buttons have common keyboard equivalents by default (Command+D for “Don’t
Save” and esc for “Cancel” for example), but many do not. For example, you can create a shortcut
that clicks the “Add” button in a dialog when you press Control+A, or one that clicks the “Replace”
button when you press Control+R.

1 v Oy Press Button i)

Find Button by: [ Name I-H ( Choose Button... :]

Button Mame: | Is
[] Ignore case
1))

Button Mumber: & if multiple matches

¥ Details

Modifiers: [ 3 Command
[ 1 shift
[C] *C Option
[£] ~ Control

Press action: () Tell button to click itself
This action may not work with some Carbon applications.

) Click button
This action may fail if the button is covered by another window.

Press Button: | Always I-G-]

More Settings: I: Application & Window Settings. .. jl

Find Button by - Indicate how QuicKeys should find the button: by name or by location. You
can click the Choose Button button, and QuicKeys will prompt you to select the button and
automatically fill in the fields, or you can fill in the fields manually.
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* Name -

Button Name - QuicKeys looks for a button whose name is, contains, starts with, or ends
with the text you enter.

Ignore Case - If you check this box, QuicKeys will ignore upper/lower case differences
when trying to locate your button.

Button Number - If more than one button that matches your naming criteria exists,
QuicKeys needs to be told which of those buttons it should be looking at.

* Location — Some buttons, check boxes, and radio buttons simply do not identify themselves
by name.

Horizontal/Vertical - Enter the coordinates of the button relative to the corner of the
window.

Window Corner - Select the corner of the window the coordinates are relative to.

Find Button by: [ Location I-%-] I: Choose Button... :]

Horizontal: 0 D
Vertical: 0 @

;

Window Corner: 8 D Button location is relative to
this corner of the window.

[¢) o]

¢ Details

Choose Button - Choose Set Button... to
automatically set the name or coordinates
of the target button A Select Button identify Button by: (&) Name Location
window appears and each time your cursor
hovers over a button, the button and
accompanying text are highlighted. When
the desired target button is highlighted,
press the Caps Lock key or fn to set the
location and click the OK button in the
. Move the cursor to the button you want to set.

Select Button dialog to save the button Press caps lock or fn key to lock on a button.

. _ . Press the OK button to save the button.
selection. If the desired item does not
register a name, you may need to use the
Location option.

Select Button

) Location Window Corner:

Horizontal:

Vertical:
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¥ Details  To further refine the action, click Details and set the following options:

Modifiers - Select a modifier key to press while clicking the target button. Modifiers allow clicks to
perform different functions.

Press Action —

Tell Button to click itself - QuicKeys can direct the target button to activate itself instead of
simulating a click. This method works even if the target button is obscured from view.

Click button - If the application you are targeting does not support the “Tell button to click
itselt” option, use the “Click button” option to simulate a click on the button.

Press Button — Choose the conditions under which the Button shortcut operates:
* Always — QuicKeys selects the designated button regardless of whether it is on or off.
*  When button is on — QuicKeys selects the designated button only when it is on.
* When button is off — QuicKeys selects the designated button only when it is off.
Note: The standard button doesn’t have an on/off state; this distinction is meant for check boxes
and radio buttons. For example, you could have QuicKeys only click on a check box if it is
unchecked or “off,” thus preventing QuicKeys from unchecking the check box you wanted it to

turn on.

More Settings - If

. Application
necessary, click the oieion: (o =
Application & Window prcTen V,mn e :
Show if hidden
Settings button and Window
ChOOSC the speciﬁcations Identify Window by: | Main Window I+{
for the window that will
contain the target button.
Window Type: [ Sheet on Any Window |+l

(CanceI\I( oK )

Application - Choose “Front Application,” choose from the list of running applications, or
choose “Select Application...” and navigate to the desired application.

Show if Hidden - With a specific application, select this to show this application before
performing the action.
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Identify Window by -

Main Window — QuicKeys will work with whichever window the application considers
to be its main window. This is almost exclusively the application’s document window.

Focused Window — QuicKeys will work with the window which currently has focus. The
key or focus window of an application is dynamic and can change depending on such
factors as your mouse location, text insertion point, or tabbing around an application’s
interface.

Name — Choose from Is, Contains, Starts with, and Ends with, and enter the name of
the Window for which you are testing,.

Ignore Case - If you check this box, QuicKeys will ignore upper/lower case differences.

Window Number - If more than one window that matches your naming criteria exists,
QuicKeys needs to be told which of those windows it should be looking at.

Frontmost — If you choose Frontmost from the pop-up list, QuicKeys looks for the
front-most window on your screen.

Level — QuicKeys identifies window level from front to back, so Level 1 would be the
front-most window. Depending upon the application and how it handles windows, you
may have to tweak the window level when you use this shortcut option. For example,
Some applications identify palettes as windows so you may need to experiment with
window level.

Window Type - In cases where you may have more than one window with the same name

(a document named Font and a palette with the same name for example), QuicKeys can
differentiate by window type. Choose the type if you need to be specific, or leave it set to Any
Type of Window if the type does not matter.

Any Type of Window *  Document Window * Palette Window
Sheet on Any Type of * Sheet on Document * Sheet on Palette
Window Window Window

Drawer on Any Type of * Drawer on Document * Drawer on Palette
Window Window Window

A drawer requires you to also specify a drawer number and which side (left, right, top, or
bottom) which side of the window it is one.
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Clicks

Create > User Actions > Clicks

The Click and Multiple Clicks shortcuts enable you to mimic mouse click(s) with QuicKeys. These
actions are especially helpful when buttons, menus, and other interface objects won’t listen to
QuicKeys and there is no keyboard equivalent for the item you want to select.

Note: The shortcut types “Click” and “Multiple Clicks” might sound like they are differentiating
between single-clicking and double-clicking with the mouse, but both types of shortcut are capable
of simulating single-clicks and double-clicks. The distinction between the two is made by how
many locations are clicked in succession.

Click

Create > User Actions > Clicks > Click

Use click if you want QuicKeys to click or click and drag a single target item or location. This step
can simulate a single-click of the mouse, a double-click, or more. (The number of clicks can even be
set to zero if you only want to move the mouse.) The click point can be separately designated from
the release point, creating a click and drag event.

1 v Rk Clickatlocation0h 0w M
Click Location
Horizontal: 0 f?] Set Location... Click Location is where the mouse cursor
o will be moved to and the button pressed
Vertical: ol towrs
=
Click Relative Ta: | Display 9‘ FI Display Details
Release Location ‘¥ 1)
Haorizontal: 0 f?] Set Location. .. Release Location is where the mouse
ezt cursor will be moved to and the button
Vertical: 0 o released. If different from the Click
: s Location, this can perform a drag action.
Release Relative To: | Display B‘ Q Display Details
¥ Details

[ Clicks & Buttons = Modifiers  Timing  Other Behavior ]

click: | 1] times

L

Click With: E Left/Primary button Leave Pressed: || Left/Primary button
[7] Right/Secondary button Right/Secondary button
[ Third button Third button

When left pressed, buttons remain down after this
step ends, but are released when the shortcut ends.
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Click/Release Location - The click location is the mouse cursor location when the button pressed
down. The release location is the mouse cursor location when the button is released. The two
locations will often be the same. For a click and drag action, they will be different.

Horizontal/Vertical - You can click the Set Location button, and QuicKeys will prompt you to
select the location and automatically fill in the coordinates, or you can fill in the fields manually.

Set Location - Click the Set Location button and

the Set QuicKeys Click Location window will
appear. The the mouse cursor will change to a
target. Position the circle where you want

QuicKeys to click, and press the Caps Lock key

to lock the Click target into place. Then, click
the OK button in the Set QuicKeys Click
Location dialog to save the Click location.

Set Location For — You can use the window
to set the location for the click, the release,
or the click and the release simultaneously.

Relative To — Set the click relative to the
display or a window.

Corner — Choose one of the four corners on
the screen example to click relative to the
display/window from the that corner.

Set QuicKeys Click Location

Set Location For: '_ Click

Relative To: | Display

Corner:

[] Target Desktop for action

Horizontal: 1151 Vertical: 380

Press caps lock or fn key to lock location.

Press OK button to set location. (_Cancel )

Relative To: | Window

Corner:

Identify Window By:

Name “Set Quickeys Click Loc...

) Level 2

Target Desktop for action — (Only present with Display) To specifically click on the desktop

select this option.

Identify Window By — (Only present with Window) QuicKeys automatically displays the
name and level of the window above which you move the target cursor. Select name or level,
depending on which you believe will accurately describe the desired window at the time the

shortcut is run.

Click Relative To - You can manually set the click relative to the display, a window, or the mouse.

Click Relative To: [ Display B‘ E] Display Details

* Display — Choose one of the
four corners on the screen
example to click relative to the
display from the that corner. If
you have multiple displays, the
click location is set relative to
the display in which the mouse
is currently located. Select Click

on Desktop if you want to target the desktop.

Click location is relative to this corner of the display.

[7] Click on Desktop
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° Window Click Relative To: [Window ¢ [&] window Details
In Applicaton: [ Front Application "ﬂ

Application - Choose “Front

Application,” choose from the WIT:::::: :::::::::w :

list of running applications, or

choose “Select Application...”

and navigate to the desired 0800

application. tnow come i R i leoecn ke
O O

Window Type - In cases where

you may have more than one

window with the same name (a document named Font and a palette with the same name for
example), QuicKeys can differentiate by window type. Choose the type if you need to be
specific, or leave it set to Any Type of Window if the type does not matter.

* Any Type of Window * Document Window * Palette Window

* Sheet on Any Type of * Sheet on Document * Sheet on Palette
Window Window Window

* Drawer on Any Type of * Drawer on Document * Drawer on Palette
Window Window Window

A drawer requires you to also specify a drawer number and which side (left, right, top, or
bottom) which side of the window it is one.

Identify by -

* Main Window — QuicKeys will work with whichever window the application
considers to be its main window: This is almost exclusively the application’s
document window.

*  Focused Window — QuicKeys will work with the window which currently has focus.
The key or focus window of an application is dynamic and can change depending
on such factors as your mouse location, text insertion point, or tabbing around an
application’s interface.

* Name — Choose from Is, Contains, Starts with, and Ends with, and enter the name of
the Window for which you are testing.

Ignore Case - If you check this box, QuicKeys will ignore upper/lower case
differences.

Window Number - If more than one window that matches your naming criteria
exists, QuicKeys needs to be told which of those windows it should be looking at.

QuicKeys 4 User Guide August 2009 177




Chapter 14 — Actions: User Actions

* Frontmost — If you choose Frontmost from the pop-up list, QuicKeys looks for the
front-most window on your screen.

* Level - QuicKeys identifies window level from front to back, so Level 1 would be the
front-most window. Depending upon the application and how it handles windows,
you may have to tweak the window level when you use this shortcut option. For
example, Some applications identify palettes as windows so you may need to
experiment with window level.

* Mouse — If you choose to click
relative to the Mouse, you are
telling QuicKeys to click wherever the mouse cursor happens to be when you trigger the
click shortcut. A good example of a time when you might want to use lick relative to mouse
is when you have to repeatedly hold a difficult set of modifier keys while clicking on an
object. Rather than pretzel your fingers, you can simply hover your mouse over the target
and hit a hot key trigger. QuicKeys can click the mouse and simulate holding down any
combination of modifier keys in the process.

Click Relative To: [ Mouse +

Copy Settings - If you want the click and release location to be the same (not a clickand (& t)
drag action) and you have made changes to one location, you can copy your settings to
the other location.

¥ Details  To further refine the action, click Details and set the following options:

Clicks & Buttons tab -

Clicks - The mouse will click a specified number of times in the same place. For example, you
can use this option to mimic a double-click by setting it to 2.

Click With - Choose the mouse button(s) to use. Chose from any combination of left/primary;
right/secondary; or third. Select which, if any, of these buttons should remain pressed until the
end of the shortcut (or another step releases them)

Modifiers tab - Modifier keys allow clicks to perform additional functions depending on the
application you are using. Choose from any combination of the Command, Shift, Option and
Control keys. Select which, if any, of these keys should remain pressed until the end of the shortcut
(or another step releases them).

Timing tab - If you want QuicKeys to slow down during a click, specify whether the delay should
occur after the click, during the drag, before release, or any combination of those. Then specify
how long the delay(s) should last.
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Other Behavior tab -

Bring all windows to front for click — Selecting this option makes all open windows active for
click actions. This ensures any hidden windows are made available for clicking.

Restore mouse location after click - The cursor will move to its original location if you choose
this option. Uncheck this option to leave your cursor at the release point when the step
finishes.

Multiple Clicks

Create > User Actions > Clicks > Multiple Clicks

Multiple Clicks automatically creates a multi-step shortcut consisting of a series of click steps.
Each click step corresponds to a click location recorded when you used the Multiple Clicks feature
and can be edited just like any Click shortcut.

Set QuicKeys Clicks Locations

When you use Multiple Clicks, the Set QuicKeys

Clicks Locations window immediately appears with L S S S e R
instructions on how to proceed. Move your cursor to e M ki youtt el Ehest:

the click locations you want to set, pressing the caps The mouse buttons and modifier keys used are
lock key or fn key to set each click point. A green remambered for sach locasion.

target with a number below it appears, tracking the Control click points you wish to delete.

order of your click locations.

( cancel )

Note: You can delete a target icon by Control+clicking
it and selecting Delete Location.

Click the OK button in the Set QuicKeys Clicks Locations window to stop designating click
points; QuicKeys will automatically create a shortcut consisting of multiple click steps for the
locations you designated.

When you set your click points, QuicKeys records them as single click and release actions relative
to your display. If you need to do anything more elaborate, you will need to edit the steps QuicKeys
created for you.
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Menus

Create > User Actions > Menus

The Menus shortcut category is intended to free you from taking your hands off of the keyboard
repeatedly to use your mouse to select menus. Most application menus communicate their contents
to the operating system, which allows QuicKeys to activate menus by simply calling their name.
Some applications, however, do not provide sufficient information about their menus to the
operating system, so QuicKeys must resort to simulating actual clicks on those menus.

To these ends, QuicKeys contains two menu shortcut types: Menu Selection — for those well
behaved menus which can be called by their names —and Menu Clicks — for those not-so-friendly
applications needing simulated clicks to operate their menus.

Menu Clicks

Create > User Actions > Menus > Menu Clicks

Menu Clicks select menus by making a series of clicks. In some applications, it is simply impossible
to access a menu by its name and so QuicKeys must resort to clicking just like a user would, only
faster and with no risk of getting a Repetitive Stress Injury:.

When you use Menu Clicks, the Set QuicKeys Menu e vttt Sl i
Clicks Locations window immediately appears with Click i 1 o \He Meris o Wailk 1 i thea
instructions on how to proceed. Move your cursor to e e e T e
the click locations you want to set, pressing the caps '

lock key or fn key to set each click point. A green
target with a number below it appears, tracking the
order of your click locations.

Press caps lock or fn key again for each submenu
or menu item you select.

Control click points you wish to delete.

Click OK when you are finished.

Note: You can delete a target icon by Control+clicking
it and selecting Delete Location.

I Cancel I

Click the OK button in the Set QuicKeys Menu Clicks Locations window to stop designating click
points; QuicKeys will automatically create a shortcut consisting of multiple click steps for the
locations you designated.

Menu Selection

Create > User Actions > Menus > Menu Selection

When you create a Menu Selection action, you have the option of hand typing the menu name and
menu item directly into the fields provided. This is a quick way to build the shortcut if you know
exactly which menu you want.
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1 » &= Select in menu i)
Menu for Action: Menu: | Details... )
Menu Item: | Details... )
_{_ Set Menu for Action... ﬁ + | -

[T 1s system menu on right side of menu bar

In Application: | Front Application >
Options
Item is Checked: [ Don't Care >

Show Menu: [| Show menus while performing menu action
Alternate: [| Perform as alternate menu action using modifier keys
3£ Command % Option

{+ Shift ~ Control

Menu for Action - You can click the Set

Menu for Action button, and QuicKeys

will prompt you to select the menu and Choose a menu from the menu bar to set it as the menu for this QuicKeys

. ! . action. Click Cancel to leave this QuicKeys action unchanged.

menu item (including any submenus) and

automaticall ﬁll in the ﬁelds Oor you can To display the menu bar for a different application, select the application
. Y . ’ Y in the pop-up menu below.

fill in the fields manually. Click plus (+) to

add additional lines as necessary. Details

buttons allow you to further refine the

target menu details.

Showing Menu Bar of: | ™ Finder ] I Cancel |

Note: Some applications may provide QuicKeys one set of menus when a shortcut is created, but
display another set upon playback. If the menu item you need is not presented by QuicKeys, you
will need to type the menu item’s name manually.

Is system menu on right side of menu bar - select this options to enable QuicKeys to access these
menus.

In Application - Select the application QuicKeys should look in for the menu.
Item is Checked - QuicKeys can test a menu item for the presence of a check mark.

Show menus while performing menu action - Some applications do not build their menus until
you click on them with your mouse, and they cease to exist once they close. This means QuicKeys
will have to actually open the desired menu to get it to draw its contents and make them accessible.

Perform as alternate menu action using modifier keys - The names of some menu items change
if you open the menu and hold down a modifier key. (Open Safari’s File menu and press the option
key, you should see Close Window change to Close all Windows.) With this option checked,
QuicKeys simulates pressing the modifier key:.
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Mouse Recording

Create > User Actions > Mouse Recording

QuicKeys makes two methods of recording your actions available to you. One is interpretive,

tfollowing your actions and building a sequence of shortcut steps as it interprets what you are doing.

This interpretive method is discussed in Chapter 4. The other recording method is the Mouse

Recording action that records exactly what your mouse, and only your mouse, is doing. This entire

recording is saved as one step in your shortcut.

1 v (8 Mouse Recording M

Real Time Mouse actions record and playback precise mouse movements and clicks.

[: Record... jl C'iea-'. Recording .

Record -

. . Ready for Mouse Recordi

Click the Record button to display the Ready for My T

Mouse Recording window. Press the Caps Lock or % heain ToLE recaiG thea e ot ok ki

fn key to begin mouse recording. When you are key. [I;‘ress the caps lock or fn key again to end mouse
. . recording.

finished recording, press the Caps Lock or fn key

again. This window will not display once recording begins.

{: Cancel Recording

You won’t see information about your recording
session in the Shortcut Editor, but you will see two
buttons (Record More and Clear Recording) that only appear when a recording already exists.

Record More -

Click the Record More button to add to your recording. This allows you to build a complex mouse

recording in bursts rather than all at once.
Clear Recording -

Click Clear Recording to delete the contents of the recording step.
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Pop-Up Menu

Create > User Actions > Pop-Up Menu

The Pop-up Menu action is used to select pop-up menu items from various windows and dialogs. It
is flexible in that it can locate pop-up menus by their name or by their location on a window.

1 L!EJ Select from Pop-Up Menu E
Find Pop-Up Menu by: [ Marme H-*-] ( Choose Pop-Up Menu... :]
Menu name: | Is HH

[ Ignore case

if multiple matches

Menu Number: 1 D

Select Menu Item by: | Name ;i‘
)

lterm name

: s
[ lgnore case

Item Mumber: 1 @ if multiple matches

¥ Details

Modifiers: || 38 Command
[ 1 shift
[C] % Option
[ ~ Control

More Settings: I: Application & Window Settings. .. j]

Find Pop-Up Menu by - Indicate how QuicKeys should find the pop-up menu: by name or by
location. You can click the Choose Pop-Up Menu button, and QuicKeys will prompt you to select
the menu and automatically fill in the fields, or you can fill in the fields manually.

* Name -

Menu Name - QuicKeys looks for a pop-up menu whose name is, contains, starts with, or
ends with the text you enter.

Ignore Case - If you check this box, QuicKeys will ignore upper/lower case differences
when trying to locate your menu.

Menu Number - If more than one pop-up menu that matches your naming criteria exists,
QuicKeys needs to be told which of those menus it should be looking at.
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* Location — Finding the correct pop-up by name is dependent on whether or not the target
application is telling the operating system the location. If the application doesn’t report this
information to the operating system, QuicKeys has no access to it either. In these cases you
will need to locate the desired pop-up menu by its location..

Horizontal/Vertical - Enter the coordinates of the button relative to the corner of the

window.

Window Corner - Select the corner of the window the coordinates are relative to.

Choose Pop-Up Menu - Choose Set
Pop-Up Menu to automatically set
the name or coordinates of the target
menu. The Select Pop-Up Menu
window appears and each time your
cursor hovers over a pop-up menu,
the menu is highlighted. When the
desired target is highlighted, press
the Caps Lock key or fn to set the
location and click the OK button in
the Select Pop-Up Menu window to
save the selection. If the desired item

Select Pop-Up Menu
Identify Pop-Up Menu by: () Name
Window Corner:

(®) Location

Horizontal: 202
Vertical: 280

Move the cursor to the pop-up menu you want to set.
Press the caps lock or fn key to set the location.
Press the OK bautton to save the pop-up menu.

(" Cancel )

does not register a name, you may need to use the Location option.

Select Menu Item by - Indicate how QuicKeys should find the menu item: by name or by position.

* Name - You can select the menu item by name just as you can find the menu by name.

* Position —To select a menu item by position enter the position number in the Item Position

field.

¥ Details

To further refine the action, click Details and set the following options:

Modifiers — Select a modifier key to press while clicking the target button. Modifiers allow clicks to

perform different functions.

More Settings - If necessary, click the Application & Window Settings button and choose the
specifications for the window that will contain the target button.

Application - Choose “Front Application,” choose from the list of running applications, or
choose “Select Application...” and navigate to the desired application.

Show if Hidden - With a specific application, select this to show this application before

performing the action.
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Identify Window by -

Main Window — QuicKeys will work with whichever window the application considers
to be its main window. This is almost exclusively the application’s document window.

Focused Window — QuicKeys will work with the window which currently has focus. The
key or focus window of an application is dynamic and can change depending on such
factors as your mouse location, text insertion point, or tabbing around an application’s
interface.

Name — Choose from Is, Contains, Starts with, and Ends with, and enter the name of
the Window for which you are testing,.

Ignore Case - If you check this box, QuicKeys will ignore upper/lower case differences.

Window Number - If more than one window that matches your naming criteria exists,
QuicKeys needs to be told which of those windows it should be looking at.

Frontmost — If you choose Frontmost from the pop-up list, QuicKeys looks for the
front-most window on your screen.

Level — QuicKeys identifies window level from front to back, so Level 1 would be the
front-most window. Depending upon the application and how it handles windows, you
may have to tweak the window level when you use this shortcut option. For example,
Some applications identify palettes as windows so you may need to experiment with
window level.

Window Type - In cases where you may have more than one window with the same name

(a document named Font and a palette with the same name for example), QuicKeys can
differentiate by window type. Choose the type if you need to be specific, or leave it set to Any
Type of Window if the type does not matter.

Any Type of Window *  Document Window * Palette Window
Sheet on Any Type of * Sheet on Document * Sheet on Palette
Window Window Window

Drawer on Any Type of * Drawer on Document * Drawer on Palette
Window Window Window

A drawer requires you to also specify a drawer number and which side (left, right, top, or
bottom) which side of the window it is one.
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Scroll Wheel

Create > User Actions > Scroll Wheel

The Scroll Wheel action enables you to create shortcuts that simulate the scroll wheel on a mouse,
even if you don’t have a scroll wheel. If an application supports scroll wheel input in some way, a
scroll wheel shortcut can fill that role. This goes beyond simply scrolling a web page up and down.
Some applications make use of the scroll wheel for zooming or for volume control for example.

1 v 7% Scroll Up/Left with Wheel 1 4]
Scroll Wheel: | Wheel 1 )
Scroll Direction: @ Up/Left Left ar right scrolling may reguire the Shift modifier be checked.

() Down Right

Scroll Speed: 6

Slow Fast

Modifiers: [ | 38 Command
[ ¢ Shift
[C] *C Option

[] ~ Control

Scroll Wheel - Most users will use Wheel 1 to simulate the scroll wheel commands. However, there
are applications, such as CAD programs, which support multiple scroll wheels. Users who have up
to three scroll wheels at their disposal can specify which they intend to use.

Scroll Direction - Indicate whether you want to simulate the scroll wheel scrolling up/left or down/
right. Up/Left and Down/Right are paired up on radio buttons; to differentiate between the two
you would need to select the Shift modifier for use in most applications. For example, scrolling to
the left with a scroll wheel is usually accomplished by holding the shift key and moving the scroll
wheel upward.

Scroll Speed - Use the slider to set how fast QuicKeys should scroll.

Modifiers - Modifiers allow scroll wheels to perform different functions. Choose from any
combination of the Command, Shift, Option, and Control keys.
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Type Keystroke

Create > User Actions > Type Keystroke

Type Keystroke is one of the simplest yet one of the most versatile actions QuicKeys provides.
You can remap almost any key combination, including modifier keys, but its uses go way beyond
changing your keystrokes. Think about what you do with your keyboard each day... You hit the
Enter key to acknowledge OK buttons; you use the escape key to cancel dialogs; you hit key
combinations to activate menu items (like 8 S to Save); you use arrow keys to navigate lists. The
keyboard is most people’s primary input device. Being able to remap keys and emulate keyboard
actions within multi-step shortcuts is thus a very important part of what QuicKeys can do to help
automate your daily tasks.

1 v B Type Keystroke "A" M
Type Keystroke: A f E ﬁ
¥ Details

Modifiers: [ ] Only type modifiers
Type: 1 @ [ times j‘

Leave Pressed: [ “&"
3£ Command 1+ Shift
 Option ~ Control

When left pressed, keys remain down after this step ends,
but are released when the shortcut ends.

Type Keystroke - The Type Keystroke field must be active to enter a key or key combination. Click
in that field to make it active. When the Keystroke field is active, all QuicKeys hot key triggers are
turned off, so that no other shortcuts will accidently fire.

Keys pop-up list - There are some situations where it is impossible (8 =

to enter the desired keystroke into the Keystroke field. For Letters & Numbers >
example, a key on your keyboard may not be readable by QuicKeys, Funcruation & Edting :
or you may be using a smaller keyboard that is actually missing Keypad >
some keys that your larger keyboard has. For these types of issues, System >
you can select the keystroke you want QuicKeys to send via the $ Command

Keys pop-up menu. The upper half of this menu contains the keys @ Shift

you can have QuicKeys press, while the bottom half is a list of }Sﬂp::f:l

modifier keys which can be toggled on and off by selecting them.

¥ Details  To further refine the action, click Details and set the following options:

Modifiers - Select “Only type modifiers” to make modifiers the only keys in this step. Combine this
with the “Leave Pressed” option and use it in a multi-step shortcut.
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Type - Select how many times the keystroke should be typed or for how many seconds it should be
held down.

Leave Pressed - Select which, if any, of these keys should remain pressed until the end of the
shortcut (or another step releases them).
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Windows

Create > User Actions > Windows

Windows Actions and Windows Arrangement actions are useful for controlling the appearance and
behavior of the windows that appear on your screen.

Windows Actions

Create > User Actions > Windows > Windows Actions

1 [ Close main window E
Window Action: [ Close F%-]
Window Type: | Any Window i-%-]
Identify by: [ Main Window '—H
In Application: [ Front Application I-H

¥ Window Details

Window Action: () Tell window to do action itself
This action may not work with some Carbon applications.

f#) Click to perform action
This action may fail if the window is covered by another

Modifiers: [ ] 38 Command Using modifiers may require the
F 14 Shift action above to be set to "click to
s perform action.”
[7] X Option
[7] ~ Control

Types of Windows Actions

There are six types of Windows Actions: Bring All Windows to Front, Close, Minimize,
Unminimize, Zoom, and Toggle Toolbar.

When you look at the contents of the Create > User Action > Windows > Windows Actions
submenu you’ll note that all six types are listed. But when you look at the “Window Action” pop-up
list while editing a windows actions step, you'll see only five. The missing item is Bring All Windows
to Front.

Bring All Windows to Front - This action brings all of the windows of the front-most application
to the front. This is the same Bring All Windows to Front action as Create > System > Computer
Tools > Bring All Windows to Front. It does not have the same options as the other windows
actions.
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Close — The Close action will close the specified window.

Minimize - The Minimize action will collapse the specified window to the Dock. You can reopen
the window by selecting it from the Dock or by using an Unminimize Windows shortcut.

Unminimize - The Unminimize action will display a window that has been minimized.
Zoom - The Zoom action changes the size of the specified window.

Toggle Toolbar - Use the Toggle Toolbar action to show/hide the toolbar of a window.

Windows Options

Window Action - Choose Close, Minimize, Unminimize, Zoom, or Toggle Toolbar.

Window Type - QuicKeys can differentiate by window type. Choose the type if you need to be
specific, or leave it set to Any Type of Window if the type does not matter.

* AnyType of Window * Document Window * Palette Window

* Sheet on Any Type of * Sheet on Document * Sheet on Palette
Window Window Window

* Drawer on Any Type of * Drawer on Document * Drawer on Palette
Window Window Window

A drawer requires you to also specify a drawer number and which side (left, right, top, or
bottom) which side of the window it is one.

Identify by -

*  Main Window — QuicKeys will work with whichever window the application considers to be
its main window. This is almost exclusively the application’s document window.

* Focused Window — QuicKeys will work with the window which currently has focus. The key
or focus window of an application is dynamic and can change depending on such factors as

your mouse location, text insertion point, or tabbing around an application’s interface.

* Name — Choose from Is, Contains, Starts with, and Ends with, and enter the name of the
Window for which you are testing.

Ignore Case - If you check this box, QuicKeys will ignore upper/lower case differences.

Window Number - If more than one window that matches your naming criteria exists,
QuicKeys needs to be told which of those windows it should be looking at.
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* Frontmost — If you choose Frontmost from the pop-up list, QuicKeys looks for the front-
most window on your screen.

* Level — QuicKeys identifies window level from front to back, so Level 1 would be the
front-most window. Depending upon the application and how it handles windows, you may
have to tweak the window level when you use this shortcut option. For example, Some
applications identify palettes as windows so you may need to experiment with window level.

In Application - Choose “Front Application,” choose from the list of running applications, or
choose “Select Application...” and navigate to the desired application.

¥ Window Details To further refine the action, set the following options:

Window Action -

Tell Window to do action itself - Select this option when you want QuicKeys to direct the
window to perform the specified action. Using this method to complete window actions is
more reliable. For example, if the window is partially hidden by another window; using “Tell
window to do action itself” will still work because it doesn’t matter that the window is partially
obscured.

Click to perform action - In contrast, if you choose “Click to perform action” the step might
fail if the window is partially obscured. However, some cases (e.g., when using modifiers) may
work better with this option.

Modifiers - Modifiers can be used in combination with window actions. For example, holding your
Option key while you click the minimizing a Finder window will minimize all Finder windows

Windows Arrangement

Create > User Actions > Windows > Windows Arrangement

Types of Windows Arrangement Actions

There are three types of Windows Arrangement actions: Cascade Windows, Resize Windows, and
Tile Windows.

Cascade Windows - This action cascades the specified windows. It is the simplest windows
arrangement action.

Tile Windows - This action tiles the specified windows. It has one additional option compared to
cascade windows.

Resize Windows — This action moves and resizes a specified window. It has the most options.
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1~ Resize Windows E
window Action: | Resize Window *%-i
Window Type: [ Any Window ‘—H
In Application: [ Front Application H‘ﬁ']
Identify By: | Frontmost F%ﬂ]

Window Size & Position

™ Position [ Left o [250 ()
[ Top ) [250 () -~

# size width: | 300 ()

Height: | 200 ()

(3% v

Windows Arrangement Options

Window Action — Choose Resize Windows, Cascade Windows, or Tile Windows.
Window Type - Select Any Window, Document, or Palette.

In Application - Choose “Front Application,” choose from the list of running applications, or
choose “Select Application...” and navigate to the desired application.

Tile Windows - (Only present with Tile Windows) Select either Vertically or Horizontally.
Identify By — (Only present with Resize Window)

* Main Window — QuicKeys will work with whichever window the application considers to be
its main window. This is almost exclusively the application’s document window.

* Focused Window — QuicKeys will work with the window which currently has focus. The key
or focus window of an application is dynamic and can change depending on such factors as

your mouse location, text insertion point, or tabbing around an application’s interface.

* Name — Choose from Is, Contains, Starts with, and Ends with, and enter the name of the
‘Window for which you are testing.

Ignore Case - If you check this box, QuicKeys will ignore upper/lower case differences.

Window Number - If more than one window that matches your naming criteria exists,
QuicKeys needs to be told which of those windows it should be looking at.
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* Frontmost — If you choose Frontmost from the pop-up list, QuicKeys looks for the
frontmost window on your screen.

* Level — QuicKeys identifies window level from front to back, so Level 1 would be the
frontmost window. Depending upon the application and how it handles windows, you may
have to tweak the window level when you use this shortcut option. For example, Some
applications identify palettes as windows so you may need to experiment with window level.

Window Size & Position — (Only present with Resize Window)
The preview to the right dynamically shows the effects of your size and position changes.

Position - If you wish to move the window, select this option. Then select which corner will be
the target corner and input the desired coordinates for this corner.

Size - If you wish to resize the window;, select this option and input the desired width and
height of the window.

Alignment Options - To assist you in determining the desired coordinates for your position, the
alignment options popup menu ' # ¥ is enabled whenever Position is selected.

If you enter coordinates in the position fields, the preview automatically updates. Selecting an
option from popup menu aligns the “window” with a corner of the “screen” in the preview, and
the coordinates automatically update.

Note: If both Position and Size are selected the alignment options menu will allow you to choose
and corner of the screen. If only Position is selected, QuicKeys does not know the size of the
window; therefore, the only option in that case is the one to align the “window” to the corner of
the “screen” matching the target corner of the window:
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QuicKeys Online gives you even more resources for getting the most out of QuicKeys 4.

* Browse the Shortcut Gallery to learn about and download shortcuts you can use right now.
* View helpful Tutorials for beginner, intermediate, and expert users.
* Do you need technical help? Visit the QuicKeys Support website.

* Visit the QuicKeys Community to chat about all things QuicKeys with other users.

To access QuicKeys Online, click QuicKeys Online is the source list of the QuicKeys Editor.
Internet access is required.

QuicKeys Editor

LIBRARY g T 5 -
o QuicKeys Online Gallery Tutorials Support Community
& Shortcuts
/¥ Abbreviations
E‘T"“'b“ Welcome to QuicKeys Online!
Clips
Here at QuicKeys Online you will find lots of resources to help you get the most out of QuicKeys 4.
SCO;SA"A 1 » Browse the Shortcut Gallery to learn about and download shortcuts you can use right now.
ol oD = View helpful Tutorials for beginner, intermediate, and expert users.
8 Adobe InDesign C54 ) - i i
« Need technical help? Visit the QuicKeys Support website.
# Unscoped ltems « Visit the QuicKeys Community to chat about all things QuicKeys with other users.
ONLINE
Quickeys Tips via Twitter
Shortcut not working? Shortcut Debugging can help find why a shortcut is failing. You can enable/disable debugging under
the Shortcuts menu. 1 day ago
Shortcuts can be played by other apps. For example iCal can play a shortcut by opening the shortcut's file via an event
"open file" alarm. 2 days ago
Date & Time actions can be used to type/insert complex dates and times. These can be customized just about any way you
can think of. 3 days age
Follow QuicKeys on Twitter
mg:mmmm;m"w?ﬁ.:mmm@mwmwmmuuummdmwhmmnuc.mmuu demark of Startly LLE. All ather ar
ni + | = 4

Shortcut Gallery

In the Shortcut Gallery you will find shortcuts contributed by other QuicKeys users. Browse
through all the shortcuts available or use the search field to narrow the list. Download the ones you
want, and then use these shortcuts as-is or edit them if you need. After downloading simply set the
triggers you want to use and you are all set.

If you have some great shortcuts others would find useful, you can submit them to the Shortcut
Gallery! In the QuicKeys Editor shortcut list, select the shortcuts to share and choose “Submit to
Shortcut Gallery” from the Shortcuts menu.
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Note: All submitted shortcuts will be reviewed before they are added to the gallery. Some shortcuts
may not be accepted or may be edited before being added. All submitted shortcuts become the
property of Startly, but you can receive attribution if you wish.

Note: Startly does not provide any guarantee of the usefulness, appropriateness, or correct behavior
of any of the shortcuts provided here. You should evaluate each shortcut you download for its
appropriateness to your needs before using.

Tutorials

In the Tutorials section you will find movies on a variety of QuicKeys topics from overviews to
demonstrations of specific features.

If you can’t find one on the subject you need, use the QuicKeys Feedback page to tell us what you
would like to know more about. The most requested topics will get their very own tutorials. You
can also visit our Support or Community sites (covered below) if you need help right now.

Support

Clicking Support opens the Startly Support page in your web browser. In addition to information
on e-mail and telephone support, this page has FAQs and links to report a lost activation key or
serial number, register your software, and provide feedback.

Community

Clicking Community opens the Startly Community Forum in your web browser. Create an account
and join the discussions!
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Whera, when, and why this shortout runs.

¥ B All Applications &

-1+] device ¢ @ pevice
- Action: Button 3 on any device &
With device triggers you can directly assign (_SetActon.. | OtherActons > ]
shortcuts to buttons on your mouse, trackball, Modifirs E) 8 Cormrnd
joystick, and even keys like Eject and Mute on g 2 ;hp':m
your keyboard. Fees

(.Advan ced Options... )

Note: If you are simply wanting to assign a
key or combination of keys such as Fr or (" Setup Devices... )

Command+M as a shortcut trigger, use a hot . J/
key trigger.

Devices Setup

Before you can create device triggers, you must use the devices window to control what devices
connected to your computer can be used for device triggers.

Select Devices from the Window menu.

®e®eco . (Devies

Human Interface Devices (HID)

HIDs are mice, keyboards, and similar devices connected to your computer that can be used to trigger QuickKeys shortcuts.
To add a device to the Active Devices list, choose a device in the Add pop-up menu. If a device is shown in the menu more
than once, it is usually best to add all of its entries to the list.

Active Devices &
Apple Internal Keyboard [ Trac... Name:
Apple Internal Keyboard [ Trac...
Apple Internal Keyboard [ Trac...
Apple Internal Keyboard | Trac... Type:

Connection: No Selection

Vendor:

[ Remember device by its connection

f Change Connection Name. .. _\'

Exclusive: | | Use this device exclusively with QuicKeys
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Active Devices - This list shows the devices that are currently enabled for use in QuicKeys for
device triggers

Plus pop-up - Shows the devices that are still available for adding to the active device list

Minus button - Removes the device selected in the Active Devices list from use in QuicKeys
Name - Shows the default name for the selected device. You can edit this to be whatever you want.
Vendor - Shows the manufacturer of the device

Type - Shows the type of device. Common types are USB Keyboard or Bluetooth Mouse

Connection - Shows the device connection name and whether the device is currently connected or
not

Remember device by its connection - This makes it easier to have more than one device of the
same kind attached to your computer. Some devices cannot be uniquely identified simply by name
alone, QuicKeys may need to also keep track of how it is connected in order to uniquely identify it.

Note: If this is checked and you unplug the device and then plug it back into another port,
QuicKeys will most likely see it as a different device. As a result, any triggers specific to this device
will need to be recreated.

Change Connection Name - By default a connection name will be a number. You can change the
name to be more user friendly. For example you could give it a name of “right front USB port”

Note: Some connections names are reused for other devices and depending on how the device is
connected. Sometimes you may plug in a device to an already named port but QuicKeys will show
you a number instead. That means that device may have its own internal connection name. You can
change the name for that connection, but it may only persist for that particular device.

Use this device exclusively with QuicKeys - When checked all input from this device will only go
to QuicKeys; no other application can use this device. For example if the device is a mouse it will
no longer move the mouse cursor. It the device is a keyboard it will not type in your documents.
Also if the device is a keyboard you may be asked for an admin user name and password before the
device can be used exclusively:.

Note: A device that is set to be used exclusively with QuicKeys cannot be used for hot key triggers.
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Advanced Options

On the edit trigger window is an Advanced Options button. It opens the Advanced Device Trigger
Options window.

The edit trigger window is shown on the first page of this appendix and is covered in the Triggers
section of Chapter 4.

Action Name - You can
provide a more descriptive
name for the Action

Action Name: IButton 3 I

Device: | Apple Internal Keyboard / Trackpad (Mcl—ﬂ

Device - Shows the device Element: | Button 3 i3
that was associated with this Element HID Usage Page: | 0x00000009
trigger. —
Element HID Usage: | 0x00000003

Element - Shows the device Trigger From: | Any Device ]
element that was associated
with this trigger. Trigger Action: f User Action I-ﬂ

Element Value: | Equal To I-ﬂ
Element HID Usage Page & 1 Min 0 Mo 1
Element HID Usage - These
display the technical identifier ( Cancel ) 0K )

of the particular element of
the device. You would rarely
need to edit these.

Trigger From — Lets you specify how QuicKeys relates this trigger back to the device in the Device
pop-up above when trying to fire this trigger

Trigger Action - Lets you specify what causes the trigger to fire.
* User Action — An action such as pressing a button.

* Value Changes — Used for device elements that have a variable value. If the value changes the
trigger can fire.

* Value Check -Periodically checks the value of the specified element on the specified device.

Element Value - Specifies the method of checking values for the Trigger Action pop-up
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QuicKeys Anywhere is an application you can install on your iPhone or iPod Touch that lets you
run shortcuts back on your Mac from wherever you are—if you have a phone data connection or
WiFi connection.

Before you can use this feature, remote control must be enabled. Check “Allow remote control” in
the Remote pane in the QuicKeys Preferences window as covered in Chapter 3.

To allow control from your “remote,” your copy of QuicKeys on your computer has to be paired
with the copy of QuicKeys Anywhere on your iPhone/iPod Touch.

To pair them, you must first be in “Add Host” mode in QuicKeys Anywhere. Your iPhone/iPod
Touch must be on the same WiFi network as your computer. (Pairing does not occur over the USB
cable.) QuicKeys must be running on your computer with the QuicKeys Editor open.

When the above conditions are met, you will see a Remotes category in source list of the QuicKeys
Editor. Select your device from this category and you will see the Add QuicKeys Anywhere Remote
pairing screen. Then, simply enter the Pair Key numbers shown in QuicKeys Anywhere on your
iPhone/iPod Touch.

800 QuicKeys Editor =

T o) @ Q

Create  Record Me QuicKeys On

Shortcut Search

LIERARY
&) Shortcuts

/¥ Abbreviations
[E8] Toolbars
[ clips
SCOPES
JE3L Al Applications
B Finder
/ TextEdit

REMOTES

-

ONLINE
E Quickeys Online

Add QuicKeys Anywhere Remote

Please enter the passkey located on your device to pair it
with QuicKeys and allow it to control QuicKeys.

Once paired, your device will be listed in the Remote pane in
the Preferences window.

i
Pair )

Once paired, QuicKeys Anywhere will exit the Add Host mode and the device will then no longer
appear on the Remotes list in the QuicKeys Editor. All the iPhones and iPod Touches you have
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paired will be listed in the Remote pane in the QuicKeys Preferences window. If necessary, you can
remove devices that have been paired by clicking the remove (-) button.

Note: If you have a firewall on your home/office network and you will be connecting from outside
your firewall, you will need to configure your firewall to allow access on the Network Port specified
in the Remote pane of the QuicKeys Preferences window.

800 QuicKeys Preferences

QuicKeys Anywhere

Remote Control: W Allow remote control

Network Port: | 50100

Changing the network port requires toggling "Allow Remote Control from Devices"
as well as a configuration change on each device listed below.

Remotes: | Name | Identification
iPhone B211331B-0E48-5152-BF3F-CAFB219FEE33

[-]

Remote Administration

Remote Admin: [ | Allow remote administration

Network Port: | 50000

Changes to Remote Administration settings only take effect after relaunching QuicKeys.

Network Security

The ports specified above must be enabled in any network firewall running on this computer.

( Configure System Firewall... )
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QuicKeys can be directed to play a shortcut by its name using AppleScript. QuicKeys can also be
directed to set or get variables with AppleScript. The AppleScript code must be written in the
following ways to make these things happen.

Triggering Shortcuts

Play shortcut by name

The following three lines of script tell QuicKeys to play the shortcut named “Open TextEdit”. Any
shortcut name can be substituted.

tell application “QuicKeys”
play shortcut named “Open TextEdit”
end tell

Play shortcut remotely

AppleScript can be used to trigger a QuicKeys shortcut residing on a remote machine.
While working on machine A, you can trigger a QuicKeys shortcut on machine B. You can
put AppleScript code like this into a QuicKeys AppleScript type of shortcut, or save it as an
AppleScript applet.

Preparation

You must prepare the remote/target machine in advance to accept these types of events by doing
the following:

* Open System Preferences
* Select the Sharing pane, Services tab.

* Check the box named “Remote Apple Events” to turn on this feature

Play remote shortcut by name

tell application “QuicKeys” of machine “eppc://xXXX.XXX.XXXX.XXX"
play shortcut named “Shutdown”
end tell

Where xxx.xxx.xxx.xxx is the IP Address of the target machine. Running/compiling this script
should bring up a window asking for user name and password for the remote machine with the
option to “add to keychain.” Once the login and password information is accepted the shortcut on
the remote machine should activate.
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Using Variables

Set variable

The following three lines of sample script set the value of a QuicKeys variable named “QKVariable”
to the value of “something.” You can use any variable name you like.

tell application “QuicKeys”
set value of variable named “QKVariable “ to “something”

end tell

Get variable

The following three lines of sample script set the value of an AppleScript variable named
“ASVariable” to the contents of a QuicKeys variable named “QKVariable.” You can use any variable
names you like. Data passed into QuicKeys or set within QuicKeys can be retrieved by AppleScript
in this way:

tell application “QuicKeys”
set ASVariable to the value of variable named “QKVariable”

end tell
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QuicKeys maintains your shortcuts, toolbars, abbreviations, and clips in one location and your
preferences settings in another. You can drag these items to a second hard drive, a network storage
location, or burn them to a CD to back them up. They can easily be restored by copying them back
to their original locations.

Backing Up Your QuicKeys Data
1. Quit the QuicKeys application.

2. Navigate to <user>/Library.

3. Locate the QuicKeys folder inside and copy it to your backup location.

Backing Up Your QuicKeys Preferences
1. Quit the QuicKeys application.

2. Navigate to <user>/Library/Preferences.
3. Locate “com.quickeys.quickeys.plist” and copy it to your backup location.

4. Locate “com.quickeys.quickeysbackgroundengine.plist” and copy it to your backup location.

Restoring Your QuicKeys Data

1. Quit the QuicKeys application.

2. Copy your archived QuicKeys folder into <user>/Library:.

Important Note: Overwriting one QuicKeys data folder with another will destroy all of the shortcut

toolbar, abbreviation, and clip data in the folder being overwritten. If you need to merge archived
data with current data, use the methods discussed in Appendix F, Sharing Shortcuts.

Restoring Your QuicKeys Preferences

1. Quit the QuicKeys application.

2. Copy your archived QuicKeys preferences files into <user>/Library/Preferences.

Note: Restoring your QuicKeys preferences file will not restore your activation code. If you've done

a fresh reinstall of your operating system or if you are moving your data to a new machine you will
need to reenter your activation key:.
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QuicKeys stores your shortcuts in the folder <user>/Library/QuicKeys/Shortcuts. Each new
shortcut is saved in this location as a separate file whose name matches the name you gave the
shortcut. If you remove a shortcut file from this folder, the next time you run QuicKeys that
shortcut will not load.

Conversely, if you drag additional shortcut files (or folders containing shortcut files) into that
folder, those shortcuts will be available next launch. You can also share shortcuts by exporting and
importing them, or subscribe to folders full of shortcuts placed on public file servers and shared
drives.

Using Others’ Shortcuts

There are three methods to get other users’ shortcuts to load into QuicKeys:

Import Shortcuts

Both shortcuts that have been exported from QuicKeys and actual shortcut files can be imported
by another user. Importing makes the new shortcuts immediately available.

1. From within QuicKeys, select the menu item, File > Import Shortcuts.
2. Navigate to the QuicKeys export file (or shortcut file) and click Open.

3. Your new shortcuts are ready to use.

Subscribe to Public Shortcuts

If you have access to a file server or shared workstation whose owner has made QuicKeys shortcuts
available to the public or selected users, you can easily subscribe to those shortcuts.

1. Loginto the server or workstation that is home to the repository of shortcuts to which
you want to subscribe. You need to be able to navigate to the target folder to be able to
subscribe to it.

2. From within QuicKeys select Subscribe to Shortcuts from the File menu. In the resulting
window; click on the {+] button to add a new location from which to load shortcuts.

3. Navigate to the folder containing the shared shortcuts and click Open. Any shortcuts in that
tolder, or inside other folders located inside the target folder, will be loaded into QuicKeys
tor your use.

Note: Subscriptions to shortcuts are not live. QuicKeys loads the shortcuts from the designated
location at only two times: 1) when you subscribe, and 2) when you quit and relaunch QuicKeys. If
the owner changes the shortcuts in a folder to which you have subscribed, your copy of QuicKeys
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will not update with the new shortcuts until you either quit and relaunch QuicKeys, or unsubscribe
and subscribe to that shared folder again.

Download Shortcuts From QuicKeys Online

In the Shortcut Gallery you can browse and download shortcuts contributed by other QuicKeys
users. You can then use these shortcuts as-is or edit them if you need.

1. Within the QuicKeys Editor, select QuicKeys in the source list. Then select Gallery.

2. Review the available shortcuts. When you see a shortcut or collection of shortcuts you
would like, click the Download button and follow the prompts.

3. Review each shortcut prior to use.

Making Your Shortcuts Available to Others

There are four ways to share your shortcuts with other users:

Export Your Shortcuts

1. Within the QuicKeys Editor, highlight the shortcuts you want to export in the shortcuts list
and select File > Export Shortcuts.

2. Navigate to the desired destination and click the Save button.

3. Pass this exported file on to anyone you wish. They will need to follow the Import Shortcuts
instructions found earlier in this appendix.

Distribute Your Shortcut Files

1. Locate your shortcuts in the <user>/Library/QuicKeys/Shortcuts folder and copy any that
you want to share out to another location.

2. Pass these copies on to whomever you wish. They will need to follow the Import Shortcuts
instructions found earlier in this appendix.

Make Your Shortcuts Public

There is no mechanism within QuicKeys to enable file sharing or act as a shortcut server per se.
What QuicKeys can do, however, is subscribe to shortcuts that are outside of its default <user>/
Library/QuicKeys/Shortcuts folder.
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To make your shortcuts available to the public you need only move copies of your shortcut files to
an accessible location. Be it a file server or a shared location on your workstation’s hard drive, if
users are allowed to log in and access that location, their copy of QuicKeys can load shortcuts from
it.

Share Your Shortcuts on QuicKeys Online

If you have some great shortcuts others would find useful, you can submit them to the Shortcut
Gallery.

1. Within the QuicKeys Editor, highlight the shortcuts you want to export in the shortcuts list
and select Shortcuts > Submit to Shortcut Gallery.

2. Fill out the form and click Upload.

3. All submitted shortcuts will be reviewed before they are added to the gallery. Some
shortcuts may not be accepted or may be edited before being added. All submitted shortcuts
become the property of Startly, but you can receive attribution if you wish.

Read/Write Permissions

QuicKeys has the ability to load shortcuts from numerous sources outside of its default data
location. QuicKeys must, like any other application, obey the Read/Write permissions of the user
that logged in.

Note: QuicKeys will always try to write an edited shortcut back along the path from which it was

loaded. New shortcuts are always saved to <user>/Library/QuicKeys/Shortcuts. These behaviors
cannot be altered.

Shortcut File Permissions Effects

Permissions Load & Run Shortcuts? | Edit Shortcuts? Save Shortcuts?
Read Only Yes Yes* No
Read & Write Yes Yes Yes

* Note: Editing shortcuts loaded with Read-only permissions caches the changes within QuicKeys,
but those changes will be lost when QuicKeys is quit.

Read-Only Permissions for All Shortcuts

Some administrators may find it desirable to prevent users from editing or creating new shortcuts
at all times. This can be accomplished by setting the QuicKeys shortcut data folder to Read-only.
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Symbolic Linking

The QuicKeys shortcut data folder can be replaced with a symbolic link using the Terminal
application if so desired.

Copyright ©2009 Startly Technologies, LLC. All rights reserved. QuicKeys is a registered U.S. trademark of Startly Technologies, LLC. All
other trademarks or registered trademarks are property of their respective owners.
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Startly Technologies License and Limited Warranty Agreement
QuicKeys®

CAREFULLY READ THE TERMS AND CONDITIONS OF THIS LICENSE AND LIMITED WARRANTY
AGREEMENT ("AGREEMENT") BEFORE YOU USE THIS PACKAGE. BY USING OR RETAINING THIS
PACKAGE, YOU AGREE TO BE BOUND BY THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL THE
TERMS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE AND PROMPTLY RETURN THE
ENTIRE PACKAGE TO YOUR PLACE OF PURCHASE FOR A FULL REFUND.

DEFINITIONS

+ Package means the Software, manual(s) and other items accompanying this Agreement.

+ Software means the computer programs owned or distributed by Startly Technologies, LLC. ("Startly")
and contained in this Package. It also means any copies of the programs made to any media or storage.
+ User means a person authorized to use the Software according to the terms of this Agreement.

* You and Your means a person who is one of the Authorized Number of Users of the Software in
accordance with the terms of this Agreement.

+ Authorized Number means the maximum number of users specified by Startly with this Package, or one
single User if no greater number is specified.

LICENSE AND RESTRICTIONS

Limited Rights

* You may operate this Software on only one computer at a time.

* You may make backup copies of the Software and digital versions of the manuals solely for archival
purposes. All copies of Software authorized under this Agreement shall reproduce and display fully all
Startly copyright notices or other proprietary legends.

« Startly retains all right, title and interest in and to the Software and all modifications, enhancements or
other derivatives of the Software or other materials, in any medium, including but not limited to all
copyrights, patents, trade secrets, trademarks and other proprietary rights.

+ All rights not expressly granted are reserved to Startly.

Specific Restrictions and Terms

* You may not copy or use the Software or other materials in the Package except as specified in this
Agreement.

* You may not modify, reverse-engineer, disassemble, decompile, translate or reduce the Software to a
human perceivable form.

* You may not sub-license, resell for profit, lend, rent, lease or otherwise distribute the Software or any
portion of the Software.

* You may not distribute the Software electronically over a network or the Internet except within the scope
of the license rights expressly granted.

* You may not create derivative works based on the Software.

* You may not remove, obscure, or alter any notice of the Startly copyright or other proprietary legends on
the Software.

* You may not transfer the Software or other materials in the Package to another person or entity, except
that, after written notification to Startly, You may transfer all (but no lesser portion) of the Package,
including this Agreement, to another party who agrees to abide by the terms and conditions of this
Agreement.

* You may not transfer the Software or any other materials in the Package to any person or entity in
violation of the United States Export Administration Act.

* You are responsible for all taxes other than those based on the net income of Startly.

U.S.A. GOVERNMENT END USERS
The Software and documentation are provided with RESTRICTED RIGHTS. Use duplication, or
disclosure by the Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of the

QuicKeys 4 User Guide August 2009 208




Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)
(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable.
Manufacturer is Startly Technologies, LLC, P.O. Box 65580, West Des Moines, 1A 50265.

TERM AND TERMINATION

The term of this Agreement is perpetual unless otherwise terminated. Both the Agreement and Your right
to use the Software terminate automatically if You violate any material part of this Agreement. In the
event of termination, You must immediately destroy all copies of the Software or return them to Startly.

LIMITED WARRANTY

+ Limited Software Warranty. For a period of ninety (90) days from the date You purchased this Package,
Startly warrants, to You only, that the Software shall conform substantially to the descriptions set forth in
the manual included in the Package, if the Software is not misused nor modified by anyone other than
Startly. The parties acknowledge and agree that, due to the complex nature of computer programs, it is
impossible to ensure the Software will be error-free or that Software operation will be uninterrupted.

» Media Warranty. Startly warrants that the media on which the Software is provided, if provided on
physical media, is free from defects in materials and workmanship under normal use for the period of
ninety (90) days from the date You purchased this Package.

+ Limitations on Warranties. The warranties above are exclusive and in lieu of all other warranties.
STARTLY EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS,
AND YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO STATE.

EXCLUSIVE REMEDIES

For any breach of the limited warranty above, Your exclusive remedy, and Startly’s entire liability shall be:
« For Software Warranty: Startly will, at its sole option: (i) repair or replace the nonconforming Software
within a commercially reasonable time of notice of such condition; or (ii) credit or refund to You all or a fair
portion of the price You paid for such Software.

+ For Media Warranty: The replacement of defective media returned within ninety (90) days of the date
You purchased this Package.

LIMITATION OF LIABILITY

IN NO EVENT SHALL EITHER STARTLY OR ITS DISTRIBUTORS BE LIABLE FOR ANY INDIRECT,
INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES, OR DAMAGES FOR LOSS OF PROFITS,
REVENUE, DATA OR USE, INCURRED BY ANY USER OR ANY THIRD PARTY, WHETHER IN AN
ACTION IN CONTRACT OR TORT, EVEN IF STARTLY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. STARTLY’s LIABILITY FOR DAMAGES HEREUNDER SHALL IN NO EVENT
EXCEED THE AMOUNT YOU PAID FOR THE SOFTWARE. The provisions in the Limited Warranty,
Exclusive Remedies and Limitation of Liability sections above allocate the risks under this Agreement
between You and Startly. Startly’s pricing reflects this allocation of risk and the limitation of liability
specified herein.

GENERAL

This Agreement constitutes the entire agreement and supersedes any prior agreement between Startly
and You concerning the contents of this Package. Startly is not bound by any provision of any purchase
order, or other document, unless Startly specifically amends this Agreement. This Agreement cannot be
amended, modified or waived unless the change is written and signed by an authorized officer of Startly.
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